The UM301W and UM301X are not distributed in North America.

Model No.
NP-UM351W, NP-UM301W, NP-UM361X, NP-UM301X
• Apple, Mac, Mac OS, MacBook, and iMac are trademarks of Apple Inc. registered in the U.S. and other countries.
• Microsoft, Windows, Windows Vista, Internet Explorer, .NET Framework and PowerPoint are either a registered trademark or trademark of Microsoft Corporation in the United States and/or other countries.
• Intel and Intel Core are trademarks of Intel Corporation in the U.S. and/or other countries.
• PowerPC is a registered trademark of the International Business Machines Corporation.
• MicroSaver is a registered trademark of Kensington Computer Products Group, a division of ACCO Brands.
• Virtual Remote Tool uses WinI2C/DDC library, © Nicomsoft Ltd.
• HDMI, the HDMI Logo and High-Definition Multimedia Interface are trademarks or registered trademarks of HDMI Licensing LLC.

• MHL and the MHL logo are a trademark, registered trademark or service mark of MHL, LLC in the United States and/or other countries.

• Trademark PJLink is a trademark applied for trademark rights in Japan, the United States of America and other countries and areas.
• Wi-Fi®, Wi-Fi Alliance®, and Wi-Fi Protected Access (WPA, WPA2)® are registered trademarks of the Wi-Fi Alliance.
• Blu-ray is a trademark of Blu-ray Disc Association
• CRESTRON and ROOMVIEW are registered trademarks of Crestron Electronics, Inc. in the United States and other countries.
• Ethernet is either a registered trademark or trademark of Fuji Xerox Co., Ltd.
• Other product and company names mentioned in this user's manual may be the trademarks or registered trademarks of their respective holders.

• GPL/LGPL Software Licenses
  The product includes software licensed under GNU General Public License (GPL), GNU Lesser General Public License (LGPL), and others.
  For more information on each software, see “readme.pdf” inside the “about GPL&LGPL” folder on the supplied CD-ROM.

NOTES
(1) The contents of this user's manual may not be reprinted in part or whole without permission.
(2) The contents of this user's manual are subject to change without notice.
(3) Great care has been taken in the preparation of this user's manual; however, should you notice any questionable points, errors or omissions, please contact us.
(4) Notwithstanding article (3), NEC will not be responsible for any claims on loss of profit or other matters deemed to result from using the Projector.
Important Information

Safety Cautions

Precautions
Please read this manual carefully before using your NEC projector and keep the manual handy for future reference.

CAUTION
To turn off main power, be sure to remove the plug from power outlet.
The power outlet socket should be installed as near to the equipment as possible, and should be easily accessible.

CAUTION
TO PREVENT SHOCK, DO NOT OPEN THE CABINET.
THERE ARE HIGH-VOLTAGE COMPONENTS INSIDE.
REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

This symbol warns the user that uninsulated voltage within the unit may be sufficient to cause electrical shock. Therefore, it is dangerous to make any kind of contact with any part inside of the unit.

This symbol alerts the user that important information concerning the operation and maintenance of this unit has been provided.
The information should be read carefully to avoid problems.

WARNING: TO PREVENT FIRE OR SHOCK, DO NOT EXPOSE THIS UNIT TO RAIN OR MOISTURE.
DO NOT USE THIS UNIT'S PLUG WITH AN EXTENSION CORD OR IN AN OUTLET UNLESS ALL THE PRONGS CAN BE FULLY INSERTED.

DOC Compliance Notice (for Canada only)
This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment Regulations.

Machine Noise Information Regulation - 3. GPSGV,
The highest sound pressure level is less than 70 dB (A) in accordance with EN ISO 7779.

CAUTION
Avoid displaying stationary images for a prolonged period of time.
Doing so can result in these images being temporarily sustained on the surface of the LCD panel.
If this should happen, continue to use your projector. The static background from previous images will disappear.

Disposing of your used product
EU-wide legislation as implemented in each Member State requires that used electrical and electronic products carrying the mark (left) must be disposed of separately from normal household waste. This includes projectors and their electrical accessories or lamps. When you dispose of such products, please follow the guidance of your local authority and/or ask the shop where you purchased the product.
After collecting the used products, they are reused and recycled in a proper way. This effort will help us reduce the wastes as well as the negative impact such as mercury contained in a lamp to the human health and the environment at the minimum level.
The mark on the electrical and electronic products only applies to the current European Union Member States.
Important Information

WARNING TO CALIFORNIA RESIDENTS:
Handling the cables supplied with this product will expose you to lead, a chemical known to the State of California to cause birth defects or other reproductive harm. WASH HANDS AFTER HANDLING.

RF Interference (for USA only)

WARNING
The Federal Communications Commission does not allow any modifications or changes to the unit EXCEPT those specified by NEC Display Solutions of America, Inc. in this manual. Failure to comply with this government regulation could void your right to operate this equipment. This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Reorient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the dealer or an experienced radio / TV technician for help.

For UK only: In UK, a BS approved power cord with moulded plug has a Black (five Amps) fuse installed for use with this equipment. If a power cord is not supplied with this equipment please contact your supplier.

Important Safeguards
These safety instructions are to ensure the long life of your projector and to prevent fire and shock. Please read them carefully and heed all warnings.

⚠️ Installation
- Do not place the projector in the following conditions:
  - on an unstable cart, stand, or table.
  - near water, baths, or damp rooms.
  - in direct sunlight, near heaters, or heat radiating appliances.
  - in a dusty, smoky or steamy environment.
  - on a sheet of paper or cloth, rugs or carpets.
- If you wish to have the projector installed on the ceiling:
  - Do not attempt to install the projector yourself.
  - The projector must be installed by qualified technicians in order to ensure proper operation and reduce the risk of bodily injury.
  - In addition, the ceiling must be strong enough to support the projector and the installation must be in accordance with any local building codes.
  - Please consult your dealer for more information.
**Important Information**

**WARNING**

- Do not place any objects, which are easily affected by heat, in front of the projection window. Doing so could lead to the object melting from the heat that is emitted from the light output.

- Do not use a spray containing flammable gas to get rid of accumulated dust and dirt on the filters and the projection window. It may cause of fire.

**Place the projector in a horizontal position**

The tilt angle of the projector should not exceed 10 degrees, nor should the projector be installed in any way other than the desktop and ceiling mount, otherwise lamp life could decrease dramatically.

**Fire and Shock Precautions**

- Ensure that there is sufficient ventilation and that vents are unobstructed to prevent the build-up of heat inside your projector. Allow at least 4 inches (10cm) of space between your projector and a wall.
- Do not try to touch the exhaust vent as it can become heated while the projector is turned on and immediately after the projector is turned off. Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the AC power supply is disconnected during normal projector operation. Use caution when picking up the projector.
- Prevent foreign objects such as paper clips and bits of paper from falling into your projector. Do not attempt to retrieve any objects that might fall into your projector. Do not insert any metal objects such as a wire or screwdriver into your projector. If something should fall into your projector, disconnect it immediately and have the object removed by a qualified service personnel.
- Do not place any objects on top of the projector.
- Do not touch the power plug during a thunderstorm. Doing so can cause electrical shock or fire.
- The projector is designed to operate on a power supply of 100-240V AC 50/60 Hz. Ensure that your power supply fits this requirement before attempting to use your projector.
- Do not look into the projection window while the projector is on. Serious damage to your eyes could result.
- Keep any items such as magnifying glass out of the light path of the projector. The light being projected from the projection window is extensive, therefore any kind of abnormal objects that can redirect light coming out of the projection window, can cause unpredictable outcome such as fire or injury to the eyes.
- Do not place any objects, which are easily affected by heat, in front of a projector exhaust vent. Doing so could lead to the object melting or getting your hands burned from the heat that is emitted from the exhaust.
- Do not splash water over the projector. Doing so can cause electrical shock or fire. If the projector gets wet, turn off
the projector, unplug the power cord and have the projector serviced by a qualified service personnel.

- Handle the power cord carefully. A damaged or frayed power cord can cause electric shock or fire.
  - Do not use any power cord other than the one supplied with the projector.
  - Do not bend or tug the power cord excessively.
  - Do not place the power cord under the projector, or any heavy object.
  - Do not cover the power cord with other soft materials such as rugs.
  - Do not heat the power cord.
  - Do not handle the power plug with wet hands.
- Turn off the projector, unplug the power cord and have the projector serviced by a qualified service personnel under the following conditions:
  - When the power cord or plug is damaged or frayed.
  - If liquid has been spilled into the projector, or if it has been exposed to rain or water.
  - If the projector does not operate normally when you follow the instructions described in this user's manual.
  - If the projector has been dropped or the cabinet has been damaged.
  - If the projector exhibits a distinct change in performance, indicating a need for service.
- Disconnect the power cord and any other cables before carrying the projector.
- Turn off the projector and unplug the power cord before cleaning the cabinet or replacing the lamp.
- Turn off the projector and unplug the power cord if the projector is not to be used for an extended period of time.
- When using a LAN cable (only models with the RJ-45 LAN port):
  For safety, do not connect to the terminal for peripheral device wiring that might have excessive voltage.

**CAUTION**

- Be sure to tighten the screws after attaching the cable cover. Failure to do so may cause the cable cover to come off and fall, resulting in injury or damage to the cable cover.
- Do not put bundled cables in the cable cover. Doing so may damage the power cord, resulting in a fire.
- Do not hold the cable cover while moving the projector or do not apply excessive force to the cable cover. Doing so may damage the cable cover, resulting in injury.
- Do not use the feet for purposes other than originally intended. Misuses such as gripping the tilt-foot or hanging on the wall can cause damage to the projector.
- Do not send the projector in the soft case by parcel delivery service or cargo shipment. The projector inside the soft case could be damaged.
- Select [HIGH] in Fan mode if you continue to use the projector for consecutive days. (From the menu, select [SETUP] → [OPTIONS(1)] → [FAN MODE] → [HIGH].)
- Do not turn off the AC power for 60 seconds after the lamp is turned on and while the POWER indicator is blinking blue. Doing so could cause premature lamp failure.

**Remote Control Precautions**

- Handle the remote control carefully.
- If the remote control gets wet, wipe it dry immediately.
- Avoid excessive heat and humidity.
- Do not short, heat, or take apart batteries.
- Do not throw batteries into fire.
- If you will not be using the remote control for a long time, remove the batteries.
- Ensure that you have the batteries’ polarity (+/−) aligned correctly.
- Do not use new and old batteries together, or use different types of batteries together.
- Dispose of used batteries according to your local regulations.
Important Information

Note for US Residents
The lamp in this product contains mercury. Please dispose according to Local, State or Federal Laws.

Lamp Replacement
- Use the specified lamp for safety and performance.
- To replace the lamp, follow all instructions provided on page 122.
- Be sure to replace the lamp and filter when the message \text{[THE LAMP HAS REACHED THE END OF ITS USABLE LIFE. PLEASE REPLACE THE LAMP AND FILTER.]} appears. If you continue to use the lamp after the lamp has reached the end of its usable life, the lamp bulb may shatter, and pieces of glass may be scattered in the lamp case. Do not touch them as the pieces of glass may cause injury. If this happens, contact your dealer for lamp replacement.

A Lamp Characteristic
The projector has a discharge lamp as special purposes as a light source. A lamp has a characteristic that its brightness gradually decreases with age. Also repeatedly turning the lamp on and off will increase the possibility of its lower brightness. The actual lamp life may vary depending upon the individual lamp, the environmental conditions and usage.

\textbf{CAUTION:}
- DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector off and then disconnect the power cord. Allow at least one hour for the lamp to cool before handling.
- When removing the lamp from a ceiling-mounted projector, make sure that no one is under the projector. Glass fragments could fall if the lamp has been burned out.

About High Altitude mode
- Set \{FAN MODE\} to \{HIGH ALTITUDE\} when using the projector at altitudes approximately 5500 feet/1700 meters or higher.
  Using the projector at altitudes approximately 5500 feet/1700 meters or higher without setting to \{HIGH ALTITUDE\} can cause the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and turn on the projector.
- Using the projector at altitudes less than approximately 5500 feet/1700 meters and setting to \{HIGH ALTITUDE\} can cause the lamp to overcool, causing the image to flicker. Switch \{FAN MODE\} to \{AUTO\}.
- Using the projector at altitudes approximately 5500 feet/1700 meters or higher can shorten the life of optical components such as the lamp.

About Copyright of original projected pictures:
Please note that using this projector for the purpose of commercial gain or the attraction of public attention in a venue such as a coffee shop or hotel and employing compression or expansion of the screen image with the following functions may raise concern about the infringement of copyrights which are protected by copyright law. \{ASPECT RATIO\}, \{KEYSTONE\}, Magnifying feature and other similar features.

Turkish RoHS information relevant for Turkish market
EEE Yönetmeliğine Uygundur.

This device is not intended for use in the direct field of view at visual display workplaces. To avoid incommending reflections at visual display workplaces this device must not be placed in the direct field of view.
**Power management function**

The projector has power management functions. To reduce power consumption, the power management functions (1 and 2) are factory preset as shown below. To control the projector from an external device via a LAN or serial cable connection, use the on-screen menu to change the settings for 1 and 2.

1. **STANDBY MODE (Factory preset: NORMAL)**
   
   To control the projector from an external device, select [NETWORK STANDBY] for [STANDBY MODE].

   **NOTE:**
   - When [NORMAL] is selected for [STANDBY MODE], the following connectors and functions will not work: MONITOR OUT connector, AUDIO OUT connector, USB(PC) port, LAN functions, Mail Alert function, DDC/CI (Virtual Remote Tool). Please refer to page 94 about details.

2. **AUTO POWER OFF (Factory preset: 1 hour)**

   To control the projector from an external device, select [OFF] for [AUTO POWER OFF].

   **NOTE:**
   - When [1:00] is selected for [AUTO POWER OFF], you can enable the projector to automatically turn off in 60 minutes if there is no signal received by any input or if no operation is performed.
# Table of Contents

## Important Information

### 1. Introduction

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What's in the Box?</td>
<td>1</td>
</tr>
<tr>
<td>Introduction to the Projector</td>
<td>2</td>
</tr>
<tr>
<td>Features you’ll enjoy:</td>
<td>2</td>
</tr>
<tr>
<td>About this user’s manual</td>
<td>3</td>
</tr>
</tbody>
</table>

### 3. Convenient Features

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turning off the Image and Sound</td>
<td>26</td>
</tr>
<tr>
<td>Freezing a Picture</td>
<td>26</td>
</tr>
<tr>
<td>Magnifying a Picture</td>
<td>26</td>
</tr>
<tr>
<td>Changing Eco Mode/Checking Energy-Saving Effect</td>
<td>27</td>
</tr>
<tr>
<td>Using Eco Mode [ECO MODE]</td>
<td>27</td>
</tr>
<tr>
<td>Checking Energy-Saving Effect [CARBON METER]</td>
<td>28</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using 4-Point Corner to Correct Keystone Distortion [CORNERSTONE]</td>
<td>29</td>
</tr>
<tr>
<td>Cornerstone</td>
<td>29</td>
</tr>
</tbody>
</table>

## 2. Projecting an Image (Basic Operation)

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flow of Projecting an Image</td>
<td>12</td>
</tr>
<tr>
<td>Connecting Your Computer/Connecting the Power Cord</td>
<td>13</td>
</tr>
<tr>
<td>Turning on the Projector</td>
<td>14</td>
</tr>
<tr>
<td>Note on Startup screen (Menu Language Select screen)</td>
<td>15</td>
</tr>
<tr>
<td>Selecting a Source</td>
<td>16</td>
</tr>
<tr>
<td>Selecting the computer or video source</td>
<td>16</td>
</tr>
<tr>
<td>Adjusting the Picture Size and Position</td>
<td>17</td>
</tr>
<tr>
<td>Adjusting horizontal/vertical position</td>
<td>18</td>
</tr>
<tr>
<td>Adjusting the focus (Focus ring)</td>
<td>18</td>
</tr>
<tr>
<td>Adjusting the tilt (Tilt foot)</td>
<td>19</td>
</tr>
<tr>
<td>Adjusting the size [Digital Zoom]</td>
<td>20</td>
</tr>
<tr>
<td>Correcting Keystone Distortion [KEYSTONE]</td>
<td>21</td>
</tr>
<tr>
<td>Optimizing Computer Signal Automatically</td>
<td>23</td>
</tr>
<tr>
<td>Adjusting the Image Using Auto Adjust</td>
<td>23</td>
</tr>
<tr>
<td>Turning Up or Down Volume</td>
<td>23</td>
</tr>
<tr>
<td>Turning off the Projector</td>
<td>24</td>
</tr>
<tr>
<td>When Moving the Projector</td>
<td>25</td>
</tr>
</tbody>
</table>

## 3. Convenient Features

- Turning off the Image and Sound
- Freezing a Picture
- Magnifying a Picture
- Changing Eco Mode/Checking Energy-Saving Effect
  - Using Eco Mode [ECO MODE]
  - Checking Energy-Saving Effect [CARBON METER]
- Using 4-Point Corner to Correct Keystone Distortion [CORNERSTONE]
Table of Contents

Pincushion .................................................................................................................. 31
6 Preventing the Unauthorized Use of the Projector [SECURITY] .................................. 33
7 Using the Computer Cable (VGA) to Operate the Projector (Virtual Remote Tool) ..... 36
8 Operating Your Computer's Mouse Functions from the Projector's Remote Control
via the USB Cable (Remote Mouse Function) ............................................................. 42
9 Projecting Your Computer's Screen Image from the Projector via the USB Cable
(USB Display) ........................................................................................................... 43
10 Controlling the Projector by Using an HTTP Browser ............................................. 45
11 Controlling the Projector over a LAN (PC Control Utility Pro 4/Pro 5) ....................... 52
12 Projecting Your Computer's Screen Image from the Projector over a LAN (Image
Express Utility Lite) ................................................................................................. 56
Starting Image Express Utility Lite from a USB Memory or SD Card ....................... 59
13 Projecting an Image from an Angle (Geometric Correction Tool in Image Express
Utility Lite) ............................................................................................................... 61
What you can do with GCT ..................................................................................... 61
Projecting an Image from an Angle (GCT) ............................................................... 61
14 Connecting Your Microphone .................................................................................. 63

4. Using the Viewer ........................................................................................................ 64
1 What you can do with the Viewer ............................................................................. 64
2 Projecting images stored in a USB memory device ................................................. 66

5. Using On-Screen Menu .............................................................................................. 72
1 Using the Menus ......................................................................................................... 72
2 Menu Elements .......................................................................................................... 73
3 List of Menu Items ...................................................................................................... 74
4 Menu Descriptions & Functions [SOURCE] ............................................................. 77
   COMPUTER ............................................................................................................. 77
   HDMI1/MHL and HDMI2 ....................................................................................... 77
   VIDEO ..................................................................................................................... 77
   USB-A ..................................................................................................................... 77
   LAN ......................................................................................................................... 77
   USB-B ..................................................................................................................... 77
5 Menu Descriptions & Functions [ADJUST] ............................................................. 78
   [PICTURE] ............................................................................................................... 78
   [IMAGE OPTIONS] ............................................................................................... 81
   [AUDIO] ............................................................................................................... 85
6 Menu Descriptions & Functions [SETUP] .............................................................. 86
   [GENERAL] ............................................................................................................ 86
   [MENU] ................................................................................................................ 88
   [INSTALLATION] ................................................................................................. 90
   [OPTIONS(1)] .................................................................................................... 92
   [OPTIONS(2)] .................................................................................................... 94
   Setting up the Projector for a Wired LAN Connection [WIRED LAN] .................... 96
   Setting up the Projector for a Wireless LAN Connection (with the optional USB
Wireless LAN Unit equipped) [WIRELESS LAN] .............................................. 97
7 Menu Descriptions & Functions [INFO.] ............................................................... 99
   [USAGE TIME] .................................................................................................... 99
# Table of Contents

- [SOURCE(1)] ........................................................................................................ 100
- [SOURCE(2)] ........................................................................................................ 100
- [WIRED LAN] ....................................................................................................... 100
- [WIRELESS LAN] ................................................................................................... 101
- [VERSION] ............................................................................................................... 101
- [OTHERS] ............................................................................................................... 101

6. Installation and Connections ........................................................................... 103
   - Setting Up the Screen and the Projector ............................................................ 103
   - Making Connections .......................................................................................... 106
     - Connecting Your Computer ............................................................................. 106
     - Connecting an External Monitor .................................................................... 108
     - Connecting Your DVD Player or Other AV Equipment ............................... 109
     - Connecting Component Input ......................................................................... 110
     - Connecting HDMI Input ................................................................................ 111
     - Connecting a smart phone and a tablet terminal ............................................. 112
     - Connecting your document camera ................................................................. 113
     - Table projection .............................................................................................. 113
     - Connecting to a Wired LAN ............................................................................ 114
     - Connecting to a Wireless LAN (Optional: NP05LM series) ........................... 115

7. Maintenance ........................................................................................................ 118
   - Cleaning the Filters .......................................................................................... 118
   - Cleaning the Projection Window ...................................................................... 121
   - Cleaning the Cabinet ....................................................................................... 121
   - Replacing the Lamp and the Filters .................................................................. 122

8. Appendix ............................................................................................................. 128
   - Troubleshooting .............................................................................................. 128
     - Indicator Messages ......................................................................................... 128
     - Common Problems & Solutions ..................................................................... 129
     - If there is no picture, or the picture is not displayed correctly ...................... 130
   - Specifications .................................................................................................. 131
   - Cabinet Dimensions ....................................................................................... 133
   - Pin Assignments of D-Sub COMPUTER Input Terminal ................................... 134
   - Compatible Input Signal List .......................................................................... 135
   - PC Control Codes and Cable Connection .......................................................... 136
   - Troubleshooting Check List ............................................................................. 137
   - TCO Certification ............................................................................................. 139
   - REGISTER YOUR PROJECTOR! (for residents in the United States, Canada, and Mexico) ................................................................. 140
1. Introduction

1 What’s in the Box?
Make sure your box contains everything listed. If any pieces are missing, contact your dealer. Please save the original box and packing materials if you ever need to ship your projector.

- Projector
- Cable cover (24FU2001) (attached to the projector at the time of shipment → page 5)
- Remote control (7N901051)
- Batteries (AAA × 2)
- Power cord (US: 7N080240/7N080243) (EU: 7N080027/7N080029)
- Computer cable (VGA) (7N520089)
- Wireless receiver strap
- NEC Projector CD-ROM
  User’s manual (PDF) and the utility software (7N952071)
- Important Information (For North America: 7N8N5231) (For Other countries than North America: 7N8N5231 and 7N8N5241)
- Quick Setup Guide (7N8N5251)/ (7N8N5281)

For North America only
Limited warranty
For customers in Europe:
You will find our current valid Guarantee Policy on our Web Site:
www.nec-display-solutions.com

Unless otherwise described in the user’s manual, the drawings for the projector cabinet show examples of the UM351W.
Introduction to the Projector

This section introduces you to your new projector and describes the features and controls.

Features you'll enjoy:

- **Ultra short throw distances**
  Ultra short focal lenses provide for a larger image using a shorter throw distance when compared to a typical projector lens.
  
  UM361X/UM301X: Max 116.6” (UM351W/UM301W: Max 110”), throw distance: 51 cm/20 inches
  (The throw distance refers to the distance between the screen and the screen side of the projector)

- **Quick start (6 seconds**), Quick Power Off, Direct Power Off
  6 seconds* after turning on the power, the projector is ready to display PC or video images.
  The projector can be put away immediately after the projector is powered down. No cool down period is required after the projector is turned off from the remote control or cabinet control panel.
  The projector has a feature called “Direct Power Off”. This feature allows the projector to be turned off (even when projecting an image) by using the Main Power Switch or disconnecting the AC power supply.
  To turn off the AC power supply when the projector is powered on, use a power strip equipped with a switch and a breaker.
  
  *1 The quick start time is only when [STANDBY MODE] is set to [NETWORK STANDBY] in the on-screen message.

- **0.22W(100-130 V AC)/0.39W (200-240 V AC) in standby condition with energy saving technology**
  Selecting [NORMAL] for [STANDBY MODE] from the menu can put the projector in power-saving mode that consumes only 0.22W(100-130 V AC)/0.39W (200-240 V AC).

- **Carbon Meter**
  This feature will show energy-saving effect in terms of CO₂ emission reduction (kg) when the projector’s [ECO MODE] is set to [AUTO ECO], [NORMAL], or [ECO].
  The amount of CO₂ emission reduction will be displayed in the confirmation message at the time of power-off and in the INFO of the on-screen menu.

- **Lamp life up to 8000 hours**
  Using in Eco Mode (ECO) allows you to prolong the projector’s lamp life up to 8000 hours (up to 4000 hours in ECO MODE OFF).
  *2 UM351W/UM361X: 6000 hours (up to 3800 hours in ECO MODE OFF)

- **Two HDMI inputs supports digital signals**
  The two HDMI inputs provide HDCP compatible digital signals. The HDMI input also supports audio signal.

- **Project the image on a smart phone and a tablet**
  Since the projector supports MHL (Mobile High-definition Link), it can project videos and photos on a smart phone and a tablet terminal by connection, and output their sound from the built-in speaker.

- **20 W built-in speaker for an integrated audio solution**
  Powerful 20 watt monaural speaker provides volume need for large rooms.

- **MIC Input provided**
  A MIC input jack for a commercially available dynamic microphone is useful for your presentation in a conference room or lecture in a classroom.

- **The optional interactive white board kit (NP03Wi, sold separately) and the projector can be used to convert your whiteboard into a virtual touchscreen.**
  By the optional stylus pen, it’s able to directly write-into the projected image that realizes more effective presentation and lecture.
1. Introduction

- **Correspond to various installation**
  Besides installation on the wall, it can correspond various installation as projecting image up onto the ceiling, onto the table, and onto the floor, etc.

- **The supplied remote control allows you to assign a CONTROL ID to the projector**
  Multiple projectors can be operated separately and independently with the same single remote control by assigning an ID number to each projector.

- **USB Display**
  Using a commercially available USB cable (compatible with USB 2.0 specifications) to connect the computer with the projector allows you to send your computer screen image to the projector without the need of a traditional computer cable (VGA).

- **Integrated RJ-45 terminal for wired networking capability along with wireless networking capabilities**
  An RJ-45 terminal is standard. An optional USB Wireless LAN Unit is required for wireless LAN connection.

- **Software programs (User Supportware) contained in the supplied CD-ROM**
  The supplied NEC Projector includes three programs: Virtual Remote Tool, Image Express Utility Lite (for Windows/Mac OS), and PC Control Utility Pro 4 (for Windows)/5 (for Mac OS).
  Image Express Utility Lite (for Windows) can be started from a commercially available USB memory or SD card without the need of installing on your computer.

- **AUTO POWER ON and AUTO POWER OFF features**
  The DIRECT POWER ON, AUTO POWER ON, AUTO POWER OFF, and OFF TIMER features eliminate the need to always use the POWER button on the remote control or projector cabinet.

- **Preventing unauthorized use of the projector**
  Enhanced smart security settings for keyword protection, cabinet control panel lock, security slot, and security chain opening to help prevent unauthorized access, adjustments and theft deterrence.

- **High resolution up to WUXGA**
  High resolution display - up to WUXGA compatible, XGA (UM361X/UM301X)/WXGA (UM351W/UM301W) native resolution.
  *3 When WXGA MODE is set to ON.

- **CRESTRON ROOMVIEW compatibility**
  The projector supports CRESTRON ROOMVIEW, allowing multiple devices connected in the network to be managed and controlled from a computer or controller.

**About this user’s manual**

The fastest way to get started is to take your time and do everything right the first time. Take a few minutes now to review the user’s manual. This may save you time later on. At the beginning of each section of the manual you’ll find an overview. If the section doesn’t apply, you can skip it.
Part Names of the Projector

Top and Screen Side of Projector

- **Filter Cover/Intake Vent/Filter** (→ page 118, 125)
- **Spacer (Left/Right)**
  To fine-adjust the height of the rear foot, remove the spacer and rotate the rear foot to the desired height. (→ page 19)
- **Focus Ring** (→ page 18)
- **Projection Window**
- **Intake Vent/Filter** (→ page 118, 125)
- **Security chain opening**
  Attach an anti-theft device. The security chain opening accepts security wires or chains up to 0.18 inch/4.6 mm in diameter.
- **Built-in Security Slot ( )*  
  * This security slot supports the MicroSaver® Security System.
- **Tilt Foot** (→ page 19)

Terminal Panel Side of Projector

- **Lamp Cover** (→ page 123)
- **Exhaust Vent**
- **Remote Sensor** (→ page 10)
- **Terminal Panel** (→ page 8)
- **Screw Hole for Cable Cover (Left/Right)** (→ page 6)
- **AC Input**
  Connect the supplied power cord’s three-pin plug here, and plug the other end into an active wall outlet. (→ page 13)
- **Monaural Speaker (20 W)**
- **Controls** (→ page 7)
Removing and Attaching the Cable Cover

After finishing connections, attach the supplied cable cover to properly hide the cables.

⚠️ **CAUTION:**
- Be sure to tighten the screws after attaching the cable cover. Failure to do so may cause the cable cover to come off and fall, resulting in injury or damage to the cable cover.
- Do not put bundled cables in the cable cover. Doing so may damage the power cord, resulting in a fire.
- Do not hold the cable cover while moving the projector or do not apply excessive force to the cable cover. Doing so may damage the cable cover, resulting in injury.

Removing the cable cover

Tool needed:
- Phillips screwdriver (plus-head) about 9 cm/4 inches in length

1. Loosen the cable cover screws until the Phillips screwdriver goes into a freewheeling condition.
   - These screws remain to stay.

2. Remove the cable cover.
   1. Push up the cable cover slightly and rotate it to release.
   2. Pull the cable cover while pushing and holding the arrow part
      If you find it to hard to release the cable cover, try holding it slightly up.
Attaching the cable cover

1. Align four tabs of the cable cover with grooves of the projector and push the cable cover until you click it.

   **NOTE:**
   - Be careful not to get cables caught in between the cable cover and the projector.

2. Tighten the cable cover screws.
   - Be sure to tighten the screws.
1.  (POWER) Button (→ page 14, 24)
2.  POWER Indicator (→ page 13, 14, 24, 128)
3.  STATUS Indicator (→ page 128)
4.  LAMP Indicator (→ page 122, 128)
5.  ECO Button (→ page 27)
6.  SOURCE Button (→ page 16)
7.  AUTO ADJ. Button (→ page 23)
8.  MENU Button (→ page 72)
9.  ▲▼◄► / Volume Buttons ◄► / Keystone Buttons
   (→ page 15, 21, 23, 72)
10. ENTER Button (→ page 72)
11. EXIT Button (→ page 72)
Terminal Panel Features

1. COMPUTER IN/ Component Input Terminal (Mini D-Sub 15 Pin) (→ page 106, 110, 113)
2. COMPUTER AUDIO IN Mini Jack (Stereo Mini) (→ page 106, 107, 110)
3. HDMI 1/MHL IN Terminal (Type A) (→ page 106, 107, 111, 112)
4. HDMI 2 IN Terminal (Type A) (→ page 106, 107, 111)
5. USB (PC) Port (Type B) (→ page 42, 43, 106)
6. MONITOR OUT (COMPUTER) Terminal (Mini D-Sub 15 Pin) (→ page 108)
7. AUDIO OUT Mini Jack (Stereo Mini) (→ page 108)
8. VIDEO IN Terminal (RCA) (→ page 109, 113)
9. VIDEO/S-VIDEO AUDIO IN L/MONO, R (RCA) (→ page 109)
10. MIC Input Jack (Monaural Mini) (→ page 63)
11. LAN Port (RJ-45) (→ page 114)
12. USB (Wireless LAN) Port (→ page 115)
13. USB Port (Type A) (→ page 66)
14. PC CONTROL [PC CONTROL] Port (D-Sub 9 Pin) (→ page 136)

Use this port to connect a PC or control system. This enables you to control the projector using serial communication protocol. If you are writing your own program, typical PC control codes are on page 136.
Part Names of the Remote Control

1. Infrared Transmitter
   (→ page 10)

2. POWER ON Button
   (→ page 14)

3. POWER STANDBY Button
   (→ page 24)

4. SOURCE Button
   (→ page 16)

5. COMPUTER 1 Button
   (→ page 16)

6. COMPUTER 2 Button
   (This button does not work in this series of projectors)

7. AUTO ADJ. Button
   (→ page 23)

8. HDMI 1/MHL Button
   (→ page 16)

9. HDMI 2 Button
   (→ page 16)

10. DisplayPort Button
    (→ page 16)

11. VIDEO Button (→ page 16)

12. USB-A Button (→ page 16, 66, 68)

13. USB-B Button (→ page 16, 106)

14. LAN Button (→ page 16)

15. ID SET Button
    (→ page 91)

    (→ page 91)

17. FREEZE Button
    (→ page 26)

18. AV-MUTE Button
    (→ page 26)

19. MENU Button
    (→ page 72)

20. EXIT Button (→ page 72)

21. ▲▼ ◀apeshift Button (→ page 72)

22. ENTER Button (→ page 72)

23. D-ZOOM (+)(–) Button
    (→ page 26, 27)

24. MOUSE L-CLICK Button*
    (→ page 42)

25. MOUSE R-CLICK Button*
    (→ page 42)

26. PAGE ▽/△ Button
    (→ page 42)

27. ECO Button (→ page 27)

28. KEYSTONE Button
    (→ page 29)

29. PICTURE Button
    (→ page 78, 80)

30. VOL. (+)(–) Button
    (→ page 23)

31. ASPECT Button
    (→ page 83)

32. FOCUS/ZOOM Button
    The ZOOM button will display the DIGITAL ZOOM bar.
    (→ page 20, 86) The FOCUS button does not work on this series of projectors.

33. HELP Button
    (→ page 99)

* The MOUSE L-CLICK and MOUSE R-CLICK buttons work only when a USB cable is connected with your computer.
Battery Installation

1. Press firmly and slide the battery cover off.
2. Install new batteries (AAA). Ensure that you have the batteries’ polarity (+/-) aligned correctly.
3. Slip the cover back over the batteries until it snaps into place. Do not mix different types of batteries or new and old batteries.

Remote Control Precautions

- Handle the remote control carefully.
- If the remote control gets wet, wipe it dry immediately.
- Avoid excessive heat and humidity.
- Do not short, heat, or take apart batteries.
- Do not throw batteries into fire.
- If you will not be using the remote control for a long time, remove the batteries.
- Ensure that you have the batteries’ polarity (+/-) aligned correctly.
- Do not use new and old batteries together, or use different types of batteries together.
- Dispose of used batteries according to your local regulations.

Operating Range for Wireless Remote Control

- The infrared signal operates by line-of-sight up to a distance of about 22 feet/7 m and within a 60-degree angle of the remote sensor on the projector cabinet.
- The projector will not respond if there are objects between the remote control and the sensor, or if strong light falls on the sensor. Weak batteries will also prevent the remote control from properly operating the projector.
## 5. Software Included on CD-ROM

Names and Features of Bundled Software Programs

<table>
<thead>
<tr>
<th>Name of software program</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>Virtual Remote Tool</td>
<td>This is a software program used to control the power ON/OFF and source selection of the projector from your computer by using the supplied computer cable (VGA) and others. (→ page 36)</td>
</tr>
</tbody>
</table>
| Image Express Utility Lite | • This is a software program used to project your computer’s screen over the USB cable or the wired/wireless network. The computer cable (VGA) is not required. (→ page 56, 60)  
  • This software program can be used to control the power ON/OFF and source selection of the projector from your computer.  
  • The Geometric Correction Tool (GCT) function allows you to correct distortion of images projected on a curved wall. (→ page 61)  
  * “USB Display” and “GCT” functions are not supported by Mac. |
| PC Control Utility Pro 4 | This is a software program used to operate the projector from the computer when the computer and the projector are connected with LAN (wired or wireless) or a serial cable. (→ page 52) |

**NOTE:**
- *Image Express Utility Lite does not support “Meeting Mode” in Image Express Utility 2.0 supplied with our other models.*

### Download Service and Operating Environment

Please visit our website about operating environment and download service for each software:


Download - Projector → Software & Driver
2. Projecting an Image (Basic Operation)

This section describes how to turn on the projector and to project a picture onto the screen.

1 Flow of Projecting an Image

Step 1
• Connecting your computer / Connecting the power cord (→ page 13)

Step 2
• Turning on the projector (→ page 14)

Step 3
• Selecting a source (→ page 16)

Step 4
• Adjusting the picture size and position (→ page 17)
• Correcting keystone distortion [KEYSTONE] (→ page 21)

Step 5
• Adjusting a picture and sound
  - Optimizing a computer signal automatically (→ page 23)
  - Turning up or down volume (→ page 23)

Step 6
• Making a presentation

Step 7
• Turning off the projector (→ page 24)

Step 8
• When Moving the Projector (→ page 25)
Connecting Your Computer/Connecting the Power Cord

1. Connect your computer to the projector.
   This section will show you a basic connection to a computer. For information about other connections, see “6. Installation and Connections” on page 106.

   Connect the computer cable (VGA) between the projector’s COMPUTER IN terminal and the computer’s port (mini D-Sub 15 Pin). Turn two thumb screws of both terminals to fix the computer cable (VGA).

2. Connect the supplied power cord to the projector.
   First connect the supplied power cord’s three-pin plug to the AC IN of the projector, and then connect the other plug of the supplied power cord in the wall outlet.
   The projector’s power indicator will flash for a few seconds and then will light red* (standby mode).
   * This will apply for both indicators when [NORMAL] is selected for [STANDBY MODE]. See the Power Indicator section. (→ page 128)

   Make sure that the prongs are fully inserted into both the AC IN and the wall outlet.

   CAUTION:
   Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the AC power supply is disconnected during normal projector operation. Be careful to handle the projector.
3 Turning on the Projector

- Press the (POWER) button on the projector cabinet or the POWER ON button on the remote control.

The POWER indicator will blink and the projector will become ready to use.

TIP:
- When the message “Projector is locked! Enter your password.” is displayed, it means that the [SECURITY] feature is turned on. (→ page 33)

After you turn on your projector, ensure that the computer or video source is turned on.

NOTE: When no input signal is present, the no-signal guidance is displayed (factory menu setting).

(→ page 128)
2. Projecting an Image (Basic Operation)

**Note on Startup screen (Menu Language Select screen)**

When you first turn on the projector, you will get the Startup menu. This menu gives you the opportunity to select one of the 30 menu languages.

To select a menu language, follow these steps:

1. **Use the ▲, ▼, ◀ or ► button to select one of the 30 languages from the menu.**

2. **Press the ENTER button to execute the selection.**

After this has been done, you can proceed to the menu operation.

If you want, you can select the menu language later.  
(→ [LANGUAGE] on page 74 and 88)

**NOTE:**

- If the projector is shut off by DIRECT POWER OFF (pulling out the power cord) during projection, wait for 1 second at least for reconnect the power cord for turning on the projector.  
  Failing to do so could result in no power to the projector. (There will be no stand-by LED)  
  Should this happen, unplug the power cord and plug it in again. Turn on the main power.
- If one of the following things happens, the projector will not turn on.
  - If the internal temperature of the projector is too high, the projector detects abnormal high temperature. In this condition the projector will not turn on to protect the internal system. If this happens, wait for the projector’s internal components to cool down.
  - When the lamp reaches its end of usable life, the projector will not turn on. If this happens, replace the lamp.
  - If the STATUS indicator lights orange with the power button pressed, it means that the [CONTROL PANEL LOCK] is turned on. Cancel the lock by turning it off. (→ page 90)
  - If the lamp fails to light, and if the STATUS indicator flashes on and off in a cycle of six times, wait a full minute and then turn on the power.
- While the POWER indicator is blinking blue in short cycles, the power cannot be turned off by using the power button.
- Immediately after turning on the projector, screen flicker may occur. This is normal. Wait 3 to 5 minutes until the lamp lighting is stabilized.
- When the projector is turned on, it may take some time before the lamp light becomes bright.
- If you turn on the projector immediately after the lamp is turned off or when the lamp temperature is high, the fans run without displaying an image for some time and then the projector will display the image.
Selecting a Source

Selecting the computer or video source

NOTE: Turn on the computer or video source equipment connected to the projector.

Detecting the Signal Automatically
Press the SOURCE button once. The projector will search for the available input source and display it. The input source will change as follows:

COMPUTER → HDMI1/MHL → HDMI2 → VIDEO → USB-A → LAN → USB-B

• With the SOURCE screen displayed, you can press the SOURCE button a few times to select the input source.

TIP: If no input signal is present, the input will be skipped.

Using the Remote Control
Press any one of the COMPUTER 1, HDMI1/MHL, HDMI2, VIDEO, USB-A, USB-B, or LAN buttons.

Selecting Default Source
You can so that it will be displayed each time the projector is turned on.

1. Press the MENU button.
   The menu will be displayed.
2. Press the ► button twice to select [SETUP] and the ▼ button or the ENTER button to select [GENERAL].
3. Press the ► button four times to select [OPTIONS(2)].
4. Press the ▼ button five times to select [DEFAULT SOURCE SELECT] and press the ENTER button.
   The [DEFAULT SOURCE SELECT] screen will be displayed.
   (→ page 95)
5. Select a source as the default source, and press the ENTER button.
6. Press the EXIT button a few times to close the menu.
7. Restart the projector.
   The source you selected in step 5 will be projected.

TIP:
• When the projector is in Standby mode, applying a computer signal from a computer connected to the COMPUTER IN input will power on the projector and simultaneously project the computer's image.
  ([AUTO POWER ON] → page 95)
• On Windows 7, a combination of the Windows and P keys allows you to set up external display easily and quickly.
## Adjusting the Picture Size and Position

Use the adjustable tilt foot, the zoom function or the focus ring to adjust the picture size and position. *In this chapter drawings and cables are omitted for clarity.*

<table>
<thead>
<tr>
<th>Adjusting horizontal/vertical position (→ page 18)</th>
<th>Adjusting the focus [Focus ring] (→ page 18)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Adjusting horizontal/vertical position" /></td>
<td><img src="image2" alt="Adjusting the focus" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Finely adjusting the left and right tilt [Tilt Foot] (→ page 19)</th>
<th>Adjusting the size [Digital Zoom] (→ page 20)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3" alt="Finely adjusting the left and right tilt" /></td>
<td><img src="image4" alt="Adjusting the size" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Correcting the keystone distortion [Keystone]^* (→ page 21)</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image5" alt="Correcting the keystone distortion" /></td>
</tr>
</tbody>
</table>

^* To perform keystone correction manually, see “6. Correcting Keystone Distortion [KEYSTONE]” on page 21.
2. Projecting an Image (Basic Operation)

**Adjusting horizontal/vertical position**

The throw distance can affect the size and the height of the projected image. Before installing the projector, decide the throw distance according to “Setting Up the Screen and the Projector” (→ page 103, 104)

It is recommended to display the test pattern while adjusting the image. (→ page 92)

1. **Move the projector back and forth and left and right so that the image fits the screen width.**

   You can reduce the image size to 70% by using [DIGITAL ZOOM] from the menu.

2. **Place the projector so that it is parallel with the screen.**

   If the top side of the image is not parallel with its bottom side, rotate the projector slightly to adjust it. If the side of the image shows outside the screen, move it to the center line of the screen.

**Adjusting the focus (Focus ring)**

- **Rotate the focus ring until you obtain the best focus.**
2. Projecting an Image (Basic Operation)

Adjusting the tilt (Tilt foot)
Adjusting the left and right tilt.

1. **Rotate the tilt foot to adjust the left and right tilt.**
   
   The tilt foot is equipped at the left and the right front bottom of the projector.
   
   If the projected image is tilted, rotate one of the tilt foot to adjust the angle to project.
   
   If keystone distortion is appeared, adjust it either by the ▼ button on the cabinet or keystone button on the remote control

**NOTE:**
- Do not extend the tilt foot beyond its height limit (18 mm/0.7 inches). Doing so may cause the tilt foot to come out of the projector.
- Do not use the tilt-foot for purposes other than originally intended. Misuses such as using the tilt foot to carry or hang (from the wall or ceiling) the projector can cause damage to the projector.
2. Projecting an Image (Basic Operation)

Adjusting the size [Digital Zoom]
Use the remote control to finely adjust the size of the image.

1. **Press the FOCUS/ZOOM button on the remote control.**
   The DIGITAL ZOOM bar will be displayed.

2. **Press the ◀ or ▶ button to finely zoom in or out.**

3. **After completing the adjustment, press the ENTER button.**
   The DIGITAL ZOOM bar will be closed.

**NOTE:**
- This feature allows you to electronically fine adjust the image size on the screen.
- This feature can not be used when USB-A, LAN, or USB-B is selected as an input terminal.
Correcting Keystone Distortion [KEYSTONE]

When the projector is not exactly perpendicular to the screen, keystone distortion occurs. To overcome it, you can use the "Keystone" function, a digital technology that can adjust for keystone-type distortion, resulting in a crisp, square image.

The following procedure explains how to use the [KEYSTONE] screen from the menu to correct trapezoidal distortions.

When the projector is placed diagonally to the screen,
- When the projector is set up at an angle in relation to the screen, adjust the Horizontal option of the Keystone menu so that the top and bottom of sides of the projected image are parallel.

1. Press the ▼ button on the projector cabinet.
   The Keystone screen will be displayed on the screen.
   • Press the KEYSTONE button when using the remote control.
   • See page for PINCUSHION.
   • See page for CORNERSTONE.
   • See page for RESET.

2. Press the ▼ button to select [VERTICAL] and then use the ◀ or ► so that the left and right sides of the projected image are parallel.
   • Adjust the vertical keystone distortion.

3. Align the left (or right) side of the screen with the left (or right) side of the projected image.
   • Use the shorter side of the projected image as the base.
   • In the right example, use the left side as the base.
2. Projecting an Image (Basic Operation)

4. Press the ▲ button to select [HORIZONTAL] and then use the ▲ or ▼ so that the top and bottom sides of the projected image are parallel.
   • Adjust the horizontal keystone distortion.

5. Repeat steps 2 and 4 to correct keystone distortion.

6. After completing Keystone correction, press the EXIT button.
   The Keystone screen will disappear.
   • To perform Keystone correction again, press the ▼ button to display the Keystone screen and repeat above steps 1 to 6.

To return the keystone adjustments to default:
1. Press the ▼ button to select [RESET] and press the ENTER button.

   ![Keystone Adjustment Screen]

2. Press the ▲ or ▼ button to select [YES] and press the ENTER button.

   ![Keystone Adjustment Confirmation]

   The adjustments will be reset.
   All the adjustments for all the five items will be reset at the same time.
   • The KEYSTONE feature can cause an image to be slightly blurred because the correction is made electronically.
7 Optimizing Computer Signal Automatically

Adjusting the Image Using Auto Adjust

Optimizing a computer image automatically. (COMPUTER)
Press the AUTO ADJ. button to optimize a computer image automatically.
This adjustment may be necessary when you connect your computer for the first time.

![Poor picture]

![Normal picture]

NOTE:
Some signals may take time to display or may not be displayed correctly.
• If the Auto Adjust operation cannot optimize the computer signal, try to adjust [HORIZONTAL], [VERTICAL], [CLOCK], and [PHASE] manually. (→ page 81, 82)

8 Turning Up or Down Volume

Sound level from the speaker or audio output can be adjusted.

TIP: When no menus appear, the ◄ and ► buttons on the projector cabinet work as a volume control.

NOTE:
• Volume control is not available with the ◄ or ► button when an image is magnified by using the D-ZOOM (+) button or when the menu is displayed.
• Volume control is not available with the ◄ or ► button when VIEWER is used.

TIP: The [BEEP] sound volume cannot be adjusted. To turn off the [BEEP] sound, from the menu, select [SETUP] → [OPTIONS (1)] → [BEEP] → [OFF].
9 Turning off the Projector

To turn off the projector:

1. First, press the (POWER) button on the projector cabinet or the STANDBY button on the remote control.
   The confirmation message will be displayed.

2. Secondly, press the ENTER button or press the (POWER) or the STANDBY button again.
   The lamp will turn off and the projector will go into standby mode. When in standby mode, the POWER indicator will light red and the STATUS indicator will turn off when [NORMAL] is selected for [STANDBY MODE].

![Power On/Standby Indicators]

**CAUTION:**
Parts of the projector may become temporarily heated if the projector is turned off with the POWER button or if the AC power supply is disconnected during normal projector operation. Use caution when picking up the projector.

**NOTE:**
- While the power indicator is blinking blue in short cycles, the power cannot be turned off.
- You cannot turn off the power for 60 seconds immediately after turning it on and displaying an image.
- Do not disconnect the AC power supply to the projector within 10 seconds of making adjustment or setting changes and closing the menu. Doing so can cause loss of adjustments and settings.
When Moving the Projector

Preparation: Make sure that the projector is turned off.

1. Remove the cable cover.
   (→ page 5)

2. Unplug the power cord.

3. Disconnect any other cables.
   - Remove the USB memory or the wireless LAN Unit if it is inserted into the projector.
     (→ page 66, 116)
3. Convenient Features

1 Turning off the Image and Sound
Press the AV-MUTE button to turn off the image and sound for a short period of time. Press again to restore the image and sound. The projector's power-saving function will work 10 seconds after the image is turned off. As a result, the lamp power will be reduced.

NOTE:
• Even though the image is turned off, the menu still remains on the screen.
• Sound from the AUDIO OUT jack (Stereo mini) can be turned off.
• Even when the power-saving function works, the lamp power may be restored to its original level temporarily.
• To restore the image, even if you press the AV-MUTE button immediately after the start of the power-saving function, the lamp brightness may not be restored to its original level.

2 Freezing a Picture
Press the FREEZE button to freeze a picture. Press again to resume motion.

NOTE: The image is frozen but the original video is still playing back.

• This feature can not be used when USB-A is selected as the input terminal.

3 Magnifying a Picture
You can enlarge the picture up to four times.

NOTE:
• The maximum magnification may be less than four times depending on the signal.
• This feature can not be used when LAN, and USB-B is selected as the input terminal.

To do so:
1. Press the D-ZOOM (+) button to magnify the picture.
   To move the magnified image, use the ▲,▼,◄, or ► button.
3. Convenient Features

2. Press the ▲▼◄► button.
The area of the magnified image will be moved

3. Press the D-ZOOM (−) button.
Each time the D-ZOOM (−) button is pressed, the image is reduced.

NOTE:
- The image will be magnified or demagnified at the center of the screen.
- Displaying the menu will cancel the current magnification.

4 Changing Eco Mode/Checking Energy-Saving Effect
Using Eco Mode [ECO MODE]
The ECO MODE (NORMAL and ECO) increases lamp life, while lowering power consumption and cutting down on CO₂ emissions.
Four brightness modes of the lamp can be selected: [OFF], [AUTO ECO], [NORMAL] and [ECO] modes.

<table>
<thead>
<tr>
<th>[ECO MODE]</th>
<th>Description</th>
<th>Status of LAMP indicator</th>
</tr>
</thead>
<tbody>
<tr>
<td>[OFF]</td>
<td>The lamp brightness is 100%.</td>
<td>![Lamp Off] Off</td>
</tr>
<tr>
<td>[AUTO ECO]</td>
<td>Lamp power consumption will be changed between [OFF] and [NORMAL] automatically according to picture level. <strong>NOTE:</strong> A bright gradation may be less visible depending on the image.</td>
<td>![Lamp Green] Steady Green light</td>
</tr>
<tr>
<td>[NORMAL]</td>
<td>Lamp power consumption: approx.80% brightness. The lamp life will extend by lowering the lamp power.</td>
<td>![Lamp Green] Steady Green light</td>
</tr>
<tr>
<td>[ECO]</td>
<td>Lamp power consumption (approx. 60% brightness). The lamp life will extend longer than the one on NORMAL mode by controlling power appropriate for the lamp. The maximum power becomes equivalent to the power in NORMAL.</td>
<td>![Lamp Green] Steady Green light</td>
</tr>
</tbody>
</table>

To turn on the [ECO MODE], do the following:
1. Press the ECO Button on the remote control to display [ECO MODE] screen.
2. Press the ECO button again to select a mode you wish.
   - Each time the ECO button is pressed, the choices will be changed:
     
     OFF → AUTO ECO → NORMAL → ECO → OFF

TIP:
- The leaf symbol at the bottom of the menu shows the current selection of ECO mode.
3. Convenient Features

NOTE:

- The [ECO MODE] can be changed by using the menu. Select [SETUP] → [GENERAL] → [ECO MODE].
- The lamp life remaining and lamp hours used can be checked in [USAGE TIME]. Select [INFO.] → [USAGE TIME].
- The projector is always in [NORMAL] for 90 seconds after the lamp is turned on and while the POWER indicator is blinking green. The lamp condition will not be affected even when [ECO MODE] is changed.
- After a lapse of 1 minute from when the projector displays no-signal guidance, a blue, black or logo screen, [ECO MODE] will automatically switch to [ECO]. The projector will return to its original setting once a signal is accepted.
- If the projector is overheated in [OFF] mode, there may be a case where the [ECO MODE] automatically changes to [NORMAL] mode to protect the projector. When the projector is in [NORMAL] mode, the picture brightness decreases. When the projector comes back to normal temperature, the [ECO MODE] returns to its original setting.
- Thermometer symbol [ ] indicates the [ECO MODE] is automatically set to [NORMAL] mode because the internal temperature is too high.
- Immediately after [ECO MODE] is changed from [ECO] to one of [OFF], [AUTO ECO], or [NORMAL], the lamp brightness may decrease temporarily. This is not a malfunction.

Checking Energy-Saving Effect [CARBON METER]

This feature will show energy-saving effect in terms of CO₂ emission reduction (kg) when the projector’s [ECO MODE] is set to [AUTO ECO], [NORMAL], or [ECO]. This feature is called as [CARBON METER].

There are two messages: [TOTAL CARBON SAVINGS] and [CARBON SAVINGS-SESSION]. The [TOTAL CARBON SAVINGS] message shows the total amount of CO₂ emission reduction from the time of shipment up to now. You can check the information on [USAGE TIME] from [INFO.] of the menu. (→ page 99)

The [CARBON SAVINGS-SESSION] message shows the amount of CO₂ emission reduction between the time of changing to ECO MODE immediately after the time of power-on and the time of power-off. The [CARBON SAVINGS-SESSION] message will be displayed in the [POWER OFF/ ARE YOU SURE?] message at the time of power-off.

TIP:

- The formula as shown below is used to calculate the amount of CO₂ emission reduction.
  Amount of CO₂ emission reduction = (Power consumption in OFF for ECO MODE − Power consumption in AUTO ECO/NORMAL/ECO for ECO MODE) × CO₂ conversion factor. * When the image is turned off with the AV-MUTE button, the amount of CO₂ emission reduction will also increase.
  * Calculation for amount of CO₂ emission reduction is based on an OECD publication “CO₂ Emissions from Fuel Combustion, 2008 Edition”.
- The [TOTAL CARBON SAVINGS] is calculated based on savings recorded in 15 minutes intervals.
- This formula will not apply to the power consumption which is not affected by whether [ECO MODE] is turned on or off.
5 Using 4-Point Corner to Correct Keystone Distortion
[CORNERSTONE]

Use the [CORNERSTONE] and [PINCUSHION] features to correct keystone (trapezoidal) distortion to make the top or bottom and the left or right side of the screen longer or shorter so that the projected image is rectangular.

Cornerstone
1. Press the KEYSTONE button with no menu displayed.

The KEYSTONE screen will be displayed.
• Press the KEYSTONE button when using the remote control.
• See page for PINCUSHION.

2. Press the ▼ button to select [CORNERSTONE] and press the ENTER button.

The CORNERSTONE screen will be displayed.

3. Project an image so that the screen is smaller than the area of the raster.
4. Pick up any one of the corners and align the corner of the image with a corner of the screen.

TIP: If you are adjusting [KEYSTONE HORIZONTAL], [KEYSTONE VERTICAL], [PINCUSHION LEFT/RIGHT], or [PINCUSHION TOP/BOTTOM], the [CORNERSTONE] item will not be available. If this happens, reset the [KEYSTONE] adjustments.

5. Use the ▲▼◄▶ button to select one icon (▲) which points in the direction you wish to move the projected image frame.
6. Press the ENTER button.
7. Use the ▲▼◀▶ button to move the projected image frame as shown on the example.

8. Press the ENTER button.

9. Use the ▲▼◀▶ button to select another icon which points in the direction.
   On the Cornerstone adjustment screen, select [EXIT] or press the EXIT button on the remote control.

10. Press the ◀ or ▶ button to highlight the [OK] and press the ENTER button.

This completes the Cornerstone correction.
Selecting [CANCEL] will return to the adjustment screen without saving changes (Step 3).
Selecting [RESET] will return to the factory default.
Selecting [UNDO] will exit without saving changes.
Pincushion

1. Press the KEYPSTONE button with no menu displayed.

The KEYSTONE screen will be displayed.

• Press the KEYSTONE button when using the remote control.

2. Press the ▼ button to select either PINCUSHION ADJUSTMENT LEFT/RIGHT or PINCUSHION ADJUSTMENT TOP/BOTTOM.

3. Press either ◄ or ► button to reform pincushion distortion.

4. Press the EXIT when PINCUSHION adjustment is completed.

NOTE:
• Even when the projector is turned on, the last used correction values are applied.
• [PINCUSHION] and [CORNERSTONE] corrections can cause the image to be slightly blurred because the correction is made electronically.

Reset the keystone adjustment to the initial value

1. Press the KEYPSTONE button with no menu displayed.

On the displayed KEYSTONE menu, set the cursor at RESET using the ▼ button and press ENTER button.

• Confirmation message is displayed on.
3. Convenient Features

2. Move the cursor onto YES using either ◀ or ▶ button and then press the ENTER.

**NOTE:**
- All adjusted values set in the KEYSTONE adjustment are reset to initial values

**TIP:**
Adjustable range of the KEYSTONE and the CORNERSTONE:

<table>
<thead>
<tr>
<th></th>
<th>Horizontal Direction</th>
<th>Vertical Direction</th>
</tr>
</thead>
<tbody>
<tr>
<td>CORNERSTONE</td>
<td>Approx. ±10° (Max)</td>
<td>Approx. ±10° (Max)</td>
</tr>
<tr>
<td>KEYSTONE</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Adjustable range may be narrower depending on input signal.
3. Convenient Features

6 Preventing the Unauthorized Use of the Projector [SECURITY]

A keyword can be set for your projector using the Menu to avoid operation by an unauthorized user. When a keyword is set, turning on the projector will display the Keyword input screen. Unless the correct keyword is entered, the projector cannot project an image.

- The [SECURITY] setting cannot be cancelled by using the [RESET] of the menu.

To enable the Security function:

1. Press the MENU button. The menu will be displayed.
2. Press the ► button twice to select [SETUP] and press the ▼ button or the ENTER button to select [GENERAL].
3. Press the ► button to select [INSTALLATION].
4. Press the ▼ button three times to select [SECURITY] and press the ENTER button.

The OFF/ON menu will be displayed.

5. Press the ▼ button to select [ON] and press the ENTER button.

The [SECURITY KEYWORD] screen will be displayed.

6. Type in a combination of the four ▲▼◄► buttons and press the ENTER button.

NOTE: A keyword must be 4 to 10 digits in length.

The [CONFIRM KEYWORD] screen will be displayed.
7. **Type in the same combination of ▲▼◄► buttons and press the ENTER button.**

   ![CONFIRM KEYWORD](image)

   The confirmation screen will be displayed.

8. **Select [YES] and press the ENTER button.**

   ![SECURITY FUNCTION WILL BE ENABLED. ARE YOU SURE?](image)

   The SECURITY function has been enabled.

To turn on the projector when [SECURITY] is enabled:

1. **Press the POWER button.**
   
   The projector will be turned on and display a message to the effect that the projector is locked.

2. **Press the MENU button.**

   ![SECURITY KEYWORD](image)

3. **Type in the correct keyword and press the ENTER button. The projector will display an image.**

   ![SECURITY KEYWORD](image)

   **NOTE:** The security disable mode is maintained until the main power is turned off or unplugging the power cord.
3. Convenient Features

To disable the SECURITY function:

1. **Press the MENU button.**
   
The menu will be displayed.

2. **Select [SETUP] → [INSTALLATION] → [SECURITY] and press the ENTER button.**

   ![Menu Screenshot]

   The OFF/ON menu will be displayed.

3. **Select [OFF] and press the ENTER button.**

   ![Security Menu]

   The SECURITY KEYWORD screen will be displayed.

4. **Type in your keyword and press the ENTER button.**

   When the correct keyword is entered, the SECURITY function will be disabled.

   **NOTE:** If you forget your keyword, contact your dealer. Your dealer will provide you with your keyword in exchange for your request code. Your request code is displayed in the Keyword Confirmation screen. In this example [NB52-YGK8-2VD6-K585-JNE6-EYA8] is a request code.
Using the Computer Cable (VGA) to Operate the Projector (Virtual Remote Tool)

Using the utility software “Virtual Remote Tool” included on the companion NEC Projector CD-ROM, Virtual Remote screen (or toolbar) can be displayed on your computer screen. This will help you perform operations such as projector’s power on or off and signal selection via the computer cable (VGA), serial cable, or LAN connection. Only via serial or LAN connection it is also used to send an image to the projector and register it as the logo data of the projector. After registering it, you can lock the logo to prevent it from changing.

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute, Logo transfer to the projector, and remote control operation on your PC.

This section provides an outline of preparation for use of Virtual Remote Tool.
For information on how to use Virtual Remote Tool, see Help of Virtual Remote Tool. (→ page 41)

Step 1: Install Virtual Remote Tool on the computer. (→ page 37)
Step 2: Connect the projector to the computer. (→ page 39)
Step 3: Start Virtual Remote Tool. (→ page 40)

TIP:
• Virtual Remote Tool can be used with a LAN and a serial connection. USB connection is not supported by Virtual Remote Tool.
• For update information on Virtual Remote Tool, visit our website:
3. Convenient Features

NOTE:

• When [COMPUTER] is selected from your source selection, the Virtual Remote screen or the toolbar will be displayed as well as your computer screen.

• Use the supplied computer cable (VGA) to connect the COMPUTER IN terminal directly with the monitor output terminal of the computer to use Virtual Remote Tool.
Using a switcher or other cables than the supplied computer cable (VGA) may cause failure in signal communication.

VGA cable terminal:
Pin Nos. 12 and 15 are required for DDC/CI.

• Virtual Remote Tool may not work depending on your computer’s specifications and version of graphic adapters or drivers.

• To run Virtual Remote Tool on Windows 8.1, Windows 8 and Windows XP, “Microsoft .NET Framework Version 2.0” is required. The Microsoft .NET Framework Version 2.0, 3.0 or 3.5 is available from Microsoft’s web page. Download and install it on your computer.

• Logo data (graphics) that can be sent to the projector with Virtual Remote Tool has the following restrictions:
(Only via serial or LAN connection)
- File size: Less than 1 MB
- Image size (resolution):
  UM361X/UM301X: Horizontal 1024 × vertical 768 dots or less
  UM351W/UM301W: Horizontal 1280 × vertical 800 dots or less
- Number of colors: 256 colors or less

• To put the default "NEC logo" back in the background logo, you need to register it as the background logo by using the image file (UM351W/UM301W: /Logo/necpj_bbwx.bmp, UM361X/UM301X: /Logo/necpj_bb_x.bmp) included on the supplied NEC Projector CD-ROM.

TIP:

• The projector’s COMPUTER IN terminal supports DDC/CI (Display Data Channel Command Interface). DDC/CI is a standard interface for bidirectional communication between display/projector and computer.

Step 1: Install Virtual Remote Tool on the computer

NOTE:

• To install Virtual Remote Tool, the Windows user account must have “Administrator” privilege (Windows 8.1, Windows 8, Windows 7, and Windows Vista) or “Computer Administrator” privilege (Windows XP).

• Exit all running programs before installing Virtual Remote Tool. If another program is running, the installation may not be completed.

1 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.
The menu window will be displayed.
3. Convenient Features

TIP:
If the menu window will not be displayed, try the following procedure.
For Windows 7
1. Click “start” on Windows.
2. Click “All Programs” → “Accessories” → “Run”.
3. Type your CD-ROM drive name (example: “Q:" ) and “LAUNCHER.EXE” in “Name”. (example: Q:\ LAUNCHER.EXE)
4. Click “OK”.
The menu window will be displayed.

2 Click “Install Virtual Remote Tool” on the menu window. The installation will start.

When the installation is complete, the Welcome window will be displayed.

3 Click “Next”. “END USER LICENSE AGREEMENT” screen will be displayed.

Read “END USER LICENSE AGREEMENT” carefully.
4 If you agree, click “I accept the terms in the license agreement” and then click “Next”.
   • Follow the instructions on the installer screens to complete the installation.
   • When the installation is complete, you will return to the menu window.
3. Convenient Features

TIP:

Uninstalling Virtual Remote Tool

Preparation:
Exit Virtual Remote Tool before uninstalling. To uninstall Virtual Remote Tool, the Windows user account must have “Administrator” privilege (Windows 8.1, Windows 8, Windows 7 and Windows Vista) or “Computer Administrator” privilege (Windows XP).

• For Windows 8.1, Windows 8, Windows 7 and Windows Vista
  1. Click “Start” and then “Control Panel”.
     The Control Panel window will be displayed.
  2. Click “Uninstall a program” under “Programs”
     The “Programs and Features” window will be displayed.
  3. Select Virtual Remote Tool and click it.
  4. Click “Uninstall/Change” or “Uninstall”.
     • When the “User Account Control” window is displayed, click “Continue”.
     Follow the instructions on the screen to complete the uninstallation.

• For Windows XP
  1. Click “Start” and then “Control Panel”.
     The Control Panel window will be displayed.
  2. Double-click “Add / Remove Programs”.
     The Add / Remove Programs window will be displayed.
  3. Click Virtual Remote Tool from the list and then click “Remove”.
     Follow the instructions on the screen to complete the uninstallation.

Step 2: Connect the projector to the computer

1. Use the supplied computer cable (VGA) to connect the COMPUTER IN terminal of the projector directly with the monitor output terminal of the computer.

2. Connect the supplied power cord to the AC IN of the projector and the wall outlet.
   The projector is in the standby condition.

TIP:
• When Virtual Remote Tool starts for the first time, “Easy Setup” window will be displayed to navigate your connections.
3. Convenient Features

Step 3: Start Virtual Remote Tool

Start using the shortcut icon

- Double-click the shortcut icon on the Windows Desktop.

Start from the Start menu

- Click [Start] → [All Programs] or [Programs] → [NEC Projector User Supportware] → [Virtual Remote Tool] → [Virtual Remote Tool].

When Virtual Remote Tool starts for the first time, “Easy Setup” window will be displayed.

Follow the instructions on the screens

When “Easy Setup” is completed, the Virtual Remote Tool screen will be displayed.

NOTE:

- When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the computer cable (VGA) or network (wired LAN/wireless LAN) connection.

TIP:

- The Virtual Remote Tool screen (or Toolbar) can be displayed without displaying “Easy Setup” window. To do so, click to place a check mark for “Do not use Easy Setup next time” on the screen at Step 6 in “Easy Setup”.
3. Convenient Features

Exiting Virtual Remote Tool

1. **Click the Virtual Remote Tool icon on the Taskbar.**
   The pop-up menu will be displayed.

   ![Virtual Remote Tool icon on Taskbar](image)

2. **Click “Exit”.**
   The Virtual Remote Tool will be closed.

Viewing the help file of Virtual Remote Tool

• Displaying the help file using the taskbar

1. **Click the Virtual Remote Tool icon on the taskbar when Virtual Remote Tool is running.**
   The pop-up menu will be displayed.

   ![Virtual Remote Tool Help menu](image)

2. **Click “Help”.**
   The Help screen will be displayed.

   ![Virtual Remote Tool Help screen](image)

• Displaying the help file using the Start Menu.

1. **Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “Virtual Remote Tool” → and then “Virtual Remote Tool Help” in this order.**
   The Help screen will be displayed.
Operating Your Computer’s Mouse Functions from the Projector’s Remote Control via the USB Cable (Remote Mouse Function)

The built-in remote mouse function enables you to operate your computer’s mouse functions from the supplied remote control when the projector is connected to a computer via a commercially available USB cable (compatible with USB 2.0 specifications).

The Remote Mouse function works for the COMPUTER input while the computer screen is displayed. The Remote Mouse function will not work while you freeze or magnify an image.

- Using the USB cable to connect the projector and the computer will also start USB Display function.

**NOTE:**

- A USB cable must support the USB 2.0 Specifications.
- The mouse function can be used with the following operating systems: Windows 7, Windows XP, or Windows Vista.
- In SP2 or older version of Windows XP, if the mouse cursor will not move correctly, do the following:
  Clear the Enhance pointer precision check box underneath the mouse speed slider in the Mouse Properties dialog box [Pointer Options tab].
- Wait at least 5 seconds after disconnecting the USB cable before reconnecting it and vice versa. The computer may not identify the USB cable if it is repeatedly connected and disconnected in rapid intervals.
- Connect the projector to the computer with a USB cable after starting the computer. Failure to do so may fail to start the computer.

Operating your computer’s mouse from the remote control

You can operate your computer’s mouse from the remote control.

- **PAGE ▼/▲ Button** .................scrolls the viewing area of the window or to move to the previous or next slide in PowerPoint on your computer.
- **▲▼► Buttons** .................moves the mouse cursor on your computer.
- **MOUSE L-CLICK/ENTER Button** .......works as the mouse left button.
- **MOUSE R-CLICK Button** ..............works as the mouse right button.

**NOTE:**

- When you operate the computer using the ▲▼► or ▶ button with the menu displayed, both the menu and the mouse pointer will be affected. Close the menu and perform the mouse operation.

**TIP:** You can change the Pointer speed on the Mouse Properties dialog box on the Windows. For more information, see the user documentation or online help supplied with your computer.
Projecting Your Computer’s Screen Image from the Projector via the USB Cable (USB Display)

Using a commercially available USB cable (compatible with USB 2.0 specifications) to connect the computer with the projector allows you to send your computer screen image to the projector for displaying. Power On/Off and source selection of the projector can be done from your computer without connecting a computer cable (VGA).

NOTE:
• To make USB-B available on Windows XP, the Windows user account must have “Administrator” privilege.
• USB Display uses functions of Image Express Utility Lite contained on NEC Projector CD-ROM (→ page 56). Starting USB Display, however, will not install Image Express Utility Lite on your computer. This is because USB Display executes the projector’s program only.
• USB Display will not work in [NORMAL] of [STANDBY MODE]. (→ page 94)
• When USB Display is used, the sound is output from the COMPUTER AUDIO IN Mini Jack (Stereo Mini). Image and sound may not be synchronized.

1. Start the computer.
2. Connect the projector’s power cord to the wall outlet and put the projector into standby condition.
3. Use the USB cable to connect the computer with the projector.

4. Click “Yes”.

The projector will turn on and the message “The projector is getting ready. Please wait.” will be displayed on the computer screen. This message will disappear in a few seconds.
5. Operate the control window.

(1) (Source) .... Selects an input source of the projector.
(2) (Picture ) .... Turns on or off AV-MUTE (Picture mute), and turns on or off FREEZE (Freeze a picture).
(3) (Sound ) .... Turns on or off AV-MUTE (Sound mute), play the sound and turns up or down the volume.
(4) (Others) .... Uses “Update”, “HTTP Server”*, “Settings” and “Information”.

* The HTTP Server cannot be selected when a USB cable is connected.
(5) (Exit) ....... Exit Image Express Utility Lite. You can also turn off the projector at the same time.
(6) (Help) ........ Displays the help of Image Express Utility Lite.
Controlling the Projector by Using an HTTP Browser

Overview

The HTTP Server function provides settings and operations for:

1. Setting for wired/wireless network (NETWORK SETTINGS)
   - To use wireless LAN connection, the optional USB Wireless LAN Unit is required. (→ page 115)
   - To use wired/wireless LAN connection, connect the projector to the computer with a commercially available LAN cable. (→ page 114)

2. Setting Alert Mail (ALERT MAIL)
   - When the projector is connected to a wired/wireless network, lamp replace time or error messages will be sent via e-mail.

3. Operating the projector
   - Power on/off, selecting input, volume control and picture adjustments are possible.

4. Setting PJLink PASSWORD and AMX BEACON

   This device uses “JavaScript” and “Cookies” and the browser should be set to accept these functions. The setting method will vary depending on the version of browser. Please refer to the help files and the other information provided in your software.

Two ways of access to the HTTP server function are available:

- **Start the Web browser on the computer via the network connected to the projector and enter the following URL:**
  - http://<the projector’s IP address>/index.html
- **Use Image Express Utility Lite contained on the supplied NEC Projector CD-ROM.**

**TIP:** The factory setting IP address is [DHCP ON].

**NOTE:**
- To use the projector in a network, consult with your network administrator about network settings.
- The display’s or button’s response can be slowed down or operation may not be accepted depending the settings of your network.
  - Should this happen, consult your network administrator. The projector may not respond if its buttons are repeatedly pressed in rapid intervals. Should this happen, wait a moment and repeat. If you still can’t get any response, turn off and back on the projector.
- If the PROJECTOR NETWORK SETTINGS screen does not appear in the web browser, press the Ctrl+F5 keys to refresh your web browser (or clear the cache).

Preparation before Use

Connect the projector to a commercially available LAN cable before engaging in browser operations. (→ page 114)

Operation with a browser that uses a proxy server may not be possible depending on the type of proxy server and the setting method. Although the type of proxy server will be a factor, it is possible that items that have actually been set will not be displayed depending on the effectiveness of the cache, and the contents set from the browser may not be reflected in operation. It is recommended that a proxy server not be used unless it is unavoidable.
3. Convenient Features

Handling of the Address for Operation via a Browser

Regarding the actual address that is entered for the address or entered to the URL column when operation of the projector is via a browser, the host name can be used as it is when the host name corresponding to the IP address of the projector has been registered to the domain name server by a network administrator, or the host name corresponding to the IP address of the projector has been set in the “HOSTS” file of the computer being used.

Example 1: When the host name of the projector has been set to “pj.nec.co.jp”, access is gained to the network setting by specifying
http://pj.nec.co.jp/index.html
for the address or the entry column of the URL.

Example 2: When the IP address of the projector is “192.168.73.1”, access is gained to the network setting by specifying
http://192.168.73.1/index.html
for the address or the entry column of the URL.

PROJECTOR ADJUSTMENT

POWER: This controls the power of the projector.
ON ........................................ Power is switched on.
OFF ........................................ Power is switched off.

VOLUME: This controls the volume of the projector.
▲ ........................................ Increases the volume adjustment value.
▼ ........................................ Decreases the volume adjustment value.

AV-MUTE: This controls the mute function of the projector.
PICTURE ON ........... Mutes the video.
PICTURE OFF ........... Cancels the video muting.
SOUND ON .............. Mutes the audio.
SOUND OFF .............. Cancels the audio muting.
ALL ON .................. Mutes each of the video, and audio functions.
ALL OFF .................. Cancels the muting of each of the video, and audio functions.
3. Convenient Features

PICTURE: Controls the video adjustment of the projector.
   CONTRAST ▲ .... Increases the contrast adjustment value.
   CONTRAST ▼ .... Decreases the contrast adjustment value.
   BRIGHTNESS ▲ .... Increases the brightness adjustment value.
   BRIGHTNESS ▼ .... Decreases the brightness adjustment value.
   SHARPNESS ▲ .... Increases the sharpness adjustment value.
   SHARPNESS ▼ .... Decreases the sharpness adjustment value.
   COLOR ▲ ............ Increases the color adjustment value.
   COLOR ▼ ............ Decreases the color adjustment value.
   HUE ▲ ............... Increases the hue adjustment value.
   HUE ▼ ............... Decreases the hue adjustment value.

   - The functions that can be controlled will vary depending on the signal being input to the projector. (→ page 80)

SOURCE SELECT: This switches the input terminal of the projector.
   COMPUTER .......... Switches to the COMPUTER IN terminal.
   HDMI1/MHL .......... Switches to the HDMI 1/MHL IN terminal
   HDMI2 ............... Switches to the HDMI 2 IN terminal.
   VIDEO ............... Switches to the VIDEO IN terminal.
   USB-A ............... Switches to the data on the USB memory device.
   LAN ................. Switches to a LAN signal.
   USB-B ............... Switches to the USB Port (PC).

PROJECTOR STATUS: This displays the condition of the projector.
   LAMP LIFE REMAINING .... Displays the remaining life of the lamp as a percentage.
   LAMP HOURS USED ........ Displays how many hours the lamp has been used.
   FILTER HOURS USED .... Displays how many hours the filter has been used.
   ERROR STATUS ........ Displays the status of errors occurring within the projector.

LOG OFF: Logging off your projector and returning to the authentication screen (LOGON screen).
### 3. Convenient Features

#### NETWORK SETTINGS

![NETWORK SETTINGS](image)

**• SETTINGS**

**WIRED or WIRELESS**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SETTING</strong></td>
<td>Set for wired LAN or for wireless LAN.</td>
</tr>
<tr>
<td><strong>APPLY</strong></td>
<td>Apply your settings to wired LAN or wireless LAN.</td>
</tr>
<tr>
<td><strong>DHCP ON</strong></td>
<td>Automatically assign IP address, subnet mask, and gateway to the projector from your DHCP server.</td>
</tr>
<tr>
<td><strong>DHCP OFF</strong></td>
<td>Set IP address, subnet mask, and gateway to the projector assigned by your network administrator.</td>
</tr>
<tr>
<td><strong>IP ADDRESS</strong></td>
<td>Set your IP address of the network connected to the projector.</td>
</tr>
<tr>
<td><strong>SUBNET MASK</strong></td>
<td>Set your subnet mask number of the network connected to the projector.</td>
</tr>
<tr>
<td><strong>GATEWAY</strong></td>
<td>Set the default gateway of the network connected to the projector.</td>
</tr>
<tr>
<td><strong>AUTO DNS ON</strong></td>
<td>DHCP server will automatically assign IP address of DNS server connected to the projector.</td>
</tr>
<tr>
<td><strong>AUTO DNS OFF</strong></td>
<td>Set your IP address of DNS server connected to the projector.</td>
</tr>
</tbody>
</table>

**Setting for WIRED LAN**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ENABLE</strong></td>
<td>Turn on wired LAN connection</td>
</tr>
<tr>
<td><strong>DISABLE</strong></td>
<td>Turn off wired LAN connection</td>
</tr>
</tbody>
</table>

**Setting for WIRELESS LAN (with the optional USB Wireless LAN Unit equipped)**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SIMPLE ACCESS POINT</strong></td>
<td>Setting as an simple access point.</td>
</tr>
<tr>
<td><strong>MODE</strong></td>
<td>Available channels vary depending on the country and region. When you select [INFRASTRUCTURE], make sure that the projector and your access point are on the same channel.</td>
</tr>
<tr>
<td><strong>CHANNEL</strong></td>
<td>Available channels vary depending on the country and region. When you select [INFRASTRUCTURE], the access point same with the wireless LAN is selected automatically.</td>
</tr>
<tr>
<td><strong>PROFILE 1/PROFILE 2</strong></td>
<td>Two settings can be set for wireless LAN connection. Select PROFILE 1 or PROFILE 2.</td>
</tr>
<tr>
<td><strong>SSID</strong></td>
<td>Enter an identifier (SSID) for wireless LAN. Communication can be done only with equipment whose SSID matches SSID for your wireless LAN.</td>
</tr>
</tbody>
</table>
### 3. Convenient Features

**SITE SURVEY**
Displays a list of available SSIDs for wireless LAN on site. Select an SSID which you can access.

**SECURITY TYPE**
Turn on or off the encryption mode for secure transmission. When turn on the encryption mode, set WEP key or encrypted key.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISABLE</td>
<td>Will not turn on the encryption feature. Your communications may be monitored by someone.</td>
</tr>
<tr>
<td>WEP 64 bit</td>
<td>Uses 64-bit datalength for secure transmission.</td>
</tr>
<tr>
<td>WEP 128 bit</td>
<td>Uses 128-bit datalength for secure transmission. This option will increase privacy and security when compared to use of 64-bit datalength encryption.</td>
</tr>
<tr>
<td>WPA PSK-TKIP/</td>
<td>These options provide stronger security than WEP.</td>
</tr>
<tr>
<td>WPA PSK-AES/</td>
<td></td>
</tr>
<tr>
<td>WPA2 PSK-TKIP/</td>
<td></td>
</tr>
<tr>
<td>WPA2 PSK-AES</td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:**
- The WEP settings must be the same as communication devices such as PC or access point in your wireless network.
- When you use WEP, your image transmission speed will slow down.

**INDEX**
Select encryption key when selecting [WEP 64 bit] or [WEP 128 bit] in [SECURITY TYPE].
WEP key is fixed at "1" either WEP64bit or WEP128bit is selected as SECURITY TYPE.

**KEY**
When selecting [WEP 64 bit] or [WEP 128 bit] in [SECURITY TYPE]:
Enter WEP key.

<table>
<thead>
<tr>
<th>Select</th>
<th>Characters (ASCII)</th>
<th>Hexadecimal digit (HEX)</th>
</tr>
</thead>
<tbody>
<tr>
<td>WEP 64 bit</td>
<td>Up to 5 characters</td>
<td>Up to 10 characters</td>
</tr>
<tr>
<td>WEP 128 bit</td>
<td>Up to 13 characters</td>
<td>Up to 26 characters</td>
</tr>
</tbody>
</table>

When selecting [WPA PSK-TKIP], [WPA PSK-AES], [WPA2 PSK-TKIP] or [WPA2 PSK-AES]:
Enter encryption key. Key length must be 8 or greater and 63 or less.

**NAME**

**PROJECTOR NAME**
Enter a name for your projector so that your computer can identify the projector. A projector name must be 16 characters or less.
TIP: Projector name will not be affected even when [RESET] is done from the menu.

**HOST NAME**
Enter the hostname of the network connected to the projector. A host name must be 15 or less.

**DOMAIN NAME**
Enter the domain name of the network connected to the projector. A domain name must be 60 characters or less.
### 3. Convenient Features

#### • ALERT MAIL

<table>
<thead>
<tr>
<th>ALERT MAIL (English only)</th>
<th>This option will notify your computer of lamp replace time or error messages via e-mail when using wireless or wired LAN. Placing a checkmark will turn on the Alert Mail feature. Clearing a checkmark will turn off the Alert Mail feature. Sample of a message to be sent from the projector: The lamp and filters are at the end of its usable life. Please replace the lamp and filters. Projector Name: NEC Projector Lamp Hours Used: 100 [H]</th>
</tr>
</thead>
<tbody>
<tr>
<td>SENDER’S ADDRESS</td>
<td>Enter sender’s address.</td>
</tr>
<tr>
<td>SMTP SERVER NAME</td>
<td>Enter the SMTP server name to be connected to the projector.</td>
</tr>
<tr>
<td>RECIPIENT’s ADDRESS 1,2,3</td>
<td>Enter your recipient’s address. Up to three addresses can be entered.</td>
</tr>
<tr>
<td>TEST MAIL</td>
<td>Send a test mail to check whether your settings are correct or not</td>
</tr>
<tr>
<td><strong>NOTE:</strong></td>
<td>* If you execute a test, you may not receive an Alert mail. Should this happen, check if network settings are correct. * If you entered an incorrect address in a test, you may not receive an Alert mail. Should this happen, check if the Recipient’s Address is correct.</td>
</tr>
<tr>
<td>SAVE</td>
<td>Click this button to reflect the above settings.</td>
</tr>
</tbody>
</table>

#### • NETWORK SERVICE

<table>
<thead>
<tr>
<th>PJLink PASSWORD</th>
<th>Set a password for PJLink*. A password must be 32 characters or less. Do not forget your password. However, if you forget your password, consult with your dealer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>HTTP PASSWORD</td>
<td>Set a password for HTTP server. A password must be 10 characters or less.</td>
</tr>
<tr>
<td>AMX BEACON</td>
<td>Turn on or off for detection from AMX Device Discovery when connecting to the network supported by AMX’s NetLinx control system.</td>
</tr>
<tr>
<td><strong>TIP:</strong></td>
<td>When using a device that supports AMX Device Discovery, all AMX NetLinx control system will recognize the device and download the appropriate Device Discovery Module from an AMX server. Placing a checkmark will enable detecting the projector from AMX Device Discovery. Clearing a checkmark will disable detecting the projector from AMX Device Discovery.</td>
</tr>
</tbody>
</table>

*What is PJLink?*  
PJLink is a standardization of protocol used for controlling projectors of different manufacturers. This standard protocol is established by Japan Business Machine and Information System Industries Association (JBMIA) in 2005. The projector supports all the commands of PJLink Class 1. Setting of PJLink will not be affected even when [RESET] is done from the menu.

**CRESTRON ROOMVIEW compatibility**

The projector supports CRESTRON ROOMVIEW, allowing multiple devices connected in the network to be managed and controlled from a computer or a controller.  
For more information, visit [http://www.crestron.com](http://www.crestron.com)

**<Setting Procedure>**

Access to the HTTP server function, and make necessary settings for [CRESTRON] in [NETWORK SETTINGS].
3. Convenient Features

- **ROOMVIEW** for managing from the computer.
  
  | DISABLE  | Enables ROOMVIEW. |
  | ENABLE   | Enables ROOMVIEW. |

- **CRESTRON CONTROL** for managing from the controller.
  
  | DISABLE  | Disables CRESTRON CONTROL. |
  | ENABLE   | Enables CRESTRON CONTROL. |
  | IP ADDRESS | Set your IP address of CRESTRON SERVER. |
  | IP ID    | Set your IP ID of CRESTRON SERVER. |

**TIP:** The CRESTRON settings are required only for use with CRESTRON ROOMVIEW. For more information, visit [http://www.crestron.com](http://www.crestron.com)

- **INFORMATION**
  
  | WIRED LAN    | Display a list of settings of wired LAN connection. |
  | WIRELESS LAN | Display a list of settings of wireless LAN connection. |
  | UPDATE       | Reflect settings when they are changed. |
3. Convenient Features

Controlling the Projector over a LAN (PC Control Utility Pro 4/Pro 5)

Using the utility software “PC Control Utility Pro 4” and “PC Control Utility Pro 5” included on the companion NEC Projector CD-ROM, the projector can be controlled from a computer over a LAN.

PC Control Utility Pro 4 is a program compatible with Windows. (→ this page)
PC Control Utility Pro 5 is a program compatible with Mac OS. (→ page 55)

Control Functions
Power On/Off, signal selection, picture freeze, picture mute, audio mute, adjusting, error message notification, event schedule.

Screen of PC Control Utility Pro 4

This section provides an outline of preparation for use of PC Control Utility Pro 4/Pro 5. For information on how to use PC Control Utility Pro 4/Pro 5, see Help of PC Control Utility Pro 4/Pro 5. (→ page 54, 55)

Step 1: Install PC Control Utility Pro 4/Pro 5 on the computer.
Step 2: Connect the projector to a LAN.
Step 3: Start PC Control Utility Pro 4/Pro 5.

• To run PC Control Utility Pro 4 on Windows 8.1, Windows 8 and Windows XP, “Microsoft .NET Framework Version 2.0” is required. The Microsoft .NET Framework Version 2.0, 3.0 or 3.5 is available from Microsoft’s web page. Download and install it on your computer.

TIP:
• PC Control Utility Pro 4 can be used with a serial connection.

Using on Windows

Step 1: Install PC Control Utility Pro 4 on the computer

NOTE:
• To install or uninstall the program, the Windows user account must have [Administrator] privilege (Windows 8.1, Windows 8, Windows 7 and Windows Vista) or [Computer Administrator] privilege (Windows XP).
• Exit all running programs before installation. If another program is running, the installation may not be completed.

1 Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.
The menu window will be displayed.
3. Convenient Features

TIP:
If the menu window will not be displayed, try the following procedure.

For Windows 7:
1. Click “start” on Windows.
2. Click “All Programs”→“Accessories”→“Run”.
3. Type your CD-ROM drive name (example: “Q:”) and “LAUNCHER.EXE” in “Name”. (example: Q:LAUNCHER.EXE)
4. Click “OK”.
   The menu window will be displayed.

2 Click “PC Control Utility Pro 4” on the menu window.
The installation will start.

When the installation is complete, the Welcome window will be displayed.

3 Click “Next”.
“END USER LICENSE AGREEMENT” screen will be displayed.

Read “END USER LICENSE AGREEMENT” carefully.

4 If you agree, click “I accept the terms in the license agreement” and then click “Next”.
   • Follow the instructions on the installer screens to complete the installation.
   • When the installation is complete, you will return to the menu window.

TIP:
• Uninstalling PC Control Utility Pro 4
To uninstall PC Control Utility Pro 4, do the same procedures stated as in “Uninstalling Virtual Remote Tool”. Read “Virtual Remote Tool” as “PC Control Utility Pro 4” (→ page 39)
3. Convenient Features

Step 2: Connect the projector to a LAN.
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 114), “Connecting to a Wireless LAN (Optional: NP05LM series)” (→ page 115) and “Controlling the Projector by Using an HTTP Browser” (→ page 45)

Step 3: Start PC Control Utility Pro 4
Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → “PC Control Utility Pro 4”.

Note:
• For the Schedule function of the PC Control utility Pro 4 to work, you must have your computer running and not in standby/sleep mode. Select “Power Options” from the “Control Panel” in Windows and disable its standby/sleep mode before running the scheduler.

[Example] For Windows 7:
- Select “Control Panel” → “System and Security” → “Power Options” → “Change when the computer sleeps” → “Put the computer to sleep” → “Never”.

Note:
• When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN/wireless LAN) connection.

Tip:
Viewing the Help of PC Control Utility Pro 4
- Displaying the Help file of PC Control Utility Pro 4 while it is running.
  Click “Help (H)” → “Help (H) …” of window of PC Control Utility Pro 4 in this order.
  The pop-up menu will be displayed.
- Displaying the help file using the Start Menu.
  Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “PC Control Utility Pro 4” → “PC Control Utility Pro 4 Help”.
  The Help screen will be displayed.
3. Convenient Features

Using on Mac OS

Step 1: Install PC Control Utility Pro 5 on the computer

1. Insert the accompanying NEC Projector CD-ROM in your Mac CD-ROM drive.
   The CD-ROM icon will be displayed on the desktop.

2. Double-click the CD-ROM icon.
   The CD-ROM window will be displayed.

3. Double-click the “Mac OS X” folder.

4. Double-click “PC Control Utility Pro 5.pkg”.
   The installer will start.

5. Click “Next”.
   “END USER LICENSE AGREEMENT” screen will be displayed.

6. Read “END USER LICENSE AGREEMENT” and click “Next”.
   The confirmation window will be displayed.

7. Click “I accept the terms in the license agreement”.
   Follow the instructions on the installer screens to complete the installation.

Step 2: Connect the projector to a LAN

Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 114), “Connecting to a Wireless LAN (Optional: NP05LM series)” (→ page 115) and “Controlling the Projector by Using an HTTP Browser” (→ page 45).

Step 3: Start PC Control Utility Pro 5

1. Open your Applications folder in Mac OS.

2. Click the “PC Control Utility Pro 5” folder.

3. Click the “PC Control Utility Pro 5” icon.
   PC Control Utility Pro 5 will start.

NOTE:
• For the Schedule function of the PC Control utility Pro 5 to work, you must have your computer running and not in sleep mode. Select “Energy Saver” from the “System Preferences” in Mac and disable its sleep mode before running the scheduler.
• When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector cannot be turned on via the network (wired LAN/wireless LAN) connection.

TIP:
Viewing the Help of PC Control Utility Pro 5

• Displaying the Help file of PC Control Utility Pro 5 while it is running.
  • From the menu bar, click “Help” → “Help” in this order.
  The Help screen will be displayed.

• Displaying the Help using the Dock
  1. Open “Application Folder” in Mac OS.
  2. Click the “PC Control Utility Pro 5” folder.
  3. Click the “PC Control Utility Pro 5 Help” icon.
  The Help screen will be displayed.
### 3. Convenient Features

#### Projecting Your Computer’s Screen Image from the Projector over a LAN (Image Express Utility Lite)

Using Image Express Utility Lite contained on the supplied NEC Projector CD-ROM allows you to send the computer’s screen image to the projector over a USB cable or a wired or wireless LAN. Image Express Utility Lite is a program compatible with Windows. Image Express Utility Lite for Mac OS is a program compatible with Mac OS. (→ page 60)

This section will show you an outline about how to connect the projector to a LAN and to use Image Express Utility Lite. For the operation of Image Express Utility Lite, see the help of Image Express Utility Lite.

1. Step 1: install Image Express Utility Lite on the computer.
2. Step 2: Connect the projector to a LAN.

**TIP:**
- Image Express Utility Lite (for Windows) can be started from most commercially available removable media such as USB memory devices or SD cards without the need to install on your computer. (→ page 59)

**What You can Do with Image Express Utility Lite**

- **Image transmission (for Windows and Mac OS)**
  - The screen of your computer can be sent to the projector via a wired or wireless network without a computer cable (VGA).
  - The screen of your computer can be sent to up to four projectors at the same time.

- **USB Display (for Windows only)**
  - Computer screen image can be projected via a USB cable, without connecting a computer cable (VGA).
  - Just connecting the computer and the projector over a USB cable will make the USB Display function available (Plug & Play) even without installing Image Express Utility Lite on the computer. (→ page 43)

- **Geometric Correction Tool [GCT] (for Windows only)**
  See “Projecting an Image from an Angle (Geometric Correction Tool in Image Express Utility Lite)”. (→ page 61)

**NOTE:**
- When Image Express Utility Lite is used, the audio from the COMPUTER AUDIO IN Mini Jack (Stereo Mini) may not be synchronized with the video.

**Using on Windows**

**Step 1: install Image Express Utility Lite on the computer.**

**NOTE:**
- To install or uninstall the program, the Windows user account must have “Administrator” privilege (Windows 8.1, Windows 8, Windows 7, Windows Vista and Windows XP).
- Exit all running programs before installation. If another program is running, the installation may not be completed.
- Image Express Utility Lite will be installed to the system drive of your computer.
  - If the message “There is not enough free space on destination” is displayed, free up enough space (about 100 MB) to install the program.

1. Insert the accompanying NEC Projector CD-ROM into your CD-ROM drive.
   - The menu window will be displayed.
3. Convenient Features

TIP:
If the menu window will not be displayed, try the following procedure.
For Windows 7:
1. **Click “start” on Windows.**
2. Click “All Programs” → “Accessories” → “Run”.
3. Type your CD-ROM drive name (example: “Q:\”) and “LAUNCHER.EXE” in “Name”. (example: Q:\LAUNCHER.EXE)
4. Click “OK”.
   The menu window will be displayed.

2. **Click “Installing Image Express Utility Lite” on the menu window.**
The installation will start.
   “END USER LICENSE AGREEMENT” screen will be displayed.
   Read “END USER LICENSE AGREEMENT” carefully
3. **If you agree, click “I agree.” and then click “Next”.**
   • Follow the instructions on the installer screens to complete the installation.
   • When the installation is complete, you will return to the menu window.
   When the installation is complete, a completion message will be displayed.
4. **Click “OK”**.
   This completes the installation.

TIP:
• Uninstalling Image Express Utility Lite
To uninstall Image Express Utility Lite, do the same procedures stated as in “Uninstalling Virtual Remote Tool”. Read “Virtual Remote Tool” as “Image Express Utility Lite” (→ page 39)

---

**Step 2: Connect the projector to a LAN.**
Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 114), “Connecting to a Wireless LAN (Optional: NP05LM series)” (→ page 115) and “Controlling the Projector by Using an HTTP Browser” (→ page 45)

**Step 3: Start Image Express Utility Lite.**
1. **On Windows, click “Start” → “All programs” → “NEC Projector UserSupportware” → “Image Express Utility Lite” → “Image Express Utility Lite”**.
   Image Express Utility Lite will start.
   The select window for network connection will be displayed
2. **Select Network and click “OK”**.
   The select window for destination will show a list of connectable projectors.
   • When connecting the computer directly to the projector by one-to-one, “Simple Access Point” is recommended.

   ![Select Network Port](image)

   • To check for the network available for connected projectors, from the menu, select [INFO.] → [WIRELESS LAN] → [SSID].
3. Convenient Features

3. Place a check mark for projectors to be connected, and then click “Connect”.

![Image of Connect interface]

- When one or more projectors are displayed, from the menu on the projector, select [INFO.] → [WIRELESS LAN] → [IP ADDRESS].

When connecting with the projector is established, you can operate the control window to control the projector. (→ page 44)

NOTE:
- When [NORMAL] is selected for [STANDBY MODE] from the menu, the projector that is turned off will not be displayed in the select window for destination

TIP:

Viewing the “Help” file of Image Express Utility Lite

- Displaying the Help file of Image Express Utility Lite while it is running.
  Click the [?] (help) icon on the control window.
  The Help screen will be displayed.

- Displaying the Help file of GCT while it is running.
  Click “Help” → “Help” on the edit window.
  The Help screen will be displayed.

- Displaying the help file using the Start Menu.
  Click “Start” → “All programs” or “Programs” → “NEC Projector User Supportware” → “Image Express Utility Lite” → “Image Express Utility Lite Help”.
  The Help screen will be displayed.
Starting Image Express Utility Lite from a USB Memory or SD Card

Image Express Utility Lite can be started from commercially available removable media such as USB memory or SD cards if it is copied beforehand. This will eliminate the trouble of installing Image Express Utility Lite to your computer.

1. **Copy Image Express Utility Lite to removable media.**

   Copy all the folders and files (total size approx. 6MB) from the “IEU_Lite (removable-media)” folder in the supplied NEC Projector CD-ROM to the root directory of your removable media.

2. **Insert your removable media into your computer.**

   The “AutoPlay” screen will be displayed on your computer.

   **TIP:**

   • If the “AutoPlay” screen is not displayed, open the folder from “Computer” (“My Computer” for Windows XP).

3. **Click “Open folder to view files”**

   The IEU_Lite.exe, other folder, and files will be displayed.

4. **Double-click the “IEU_Lite.exe” icon.**

   Image Express Utility Lite will start.
3. Convenient Features

Using on Mac OS

Step 1: Install Image Express Utility Lite for Mac OS on the computer

1. Insert the accompanying NEC Projector CD-ROM in your Mac CD-ROM drive.
   The CD-ROM icon will be displayed on the desktop.

2. Double-click the CD-ROM icon.
   The CD-ROM window will be displayed.

3. Double-click the “Mac OS X” folder.

4. Double-click “Image Express Utility Lite.dmg”.
   The “Image Express Utility Lite” window will be displayed.

5. Drag and drop the “Image Express Utility Lite” folder to your Applications folder in Mac OS.

Step 2: Connect the projector to a LAN

Connect the projector to the LAN by following the instructions in “Connecting to a Wired LAN” (→ page 114), “Connecting to a Wireless LAN (Optional: NP05LM series)” (→ page 115) and “Controlling the Projector by Using an HTTP Browser” (→ page 45)

Step 3: Start Image Express Utility Lite for Mac OS

1. Open your Applications folder in Mac OS.

2. Double-click the “Image Express Utility Lite” folder.

3. Double-click the “Image Express Utility Lite” icon.
   When Image Express Utility Lite for Mac OS starts, the select window for destination will be displayed.

   ![Image Express Utility Lite for Mac OS](image)

   • At the first time of startup, “END USER LICENSE AGREEMENT” screen will be displayed before the select window for destination is displayed.
     Read “END USER LICENSE AGREEMENT” and select “I accept the terms in the license agreement”, and click “OK”.

4. Select a projector to be connected, and then click “Connect”.
   Your desktop screen will be displayed on the projector.

TIP:

Viewing the Help of Image Express Utility Lite for Mac OS

• From the menu bar, click “Help” → “Image Express Utility Lite Help” while Image Express Utility is running.

   The Help screen will be displayed.
Projecting an Image from an Angle (Geometric Correction Tool in Image Express Utility Lite)

The Geometric Correction Tool (GCT) function allows you to correct distortion of images projected even from an angle.

What you can do with GCT

- The GCT feature includes the following three functions
  - **4-point Correction**: You can fit a projected image within the border of the screen easily by align the four corners of an image to the ones of the screen.
  - **Multi-point Correction**: You can correct a distorted image on the corner of a wall or irregular shaped screen by using many separated screens to correct the image as well as 4-point Correction.
  - **Parameters Correction**: You can correct a distorted image by using a combination of transformational rules prepared in advance.

This section will show an example for use with 4-point Correction.
For information about “Multi-point Correction” and “Parameters Correction”, see the help file of Image Express Utility Lite. (→ page 58, 60)

- Your correction data can be stored in the projector or your computer which can be restored when necessary.
- The GCT function is available with a USB cable, wired or wireless LAN connection, and video cable.

Projecting an Image from an Angle (GCT)

This section will show an example for use with USB Display (using a USB cable to connect a computer and the projector).
- The USB Display function will automatically display the control window
- For a video cable or LAN connection, install and start Image Express Utility Lite in your computer beforehand. (→ page 56)

Preparation: Adjust the projector position or the zoom so that the projected image can cover the whole screen area.

1. **Click the “ ” (Picture) icon and then the “ ” button.**

   The “4-point Correction” window will be displayed.

2. **Click the “Start Correction” button and then “Start 4-point Correction” button.**

   A green frame and a mouse pointer ( ) will be displayed.
   - Four [ ] marks will be appeared at four corners of the green frame
3. Convenient Features

3. Use the mouse to click the [●] mark of which corner you wish to move.
   The currently selected [●] mark will turn red.

4. Drag the selected [●] mark to the point you wish to correct and drop it.
   • When you click somewhere within the project image area, the nearest [●] mark will go to the position where the mouse cursor is.

5. Repeat Step 3 and 4 to correct the distortion of the projected image.

6. After completing, right-click the mouse.
   The green frame and the mouse pointer will disappear from the projected image area. This will complete the correction.

7. Click the “X” (close) button on the “4-point Correction” window.
   The “4-point Correction” window will disappear and the 4-point correction will take effect.

8. Click the “” button on the control window to exit the GCT.

TIP:
• After performing the 4-point correction, you can save the 4-point correction data to the projector by clicking “File” → “Export to the projector…” on the “4-point Correction” window.
• See the Help of Image Express Utility Lite for operating “4-point Correction” window and other functions than GCT. (→ page 58, 60)
Connecting Your Microphone

Connecting a commercially available dynamic microphone or condenser mic to the MIC input jack allows you to output your mic sound from the built-in speaker.

Sound input from all input terminals including LAN, USB-A, and USB-B will be heard from the speaker with your microphone voice. Microphone sensitivity can be adjusted. From the menu, select [SETUP] → [INSTALLATION] → [MIC GAIN]. (→ page 92)

NOTE:

- Depending on input condition of HDMI1/MHL or HDMI2 signal, these is a case sound may not output.
- Do not connect an audio signal to the MIC input jack. Doing so may cause excessively loud sound, resulting in a damage to the speaker.
4. Using the Viewer

What you can do with the Viewer

The Viewer has the following features.

- When a commercially available USB memory that stores image files is inserted into the USB port (Type A) of the projector, the Viewer allows you to view the image files on the USB memory. Even if no computer is available, presentations can be conducted simply with the projector.
- Supported graphic format is JPEG.
- The Viewer displays the thumbnail screen (JPEG Exif only) on which you can jump to any specific image you wish to project.
- There are two ways of playback for slideshow: manual playback and auto playback. The interval time can be changed in auto playback.
- The order of displaying images can be set by name, date or size. Ascending or descending order can be selected.
- Images can be rotated by 90 degrees during playback.
4. Using the Viewer

NOTE
• The USB port of the projector does not support USB hub.
• The following operations by using the buttons on the projector are not possible when the VIEWER screen such as the slide screen and the thumbnail screen is displayed.

Buttons on the cabinet
- Keystone correction by using the ▲▼ button
- Auto Adjustment by using the AUTO ADJ. button
- Volume control with the ◀ or ▶ button

To perform Keystone correction or Source selection during display of the Viewer, press the MENU button twice to display the menu and operate Viewer from the menu.

Remote control
- Auto Adjustment button
- Freeze button

• Executing [RESET] → [ALL DATA] from the menu will return the settings for the Viewer toolbar to the factory default.
• USB memory
- Be sure to use a USB memory device formatted with the FAT32 or FAT16 file system.
  The projector does not support NTFS formatted USB memory.
  If the projector does not recognize your USB memory, check if the format is supported.
  To format your USB memory in your computer, refer to the document or help file that comes with your Windows.
- We do not warrant that the USB port of the projector will support all USB memories in the market.

• Supported images
- Supported file format for Viewer are as follows.
  We do not warrant all the images are supported for Viewer.
  Images other than mentioned in the table may not be supported.

<table>
<thead>
<tr>
<th>Image type</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPEG</td>
<td>JPG/JPEG</td>
<td>Baseline/Exif are supported</td>
</tr>
</tbody>
</table>

- Slideshow, effect, and sound effect set with PowerPoint cannot be played back.
- Image can be displayed at a resolution up to 10000 × 10000 pixels.
- Even if images are met by the above conditions, there may be some images which cannot be played back.
- More than 200 icons (total number of image file icons and folder icons) cannot be displayed in a thumbnail screen.
- Long file/folder name will be limited to the specified length. This can be shown by bracket added.
- If one folder has many files, it takes some time to play back.
• If a single folder contains too many files, switching images will take time. To shorten switching time, reduce the number of images contained in a single folder.

TIP:
• Exchangeable image file format (Exif) is a standard image file format used by digital cameras with the addition of specific shooting data.
• Viewer PPT converter 3.0 is software to convert the PowerPoint file into the JPEG file.
  You can download it from our website:
2 Projecting images stored in a USB memory device

This section explains the basic operation of the Viewer. The explanation provides the operational procedure when the Viewer toolbar (→ page 69) is set to the factory default.

- Starting the Viewer.................................................................below
- Removing the USB memory from the projector............... page 68
- Exiting the Viewer............................................................... page 68

Preparation: Before starting the Viewer, store images to the USB memory using your computer.

Starting the Viewer
1. Turn on the projector. (→ page 14)

2. Insert the USB memory into the USB port of the projector.
   • Do not remove the USB memory from the projector while it’s LED flashes. Doing so may corrupt the data.

3. Press the SOURCE button on the projector cabinet.
   The Viewer start screen will be displayed.
   • Press the USB-A button on the remote control.
4. **Press the ENTER button.**
   The thumbnail screen will be displayed. (→ page 70)

5. **Use the ▲▼◀ or ▶ button to select an icon.**
   - The → (arrow) symbol on the right indicates there are more pages. pressing the PAGE ▼ (page down) button will show the next page: pressing the PAGE △ (page up) will show the previous page.

6. **Press the ENTER button.**
   The selected slide will be displayed.
   - When a folder icon is selected, icons contained in the folder will be displayed.

7. **Press the ▶ button to select the next slide.**
   The slide on the right will be displayed.
   - The ◀ or ▶ button can be used to select the next (right) slide or the previous (left) slide in the thumbnail screen.
   - Pressing the MENU button during display of the thumbnail screen, the slide screen, or the slideshow screen will display the toolbar. The toolbar is used to select or rotate an slide. (→ page 71)

8. **Press the EXIT button when the toolbar is not displayed.**
   The thumbnail screen will be displayed.
   - Another way to display the thumbnail screen is to press the ENTER button.
   - To close the toolbar, press the MENU button to return to the SOURCE list, and press the MENU button again to close the SOURCE list.
Removing the USB memory from the projector

1. Select the VIEWER start screen.
   Press the EXIT button with no menu displayed.

2. Remove the USB memory from the projector.
   Make sure that the LED on the USB memory is not flashing before removing the USB memory.
   **NOTE:** If you remove the USB memory from the projector with a slide displayed, the projector may not operate correctly. If this happens, turn off the projector and unplug the power cord. Wait 3 minutes, then connect the power cord, and turn on the projector.

Exiting the Viewer

1. Press the MENU button with the slide screen or the thumbnail screen displayed.
   The control bar or the pop-up menu will be displayed.

2. Press the MENU button again.
   The on-screen menu will be displayed.

3. Select a source other than [USB-A] and press the ENTER button.
   The Viewer will be exited.

**TIP:** To exit the Viewer using the remote control, select a source other than [USB-A].
4. Using the Viewer

Parts of each screen

The Viewer has four screens.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Viewer start screen</td>
<td>This screen will be displayed first when you select the Viewer.</td>
</tr>
<tr>
<td>(2) USB icon</td>
<td>This icon indicates that the USB memory is inserted into the projector.</td>
</tr>
<tr>
<td>(3) Thumbnail screen</td>
<td>This screen will show a list of folders and image files stored in the USB memory. The JPEG Exif files will be displayed in thumbnail screen only.</td>
</tr>
<tr>
<td></td>
<td>• The maximum number of image files or folders within one page is different depending on the model.</td>
</tr>
<tr>
<td></td>
<td>UM361X and UM301X are 5 by 4</td>
</tr>
<tr>
<td></td>
<td>UM351W and UM301W are 6 by 4</td>
</tr>
<tr>
<td>(4) Cursor</td>
<td>The cursor is used to select (highlight) the folder or image file by using ▲▼◀▶button.</td>
</tr>
<tr>
<td>(5) Back icon</td>
<td>This icon is used to return to the upper (parent) folder.</td>
</tr>
<tr>
<td>(6) Folder icon</td>
<td>This icon shows that the USB memory has folders.</td>
</tr>
<tr>
<td>(7) Page up (Page down) icon</td>
<td>This icon shows further folders or image files are available in the next (previous) page. Use the ► button to go to the next (previous) row.</td>
</tr>
<tr>
<td></td>
<td>The PAGE ▼ or PAGE △ on the remote control is used to go to the next or previous page directly.</td>
</tr>
<tr>
<td>(8) Thumbnail toolbar</td>
<td>This toolbar is used in the thumbnail screen. Pressing the MENU button will display this toolbar. (→ page 70)</td>
</tr>
<tr>
<td>(9) Slide screen</td>
<td>This screen is used for manual playback. The selected image will be displayed in full screen.</td>
</tr>
<tr>
<td>(10) Slide toolbar</td>
<td>This toolbar is used in the slide screen. Pressing the MENU button will display this toolbar. (→ page 71)</td>
</tr>
<tr>
<td>(11) Slideshow screen</td>
<td>This screen is used for auto playback. The slides will be changed automatically.</td>
</tr>
<tr>
<td>(12) Slideshow toolbar</td>
<td>This toolbar is used in the slideshow screen. Pressing the MENU button will display this toolbar. (→ page 71)</td>
</tr>
</tbody>
</table>
Using the toolbar

1. **Press the MENU button.**
   The toolbar will be displayed.
   The SOURCE screen will be displayed as Viewer connection screen.

2. **Use the ◀ or ▶ button to select an item and use the ▲ or ▼ button to select its available option.**
   When the cursor is placed, the selected item will be changed to yellow.
   The ▲ or ▼ shows more available choices.

3. **Press the ENTER button.**
   The selected item will be displayed.

4. **Press the MENU button two times.**
   The toolbar will be closed and the SOURCE list will be displayed. Press the MENU button again to close the SOURCE list.

**Thumbnail toolbar**

<table>
<thead>
<tr>
<th>Menu</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Back</td>
<td>◀</td>
<td>Goes back to the previous image. When the cursor reaches the top left of the screen, it will go to the previous page.</td>
</tr>
<tr>
<td>(2) Forward</td>
<td>▶</td>
<td>Goes to the next image. When the cursor reaches the bottom right of the screen, it will go to the next page.</td>
</tr>
<tr>
<td>(3) Display</td>
<td>—</td>
<td>Closes the menu and returns to the thumbnail screen.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Closes the menu and starts the slideshow from the highlighted item.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Closes the menu and displays the slide screen.</td>
</tr>
<tr>
<td>(4) Order</td>
<td>—</td>
<td>Displays the icons alphabetically by name. (number before alphabet)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Displays the icons in descending order of file size.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Displays the icons in the order of creation date</td>
</tr>
</tbody>
</table>
### 4. Using the Viewer

#### Slide toolbar

<table>
<thead>
<tr>
<th>Menu</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Display</td>
<td><img src="image" alt="Image Display" /></td>
<td>Closes the menu and switches to the slide screen.</td>
</tr>
<tr>
<td>(2) Image display</td>
<td><img src="image" alt="Image Display" /></td>
<td>Closes the menu and displays the thumbnail screen.</td>
</tr>
<tr>
<td>(3) Clockwise rotation</td>
<td><img src="image" alt="Image Display" /></td>
<td>Closes the menu and starts the slideshow from the highlighted item.</td>
</tr>
<tr>
<td>(4) Counter-clockwise rotation</td>
<td><img src="image" alt="Image Display" /></td>
<td>Closes the menu and displays the image in the projector’s maximum resolution.</td>
</tr>
</tbody>
</table>

#### Slideshow toolbar

<table>
<thead>
<tr>
<th>Menu</th>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>(1) Stop</td>
<td><img src="image" alt="Stop" /></td>
<td>Closes the menu and changes to the slide screen.</td>
</tr>
<tr>
<td>(2) Back</td>
<td><img src="image" alt="Back" /></td>
<td>Goes back to the previous image.</td>
</tr>
<tr>
<td>(3) Forward</td>
<td><img src="image" alt="Forward" /></td>
<td>Goes to the next image.</td>
</tr>
<tr>
<td>(4) Interval</td>
<td><img src="image" alt="Interval" /></td>
<td>Specifies interval time when playing back the slides.</td>
</tr>
<tr>
<td>(5) Repeat</td>
<td><img src="image" alt="Repeat" /></td>
<td>Repeats to play back the images in the folder.</td>
</tr>
</tbody>
</table>

**TIP:**
- A picture icon at the center of the screen shows that the file cannot be displayed in the slide screen or thumbnail screen.
- Slide toolbar setting for rotation will be cancelled if the folder is moved from one place to another.
5. Using On-Screen Menu

1. Press the MENU button on the remote control or the projector cabinet to display the menu.

2. Press the \( \text{ excitement} \) buttons on the remote control or the projector cabinet to display the submenu.

3. Press the ENTER button on the remote control or the projector cabinet to highlight the top item or the first tab.

4. Use the \( \text{ excitement} \) buttons on the remote control or the projector cabinet to select the item you want to adjust or set.
   
   You can use the \( \text{ excitement} \) buttons on the remote control or the projector cabinet to select the tab you want.

5. Press the ENTER button on the remote control or the projector cabinet to display the submenu window.

6. Adjust the level or turn the selected item on or off by using the \( \text{ excitement} \) buttons on the remote control or the projector cabinet.
   
   Changes are stored until adjusted again.

7. Repeat steps 2-6 to adjust an additional item, or press the EXIT button on the remote control or the projector cabinet to quit the menu display.

8. Press the MENU button to close the menu.
   
   To return to the previous menu, press the EXIT button.
Menu windows or dialog boxes typically have the following elements:

- **Highlight** ......................... Indicates the selected menu or item.
- **Solid triangle** ................. Indicates further choices are available. A highlighted triangle indicates the item is active.
- **Tab** .................................. Indicates a group of features in a dialog box. Selecting on any tab brings its page to the front.
- **Radio button** ..................... Use this round button to select an option in a dialog box.
- **Source** .............................. Indicates the currently selected source.
- **Off Timer remaining time** .... Indicates the remaining countdown time when the [OFF TIMER] is preset.
- **Slide bar** ........................... Indicates settings or the direction of adjustment.
- **ECO mode symbol** ............. Indicates ECO MODE is set.
- **Key Lock symbol** .............. Indicates the [CONTROL PANEL LOCK] is enabled.
- **Thermometer symbol** ........ Indicates the [ECO MODE] is forcibly set to [NORMAL] mode because the internal temperature is too high.
- **High Altitude symbol** ......... Indicates the [FAN MODE] is set to [HIGH ALTITUDE] mode.
- **Wireless symbol** ............... Indicate the wireless LAN connection is enabled.
## List of Menu Items

Some menu items are not available depending on the input source.

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SOURCE</strong></td>
<td></td>
</tr>
<tr>
<td>COMPUTER</td>
<td>*</td>
</tr>
<tr>
<td>HDMI1/MHL</td>
<td>*</td>
</tr>
<tr>
<td>HDMI2</td>
<td>*</td>
</tr>
<tr>
<td>VIDEO</td>
<td>*</td>
</tr>
<tr>
<td>USB-A</td>
<td>*</td>
</tr>
<tr>
<td>LAN</td>
<td>*</td>
</tr>
<tr>
<td>USB-B</td>
<td>*</td>
</tr>
<tr>
<td><strong>PRESET</strong></td>
<td></td>
</tr>
<tr>
<td>GENERAL</td>
<td></td>
</tr>
<tr>
<td>REFERENCE</td>
<td>* HIGH-BRIGHT, PRESENTATION, VIDEO, MOVIE, GRAPHIC, sRGB, DICOM SIM.</td>
</tr>
<tr>
<td>SCREEN SIZE</td>
<td>* LARGE, MEDIUM, SMALL</td>
</tr>
<tr>
<td>COLOR TEMPERATURE</td>
<td>* 5000, 6500, 7800, 8500, 9300, 10500</td>
</tr>
<tr>
<td>DYNAMIC CONTRAST</td>
<td>* OFF, ON</td>
</tr>
<tr>
<td>IMAGE MODE</td>
<td>* STILL, MOVIE</td>
</tr>
<tr>
<td>COLOR ENHANCEMENT</td>
<td>* OFF, LOW, MIDDLE, HIGH</td>
</tr>
<tr>
<td><strong>PICTURE</strong></td>
<td></td>
</tr>
<tr>
<td>CONTRAST</td>
<td>63</td>
</tr>
<tr>
<td>BRIGHTNESS</td>
<td>63</td>
</tr>
<tr>
<td>SHARPNESS</td>
<td>7</td>
</tr>
<tr>
<td>COLOR</td>
<td>31</td>
</tr>
<tr>
<td>HUE</td>
<td>31</td>
</tr>
<tr>
<td><strong>ADJUST</strong></td>
<td></td>
</tr>
<tr>
<td>CONTRAST R</td>
<td>0</td>
</tr>
<tr>
<td>CONTRAST G</td>
<td>0</td>
</tr>
<tr>
<td>CONTRAST B</td>
<td>0</td>
</tr>
<tr>
<td>BRIGHTNESS R</td>
<td>*</td>
</tr>
<tr>
<td>BRIGHTNESS G</td>
<td>*</td>
</tr>
<tr>
<td>BRIGHTNESS B</td>
<td>*</td>
</tr>
<tr>
<td><strong>IMAGE OPTIONS</strong></td>
<td></td>
</tr>
<tr>
<td>CLOCK</td>
<td>*</td>
</tr>
<tr>
<td>PHASE</td>
<td>*</td>
</tr>
<tr>
<td>HORIZONTAL</td>
<td>*</td>
</tr>
<tr>
<td>VERTICAL</td>
<td>*</td>
</tr>
<tr>
<td>OVERSCAN</td>
<td>* AUTO, 0(%), 5(%), 10(%)</td>
</tr>
<tr>
<td>ASPECT RATIO</td>
<td>* UM361X/UM301X: AUTO, 4:3, 16:9, 15:9, 16:10, WIDE ZOOM, NATIVE</td>
</tr>
<tr>
<td>POSITION (Not available on UM351W/UM301W)</td>
<td>0</td>
</tr>
<tr>
<td><strong>AUDIO</strong></td>
<td></td>
</tr>
<tr>
<td>DIGITAL ZOOM</td>
<td>100 70 to 100</td>
</tr>
<tr>
<td><strong>SETUP</strong></td>
<td></td>
</tr>
<tr>
<td>KEYSTONE</td>
<td></td>
</tr>
<tr>
<td>KEYSTONE HORIZONTAL</td>
<td>0</td>
</tr>
<tr>
<td>KEYSTONE VERTICAL</td>
<td>0</td>
</tr>
<tr>
<td>PINCUSHION LEFT/RIGHT</td>
<td>0</td>
</tr>
<tr>
<td>PINCUSHION TOP/ BOTTOM</td>
<td>0</td>
</tr>
<tr>
<td>CORNERSTONE</td>
<td>0</td>
</tr>
<tr>
<td>WALL COLOR</td>
<td>OFF OFF, WHITEBOARD, BLACKBOARD, BLACKBOARD (GRAY), LIGHT YELLOW, LIGHT GREEN, LIGHT BLUE, SKY BLUE, LIGHT ROSE, PINK</td>
</tr>
<tr>
<td>ECO MODE</td>
<td>AUTO ECO OFF, AUTO ECO, NORMAL, ECO</td>
</tr>
<tr>
<td>CLOSED CAPTION</td>
<td>OFF OFF, CAPTION1, CAPTION2, CAPTION3, CAPTION4, TEXT1, TEXT2, TEXT3, TEXT4</td>
</tr>
<tr>
<td>OFF TIMER</td>
<td>OFF OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00</td>
</tr>
</tbody>
</table>
| LANGUAGE | ENGLISH ENGLISH, DEUTSCH, FRANÇAIS, ITALIANO, ESPAÑOL, SVENSKA, 日本語, DANSK, PORTUGUÊS, ESTONIAN, MAGYAR, POLSKI, NEDERLANDS, SUOMI, NORSK, TÜRKÇE, РУССКИЙ, ΕΛΛΗΝΙΚΑ, 繁體中文, 한국어, THIẾT VIỆT, ROMANA, HRVATSKI, БЪЛГАРСКИ, INDONESIA, हिन्दी, ไทย, 中文

* The asterisk (*) indicates that the default setting varies depending on the signal.
### 5. Using On-Screen Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>Default</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>COLOR SELECT</strong></td>
<td>COLOR</td>
<td>COLOR, MONOCHROME</td>
</tr>
<tr>
<td><strong>SOURCE DISPLAY</strong></td>
<td>ON</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>ID DISPLAY</strong></td>
<td>ON</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>ECO MESSAGE</strong></td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>DISPLAY TIME</strong></td>
<td>AUTO 45 SEC</td>
<td>MANUAL, AUTO 5 SEC, AUTO 15 SEC, AUTO 45 SEC</td>
</tr>
<tr>
<td><strong>BACKGROUND</strong></td>
<td>BLUE</td>
<td>BLUE, BLACK, LOGO</td>
</tr>
<tr>
<td><strong>FILTER MESSAGE</strong></td>
<td>5000[H]</td>
<td>OFF, 1000[H], 5000[H], 1000[H], 2000[H], 5000[H]</td>
</tr>
<tr>
<td><strong>ORIENTATION</strong></td>
<td>DESKTOP FRONT</td>
<td>AUTO, DESKTOP FRONT, CEILING REAR, DESKTOP REAR, CEILING FRONT</td>
</tr>
<tr>
<td><strong>CONTROL PANEL LOCK</strong></td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>SECURITY</strong></td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>COMMUNICATION SPEED</strong></td>
<td>38400bps</td>
<td>4800bps, 9600bps, 19200bps, 38400bps</td>
</tr>
<tr>
<td><strong>CONTROL ID</strong></td>
<td>CONTROL ID NUMBER 1</td>
<td>1–254</td>
</tr>
<tr>
<td><strong>MIC SELECT</strong></td>
<td>DYNAMIC</td>
<td>DYNAMIC, CONDENSER</td>
</tr>
<tr>
<td><strong>MIC GAIN</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>AUTO ADJUST</strong></td>
<td>NORMAL</td>
<td>OFF, NORMAL, FINE</td>
</tr>
<tr>
<td><strong>SEAMLESS SWITCHING</strong></td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>FAN MODE</strong></td>
<td>AUTO</td>
<td>AUTO, HIGH, HIGH ALTITUDE</td>
</tr>
<tr>
<td><strong>SIGNAL SELECT</strong></td>
<td>COMPUTER</td>
<td>RGB/COMPONENT</td>
</tr>
<tr>
<td><strong>VIDEO</strong></td>
<td>AUTO</td>
<td>AUTO, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, SECAM</td>
</tr>
<tr>
<td><strong>WXGA MODE</strong></td>
<td>UM361X/UM301X: OFF, UM351W/UM301W: ON</td>
<td></td>
</tr>
<tr>
<td><strong>DEINTERLACE</strong></td>
<td>OFF, ON</td>
<td></td>
</tr>
<tr>
<td><strong>HDMI SETTINGS</strong></td>
<td>HDMI1/MHL VIDEO LEVEL</td>
<td>AUTO, AUTO, NORMAL, ENHANCED</td>
</tr>
<tr>
<td><strong>HDMI2 VIDEO LEVEL</strong></td>
<td>AUTO</td>
<td>AUTO, NORMAL, ENHANCED</td>
</tr>
<tr>
<td><strong>AUDIO SELECT</strong></td>
<td>HDMI1/MHL</td>
<td>HDMI1/MHL, HDMI1/MHL, COMPUTER</td>
</tr>
<tr>
<td><strong>HDMI2 HDMI1/MHL</strong></td>
<td>HDMI2</td>
<td>HDMI2, HDMI2, COMPUTER</td>
</tr>
<tr>
<td><strong>LAN</strong></td>
<td>LAN</td>
<td>LAN, COMPUTER</td>
</tr>
<tr>
<td><strong>USB-B</strong></td>
<td>USB-B</td>
<td>USB-B, COMPUTER</td>
</tr>
<tr>
<td><strong>STANDBY MODE</strong></td>
<td>NORMAL</td>
<td>NORMAL, NETWORK STANDBY</td>
</tr>
<tr>
<td><strong>DIRECT POWER ON</strong></td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>AUTO POWER ON</strong></td>
<td>OFF</td>
<td>OFF, ON</td>
</tr>
<tr>
<td><strong>AUTO POWER OFF</strong></td>
<td>1:00</td>
<td>OFF, 0:05, 0:10, 0:20, 0:30, 1:00</td>
</tr>
<tr>
<td><strong>DEFAULT SOURCE SELECT</strong></td>
<td>LAST</td>
<td>LAST, AUTO, COMPUTER, HDMI1/MHL, HDMI2, VIDEO, USB-A, LAN, USB-B</td>
</tr>
<tr>
<td><strong>CURRENCY CONVERT</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>WIRED LAN</strong></td>
<td>ENABLE</td>
<td>DISABLE, ENABLE</td>
</tr>
<tr>
<td><strong>SETTINGS</strong></td>
<td>DHCP ON AUTO DNS: ON</td>
<td>DHCP, IP ADDRESS, SUBNET MASK, GATEWAY, AUTO DNS, DNS</td>
</tr>
<tr>
<td><strong>RECONNECT</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>WIRELESS LAN</strong></td>
<td>PROFILE</td>
<td>DISABLE, SIMPLE ACCESS POINT, PROFILE1, PROFILE2</td>
</tr>
<tr>
<td><strong>RECONNECT</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* The asterisk (*) indicates that the default setting varies depending on the signal.*
## 5. Using On-Screen Menu

<table>
<thead>
<tr>
<th>Menu Item</th>
<th>LAMP LIFE REMAINING</th>
<th>LAMP HOURS USED</th>
<th>FILTER HOURS USED</th>
<th>TOTAL CARBON SAVINGS</th>
<th>TOTAL COST SAVINGS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SOURCE(1)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SOURCE NAME</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SOURCE INDEX</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HORIZONTAL FREQUENCY</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VERTICAL FREQUENCY</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SYNC TYPE</td>
<td>SEPARATE SYNC, COMPOSITE SYNC, SYNC ON GREEN, SYNC ON VIDEO</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SYNC POLARITY</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SCAN TYPE</td>
<td>INTERLACE, NON-INTERLACE</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SOURCE(2)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SIGNAL TYPE</td>
<td>RGB, COMPONENT VIDEO, HDTV</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIDEO TYPE</td>
<td>NTSC, NTSC3.58, NTSC4.43, PAL, PAL-M, PAL-N, PAL60, SECAM</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>BIT DEPTH</td>
<td>8[bits], 10[bits], 12[bits]</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VIDEO LEVEL</td>
<td>ENHANCED, FULL</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MHL SIGNAL</td>
<td>SUPPORTED, NOT SUPPORTED</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>INFO.</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WIRED LAN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP ADDRESS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUBNET MASK</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GATEWAY</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MAC ADDRESS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WIRELESS LAN</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP ADDRESS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SUBNET MASK</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>GATEWAY</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MAC ADDRESS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SSID</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>NETWORK TYPE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WEP/WPA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CHANNEL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SIGNAL LEVEL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>VERSION</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FIRMWARE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DATA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>OTHERS</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PROJECTOR NAME</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MODEL NO.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>SERIAL NUMBER</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LAN UNIT TYPE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONTROL ID (when [CONTROL ID] is set)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>RESET</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CURRENT SIGNAL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ALL DATA</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CLEAR LAMP HOURS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CLEAR FILTER HOURS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* The asterisk (*) indicates that the default setting varies depending on the signal.
### Menu Descriptions & Functions [SOURCE]

<table>
<thead>
<tr>
<th>SOURCE</th>
<th>ADJUST</th>
<th>SETUP</th>
<th>INFO.</th>
<th>RESET</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Computer.png" alt="Computer" /></td>
<td><img src="Adjust.png" alt="Adjust" /></td>
<td><img src="Setup.png" alt="Setup" /></td>
<td><img src="Info.png" alt="Info." /></td>
<td><img src="Reset.png" alt="Reset" /></td>
</tr>
<tr>
<td><img src="HDMI1.png" alt="HDMI1/MHL" /></td>
<td><img src="HDMI2.png" alt="HDMI2" /></td>
<td><img src="Video.png" alt="Video" /></td>
<td><img src="USB-A.png" alt="USB-A" /></td>
<td></td>
</tr>
<tr>
<td><img src="USB-B.png" alt="USB-B" /></td>
<td><img src="LAN.png" alt="LAN" /></td>
<td><img src="Computer.png" alt="computer" /></td>
<td><img src="Default.png" alt="Default" /></td>
<td></td>
</tr>
</tbody>
</table>

#### COMPUTER
Selects the computer connected to your COMPUTER input terminal signal.

*NOTE: When the component input signal is connected to the COMPUTER IN terminal, select [COMPUTER].*

#### HDMI1/MHL and HDMI2
Selects the HDMI compatible equipment connected to your HDMI1/MHL or 2 IN terminal.

#### VIDEO
Selects what is connected to your VIDEO input-VCR, DVD player or document camera.

#### USB-A
This feature enables you to make presentations using a USB memory that contains slides.

(→ page 64 “4. Using the Viewer”)

#### LAN
Selects a signal from the LAN port (RJ-45) or the installed USB wireless LAN unit (optional).

#### USB-B
Selects the computer connected to the USB(PC) port (type B) by using a commercially available USB cable.

(→ page 42)
5. Using On-Screen Menu

Menu Descriptions & Functions [ADJUST]

[PICTURE]

This function allows you to select optimized settings for your projected image. You can adjust neutral tint for yellow, cyan or magenta. There are seven factory presets optimized for various types of images. You can also use [DETAIL SETTINGS] to set user adjustable settings to customize each gamma or color. Your settings can be stored in [PRESET 1] to [PRESET 7].

- HIGH-BRIGHT........ Recommended for use in a brightly lit room.
- PRESENTATION .... Recommended for making a presentation using a PowerPoint file.
- VIDEO................ Recommended for typical TV program viewing.
- MOVIE .............. Recommended for movies.
- GRAPHIC ............ Recommended for graphics.
- sRGB .............. Standard color values
- DICOM SIM. ......... Recommended for DICOM simulation format.

**NOTE:**
- The [DICOM SIM.] option is for training/reference only and should not be used for actual diagnosis.
- DICOM stands for Digital Imaging and Communications in Medicine. It is a standard developed by the American College of Radiology (ACR) and the National Electrical Manufacturers Association (NEMA).
  The standard specifies how digital image data can be moved from system to system.

[DETAIL SETTINGS]
5. Using On-Screen Menu

[GENERAL]

Storing Your Customized Settings [REFERENCE]
This function allows you to store your customized settings in [PRESET 1] to [PRESET 7]. First, select a base preset mode from [REFERENCE], then set [GAMMA CORRECTION] and [COLOR TEMPERATURE].

- HIGH-BRIGHT ....... Recommended for use in a brightly lit room.
- PRESENTATION ..... Recommended for making a presentation using a PowerPoint file.
- VIDEO ................ Recommended for typical TV program viewing.
- MOVIE ................ Recommended for movies.
- GRAPHIC .............. Recommended for graphics.
- sRGB ................... Standard color values.
- DICOM SIM. ........... Recommended for DICOM simulation format.

Selecting Gamma Correction Mode [GAMMA CORRECTION]
Each mode is recommended for:
- DYNAMIC ............ Creates a high-contrast picture.
- NATURAL .............. Natural reproduction of the picture.
- BLACK DETAIL....... Emphasizes detail in dark areas of the picture.

**NOTE:** This function is not available when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Selecting Screen Size for DICOM SIM [SCREEN SIZE]
This function will perform gamma correction appropriate for the screen size.
- LARGE ................ For screen size of 110”
- MEDIUM ............ For screen size of 90”
- SMALL ............... For screen size of 70”

**NOTE:** This function is available only when [DICOM SIM.] is selected for [DETAIL SETTINGS].

Adjusting Color Temperature [COLOR TEMPERATURE]
This option allows you to select the color temperature of your choice.

**NOTE:** When [PRESENTATION] or [HIGH-BRIGHT] is selected in [REFERENCE], this function is not available.

Adjusting Brightness and Contrast [DYNAMIC CONTRAST]
This function allows you to adjust the contrast ratio optically using the built-in iris. To increase the contrast ratio, select [ON].

Selecting Still Image Mode or Movie Mode [IMAGE MODE]
This function allows you to select the still image mode or the movie mode.
- STILL .................. This mode is for a still image.
- MOVIE ................ This mode is for a movie.

**NOTE:** This function is available only when [HIGH-BRIGHT] is selected for [REFERENCE].
Enhancing the Color [COLOR ENHANCEMENT]
This allows you to adjust the color density of the image. The color of the image will become deeper in the order of "LOW", "MEDIUM", AND "HIGH" as the displayed image will become darker. With "OFF" selected, the COLOR ENHANCEMENT function will not work.

**NOTE:** This function is available only when [PRESENTATION] is selected [REFERENCE].

Adjusting White Balance [WHITE BALANCE]
This allows you to adjust the white balance. Contrast for each color (RGB) to adjust the white level of the screen; Brightness for each color (RGB) is used to adjust the black level of the screen.

**[CONTRAST]**
Adjusts the intensity of the image according to the incoming signal.

**[BRIGHTNESS]**
Adjusts the brightness level or the back raster intensity.

**[SHARPNESS]**
Controls the detail of the image.

**[COLOR]**
Increases or decreases the color saturation level.

**[HUE]**
Varies the color level from +/- green to +/- blue. The red level is used as reference.

<table>
<thead>
<tr>
<th>Input signal</th>
<th>CONTRAST</th>
<th>BRIGHTNESS</th>
<th>SHARPNESS</th>
<th>COLOR</th>
<th>HUE</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPUTER/HDMI (RGB)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>COMPUTER/HDMI (COMPONENT)</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>USB-B</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>VIDEO</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>USB-A/LAN</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

Yes = Adjustable, No = Not adjustable

**[RESET]**
The settings and adjustments for [PICTURE] will be returned to the factory settings with the exception of the following; Preset numbers and [REFERENCE] within the [PRESET] screen.
The settings and adjustments under [DETAIL SETTINGS] within the [PRESET] screen that are not currently selected will not be reset.
5. Using On-Screen Menu

[IMAGE OPTIONS]

Adjusting Clock and Phase [CLOCK/PHASE]
This allows you to manually adjust CLOCK and PHASE.

CLOCK.................... Use this item to fine tune the computer image or to remove any vertical banding that might appear. This function adjusts the clock frequencies that eliminate the horizontal banding in the image. This adjustment may be necessary when you connect your computer for the first time.

PHASE..................... Use this item to adjust the clock phase or to reduce video noise, dot interference or cross talk. (This is evident when part of your image appears to be shimmering.)

Use [PHASE] only after the [CLOCK] is complete.
Adjusting Horizontal/Vertical Position [HORIZONTAL/VERTICAL]

Adjusts the image location horizontally and vertically.

- An image can be distorted during the adjustment of [CLOCK] and [PHASE]. This is not malfunction.
- The adjustments for [CLOCK], [PHASE], [HORIZONTAL], and [VERTICAL] will be stored in memory for the current signal. The next time you project the signal with the same resolution, horizontal and vertical frequency, its adjustments will be called up and applied.

To delete adjustments stored in memory, from the menu, you select [RESET] → [CURRENT SIGNAL] or [ALL DATA] and reset the adjustments.

Selecting Overscan Percentage [OVERSCAN]

Select overscan percentage (AUTO, 0%, 5% and 10%) for signal.

NOTE:
- The [0%] cannot be selected when VIDEO signal is used.
- The [OVERSCAN] item is not available:
  - when [NATIVE] is selected for [ASPECT RATIO].
Selecting Aspect Ratio [ASPECT RATIO]

The term “aspect ratio” refers to the ratio of width to height of a projected image.
The projector automatically determines the incoming signal and displays it in its appropriate aspect ratio.

- This table shows typical resolutions and aspect ratios that most computers support.

<table>
<thead>
<tr>
<th>Resolution</th>
<th>Aspect Ratio</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640 × 480</td>
</tr>
<tr>
<td>SVGA</td>
<td>800 × 600</td>
</tr>
<tr>
<td>XGA</td>
<td>1024 × 768</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280 × 768</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1280 × 800</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280 × 1024</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400 × 1050</td>
</tr>
<tr>
<td>UXGA</td>
<td>1600 × 1200</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1920 × 1200</td>
</tr>
</tbody>
</table>

**Options** | **Function**
--- | ---
AUTO | The projector will automatically determine the incoming signal and display it in its aspect ratio. (→ next page)
The projector may erroneously determine the aspect ratio depending on its signal. If this occurs, select the appropriate aspect ratio from the following.

4:3 | The image is displayed in 4:3 aspect ratio.
16:9 | The image is displayed in 16:9 aspect ratio.
15:9 | The image is displayed in 15:9 aspect ratio.
16:10 | The image is displayed in 16:10 aspect ratio.

WIDE ZOOM (UM361X/UM301X) | The image is stretched left and right. Parts of the displayed image are cropped at the left and right edges and therefore not visible.

LETTERBOX (UM351W/UM301W) | The image of a letterbox signal is stretched equally in the horizontal and vertical directions to fit the screen. Parts of the displayed image are cropped at the top and bottom edges and therefore not visible.

NATIVE | The projector displays the current image in its true resolution when the incoming computer signal has a lower resolution than the projector’s native resolution.

[Example 1] When the incoming signal with the resolution of 800 × 600 is displayed on the UM361X/UM301X:

[Example 2] When the incoming signal with the resolution of 800 × 600 is displayed on the UM351W/UM301W:

**NOTE:**
- When a non-computer signal is displayed, the [NATIVE] is not available.
- When a signal with a higher resolution than the projector’s native resolution is displayed, [NATIVE] is not available.
### Sample image when the appropriate aspect ratio is automatically determined

#### UM361X/UM301X

[Computer signal]

<table>
<thead>
<tr>
<th>Aspect ratio of incoming signal</th>
<th>4:3</th>
<th>5:4</th>
<th>16:9</th>
<th>15:9</th>
<th>16:10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample image when the appro-</td>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
<td><img src="image4.png" alt="Image" /></td>
<td><img src="image5.png" alt="Image" /></td>
</tr>
<tr>
<td>priate aspect ratio is auto-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>matically determined</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

[Video signal]

<table>
<thead>
<tr>
<th>Aspect ratio of incoming signal</th>
<th>4:3</th>
<th>Letterbox</th>
<th>Squeeze</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample image when the appro-</td>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td>priate aspect ratio is auto-</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>matically determined</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### NOTE:
To display a squeezed signal properly, select [16:9] or [WIDE ZOOM].

#### UM351W/UM301W

[Computer signal]

<table>
<thead>
<tr>
<th>Aspect ratio of incoming signal</th>
<th>4:3</th>
<th>5:4</th>
<th>16:9</th>
<th>15:9</th>
<th>16:10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample image when the appro-</td>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
<td><img src="image4.png" alt="Image" /></td>
<td><img src="image5.png" alt="Image" /></td>
</tr>
<tr>
<td>priate aspect ratio is auto-</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>matically determined</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

[Video signal]

<table>
<thead>
<tr>
<th>Aspect ratio of incoming signal</th>
<th>4:3</th>
<th>Letterbox</th>
<th>Squeeze</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample image when the appro-</td>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
<tr>
<td>priate aspect ratio is auto-</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>matically determined</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### NOTE:
To display a letterbox signal properly, select [LETTERBOX].
To display a squeezed signal properly, select [16:9].

### TIP:
- Image position can be adjusted vertically using [POSITION] when the [16:9], [15:9], or [16:10] aspect ratios are selected.
- The term “letterbox” refers to a more landscape-oriented image when compared to a 4:3 image, which is the standard aspect ratio for a video source.
  - The letterbox signal has aspect ratios with the vista size “1.85:1” or cinema scope size “2.35:1” for movie film.
- The term “squeeze” refers to the compressed image of which aspect ratio is converted from 16:9 to 4:3.

### Adjusting the Vertical Position of Image [POSITION] (not available on UM351W/UM301W)

(only when [16:9], [15:9], or [16:10] is selected for [ASPECT RATIO])

When [16:9], [15:9], or [16:10] is selected in [ASPECT RATIO], the image is displayed with black borders on the top and bottom.

You can adjust the vertical position from the top to the bottom of the black area.
5. Using On-Screen Menu

[TIP]

• When no menus appear, the ◄ and ► buttons on the projector cabinet and the VOL. +/- buttons on the remote control work as a volume control. (→ page 23)
5. Using On-Screen Menu

6 Menu Descriptions & Functions [SETUP]

[GENERAL]

Using Digital Zoom [DIGITAL ZOOM]
This feature allows you to electronically fine adjust the image size on the screen.

**NOTE:**
- This feature can not be used when USB-A, LAN, or USB-B is selected as a input terminal.

**TIP:** To adjust the projected image size roughly, move the projector away or closer to the screen. To fine adjust the zoom, use the [DIGITAL ZOOM] function. (→ page 20)

Correcting Keystone Distortion Manually [KEYSTONE]
You can correct horizontal or vertical keystone, pincushion, or cornerstone distortion manually.

**NOTE:**
- Some items are not available when one item is activated. Unavailable items are shown in grey.
- To change from one item to another item, reset the first item.
- Adjustment values will be overwritten. They will not be deleted even when the projector is turned off.
- Using [KEYSTONE], [PINCUSHION] and [CORNERSTONE] correction can cause the image to be slightly blurred because the correction is made electronically.

KEYSTONE HORIZONTAL ........... Corrects horizontal keystone distortion. (→ page 21)
KEYSTONE VERTICAL............... Corrects vertical keystone distortion. (→ page 21)
PINCUSHION LEFT/RIGHT......... Corrects pincushion distortion at the left or right side.
PINCUSHION TOP/BOTTOM ..... Corrects pincushion distortion at the top or bottom side.
CORNERSTONE ...................... Fits a projected image within the border of the screen easily by align the four corner of an image to the ones of the screen. (→ page 29)
RESET.............................. Returns all the above items to the factory preset values.

**TIP:**
- Adjustable angle range in horizontal and vertical direction in the cornerstone and the keystone corrections: Approx. 10 degrees (Max)
  - Depending on input signal, the adjustable range may be narrower.
Using the Wall Color Correction [WALL COLOR]

This function allows for quick adaptive color correction in applications where the screen material is not white.

**NOTE:** Selecting [WHITEBOARD] reduces lamp brightness.

Setting Eco Mode [ECO MODE]

The ECO MODE increases lamp life, while lowering power consumption and cutting down on CO₂ emissions. Four brightness modes of the lamp can be selected: [OFF], [AUTO ECO], [NORMAL] and [ECO] modes. (→ page 27)
5. Using On-Screen Menu

Setting Closed Caption [CLOSED CAPTION]
This option sets several closed caption modes that allow text to be superimposed on the projected image of Video or S-Video.

OFF .......................... This exits the closed caption mode.
CAPTION 1-4 ........... Text is superimposed.
TEXT 1-4 ............... Text is displayed.

NOTE:
• The closed caption is not available under the following conditions:
  - when messages or menus are displayed.
  - when an image is magnified, frozen, or muted.
• Portions of superimposed text or closed caption may be truncated. If that happens, try to place the superimposed text or closed caption within the screen.

Using Off Timer [OFF TIMER]
1. Select your desired time between 30 minutes and 16 hours: OFF, 0:30, 1:00, 2:00, 4:00, 8:00, 12:00, 16:00.
2. Press the ENTER button on the remote control.
3. The remaining time starts counting down.
4. The projector will turn off after the countdown is complete.

NOTE:
• To cancel the preset time, set [OFF] for the preset time or turn off the power.
• When the remaining time reaches 3 minutes before the projector is turned off, the [THE PROJECTOR WILL TURN OFF WITHIN 3 MINUTES] message will be displayed on the bottom of the screen.

Selecting Menu Language [LANGUAGE]
You can choose one of 30 languages for on-screen instructions.

NOTE: Your setting will not be affected even when [RESET] is done from the menu.

[Menu]

Selecting Menu Color [COLOR SELECT]
You can choose between two options for menu color: COLOR and MONOCHROME.

Turning On / Off Source Display [SOURCE DISPLAY]
This option turns on or off input name display such as COMPUTER, HDMI1/MHL, HDMI2, VIDEO, USB-A, LAN, USB-B, to be displayed on the top right of the screen.
When no input signal is present, the no-signal guidance prompting you to check for an available input will be displayed at the center of the screen. When the [USB-A] or [LAN] item is selected for [SOURCE], the no-signal guidance will not be displayed.
5. Using On-Screen Menu

Turning ON/OFF Control ID [ID DISPLAY]

This option turns on or off the ID number which is displayed when the ID SET button on the remote control is pressed.

Turning On / Off Eco Message [ECO MESSAGE]

This option turns on or off the following messages when the projector is turned on.

The Eco Message prompts the user to save energy. When [OFF] is selected for [ECO MODE], you will get a message to prompt you to select [AUTO ECO], [NORMAL], or [ECO] for [ECO MODE].

When [AUTO ECO], [NORMAL], or [ECO] is selected for [ECO MODE]

![ECO Meter]

To close the message, press any one of the buttons. The message will disappear if no button operation is done for 30 seconds.

When [OFF] is selected for [ECO MODE]

![ECO Meter]

Pressing the ENTER button will display the [ECO MODE] screen. (→ page 27)

To close the message, press the EXIT button.

Selecting Menu Display Time [DISPLAY TIME]

This option allows you to select how long the projector waits after the last touch of a button to turn off the menu. The preset choices are [MANUAL], [AUTO 5 SEC], [AUTO 15 SEC], and [AUTO 45 SEC]. The [AUTO 45 SEC] is the factory preset.

Selecting a Color or Logo for Background [BACKGROUND]

Use this feature to display a blue/black screen or logo when no signal is available. The default background is [BLUE].

**NOTE:**
- If the [LOGO] item is selected for [BACKGROUND] with the [LAN] or [USB-B] source selected, the [BLUE] item will be selected regardless of its selection.
- When [SOURCE DISPLAY] is turned on, the no-signal guidance prompting you to check for an available input will be displayed at the center of the screen regardless of its selection.
- Your setting will not be affected even when [RESET] is done from the menu.

Selecting Interval Time for Filter Message [FILTER MESSAGE]

This option allows you to select the time preference between displaying the message for cleaning the filters. Clean the filter when you get the message “PLEASE CLEAN THE FILTER.” (→ page 118)

Six options are available:
- OFF, 100[H], 500[H], 1000[H], 2000[H], 5000[H]

**NOTE:** Your setting will not be affected even when [RESET] is done from the menu.
Selecting Projector Orientation [ORIENTATION]

This reorients your image for your type of projection. The options are: desktop front projection, ceiling rear projection, desktop rear projection, and ceiling front projection.

AUTO
When the lamp is turned ON, the inner sensor of the projector detects its installation state either DESK FRONT or CEILING FRONT and then switch its projection method.

Disabling the Cabinet Buttons [CONTROL PANEL LOCK]

This option turns on or off the CONTROL PANEL LOCK function.

NOTE:
• This CONTROL PANEL LOCK does not affect the remote control functions.
• When the control panel is locked, pressing and holding the EXIT button on the projector cabinet for about 10 seconds will change the setting to [OFF].

TIP: When the [CONTROL PANEL LOCK] is turned on, a key lock icon [ ] will be displayed at the bottom right of the menu.

Enabling Security [SECURITY]

This feature turns on or off the SECURITY function. Unless the correct keyword is entered, the projector cannot project an image. (→ page 33)

NOTE: Your setting will not be affected even when [RESET] is done from the menu.
Selecting Communication Speed [COMMUNICATION SPEED]
This feature sets the baud rate of the PC Control port (D-Sub 9P). It supports data rates from 4800 to 38400 bps. The default is 38400 bps. Select the appropriate baud rate for your equipment to be connected (depending on the equipment, a lower baud rate may be recommended for long cable runs).

NOTE: Your selected communication speed will not be affected even when [RESET] is done from the menu.

Setting ID to the Projector [CONTROL ID]
You can operate multiple projectors separately and independently with the single remote control that has the CONTROL ID function. If you assign the same ID to all the projectors, you can conveniently operate all the projectors together using the single remote control. To do so, you have to assign an ID number to each projector.

CONTROL ID NUMBER..............Select a number from 1 to 254 you wish to assign to your projector.
CONTROL ID.........................Select [OFF] to turn off the CONTROL ID setting and select [ON] to turn on the CONTROL ID setting.

NOTE:
• When [ON] is selected for [CONTROL ID], the projector cannot be operated by using the remote control that does not support the CONTROL ID function. (In this case the buttons on the projector cabinet can be used.)
• Your setting will not be affected even when [RESET] is done from the menu.
• Pressing and holding the ENTER button on the projector cabinet for 10 seconds will display the menu for canceling the Control ID.

Assigning or Changing the Control ID
1. Turn on the projector.
2. Press the ID SET button on the remote control.
The CONTROL ID screen will be displayed.

If the projector can be operated with the current remote control ID, the [ACTIVE] will be displayed. If the projector cannot be operated with the current remote control ID, the [INACTIVE] will be displayed. To operate the inactive projector, assign the control ID used for the projector by using the following procedure (Step 3).

3. Press one of numeric keypad buttons while pressing and holding the ID SET button on the remote control.
Example:
To assign “3”, press the “3” button on the remote control.
No ID means that all the projectors can be operated together with a single remote control. To set “No ID”, enter “000” or press the CLEAR button.

TIP: The range of IDs is from 1 to 254.

4. Release the ID SET button.
The updated CONTROL ID button will be displayed.

NOTE:
• The IDs can be cleared in a few days after the batteries are run down or removed.
• Accidentally pressing any one of the buttons of the remote control will clear currently specified ID with batteries removed.
5. Using On-Screen Menu

Using Test Pattern [TEST PATTERN]
Displays the test pattern to check for image distortion at the time of the projector setup. Press the ENTER button to display the test pattern; press the EXIT button to close the test pattern and return to the menu. Menu operation and corrections for keystone, cornerstone and pincushion are not available when the test pattern is displayed.

Selecting Microphone Type [MIC SELECT]
This feature allows you to select dynamic or condenser type for your microphone.

Setting MIC Gain [MIC GAIN]
This feature allows you to adjust your microphone sensitivity when it is connected to the MIC input jack of the projector. Microphone volume can be adjusted with the VOL. (+) or (−) button on the remote control or the ◄ or ► on the projector cabinet.

[OPTIONS(1)]

Setting Auto Adjust [AUTO ADJUST]
This feature sets the Auto Adjust mode so that the computer signal can be automatically or manually adjusted for noise and stability. You can automatically make adjustment in two ways: [NORMAL] and [FINE].

- OFF ......................... The computer signal will not be automatically adjusted. You can manually optimize the computer signal.
- NORMAL .................. Default setting. The computer signal will be automatically adjusted. Normally select this option.
- FINE ...................... Select this option if fine adjustment is needed. It takes more time to switch to the source than when [NORMAL] is selected.

[SEAMLESS SWITCHING]
When the input terminal is switched, the image displayed before switching is held to switch to the new image without a break due to absence of a signal.

Selecting Fan Mode [FAN MODE]
This option allows you to select three modes for fan speed: Auto mode, High speed mode, and High Altitude mode.

- AUTO ...................... The built-in fans automatically run at a variable speed according to the internal temperature.
- HIGH ...................... The built-in fans run at high speed.
- HIGH ALTITUDE ...... The built-in fans run at a high speed. Select this option when using the projector at altitudes approximately 5500 feet/1700 meters or higher.

When you wish to cool down the temperature inside the projector quickly, select [HIGH].

NOTE:
- It is recommended that you select High speed mode if you use the projector non-stop for consecutive days.
- Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1700 meters or higher.
- Using the projector at altitudes approximately 5500 feet/1700 meters or higher without setting to [HIGH ALTITUDE] can cause the projector to overheat and the protector could shut down. If this happens, wait a couple minutes and turn on the projector.
- Using the projector at altitudes less than approximately 5500 feet/1700 meters and setting to [HIGH ALTITUDE] can cause the
lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO].

- Using the projector at altitudes approximately 5500 feet/1700 meters or higher can shorten the life of optical components such as the lamp.
- Your setting will not be affected even when [RESET] is done from the menu.

TIP:
- When [HIGH ALTITUDE] is selected, an icon [ ] is displayed at the bottom of the on-screen menu.

Selecting Signal Format [SIGNAL SELECT]
[COMPUTER]
Allows you to choose [COMPUTER] for an RGB source such as a computer, or [COMPONENT] for a component video source such as a DVD player. Normally select [RGB/COMPONENT] and the projector automatically detects a component signal. However there may be some component signals that the projector is unable to detect. If this is the case, select [COMPONENT].

[VIDEO & S-VIDEO System Select]
This feature enables you to select composite video standards automatically or manually. Normally select [AUTO] and the projector will automatically detect the video standard. In the case where the projector has difficulty detecting the video standard, select the appropriate video standard from the menu. This must be done for VIDEO and S-VIDEO respectively.

Enabling or Disabling WXGA Mode [WXGA MODE]
Selecting [ON] will give priority to WXGA (1280 × 768)/WUXGA (1920 × 1200) signals in recognizing an input signal. When [WXGA MODE] is set to [ON], XGA (1024 × 768)/UXGA (1600 × 1200) signals may not be recognized on UM361X/UM301X. In this case, select [OFF].

NOTE:
- The [OFF] is selected at the time of shipment of UM361X/UM301X.
- The [ON] is selected at the time of shipment of UM351W/UM301W.

Enabling the deinterlace [DEINTERLACE]
Turns on or off the deinterlace function for a telecine signal.

OFF ............................ Select this option if there is any jitter or artifacts in video.
ON ............................... Default standard setting.

NOTE: This feature is not available for HDTV (progressive) and computer signals.

Setting HDMI1/MHL & HDMI2 [HDMI SETTINGS]
Make the settings for each video level when connecting HDMI1/MHL equipment such as a DVD player.

VIDEO LEVEL............ Select [AUTO] to automatically detect video level. If automatic detection may not work well, select [NORMAL] to disable the [ENHANCED] feature of your HDMI equipment or select [ENHANCED] to improve image contrast and increase detail in the dark areas.

Setting Audio [AUDIO SELECT]
Make the settings for each audio level when connecting HDMI equipment, your network, and USB (PC) terminal. Select between each equipment and computer.

HDMI1/MHL, HDMI2 ....... Select [HDMI1/MHL] or [HDMI2] to switch the HDMI1/MHL IN or HDMI 2 IN digital audio signal or select [COMPUTER] to switch the COMPUTER input audio signal.
LAN............................ Select [LAN] or [COMPUTER] to switch the source connected to the network.
5. Using On-Screen Menu

USB-B.................. Select [USB-B] or [COMPUTER] to switch the source connected over the USB cable (USB-B).

Enabling Key Sound and Error Sound [BEEP]
This feature turns on or off the button sound or alarm when an error occurs or the following operations are performed.

- Displaying the main menu
- Switching sources
- Resetting data by using [RESET]
- Pressing POWER ON or STANDBY button

[OPTIONS(2)]

Selecting Power-saving in [STANDBY MODE]
The projector has two standby modes: [NORMAL] and [NETWORK STANDBY].
The NORMAL mode is the mode that allows you to put the projector in the power-saving condition which consumes less power than the NETWORK STANDBY mode.

NORMAL..................POWER indicator: Red light/STATUS indicator: Off
When [NORMAL] is selected, only the following buttons and feature will work:
POWER button on the projector cabinet and the remote control, and powering on from PC Control command.

NETWORK STANDBY......POWER indicator: Orange light/STATUS indicator: Off
When [NETWORK STANDBY] is selected, the projector can be turned on over a wired LAN connection and only the following buttons, port, and features will work:
POWER button on the projector cabinet and the remote control, powering on from PC Control command, AUTO POWER ON, LAN port, wireless LAN unit (optional), Virtual Remote Tool, Controls by Image Express Utility Lite, LAN feature, and Mail Alert feature.

NOTE:
• Even when [NORMAL] is selected for [STANDBY MODE], power on or off can be done by using the PC CONTROL port.
• The power consumption in the standby mode will not be included in calculating CO2 emission reduction.
• Your setting will not be affected even when [RESET] is done from the menu.

Enabling Direct Power On [DIRECT POWER ON]
Turns the projector on automatically when the power cord is inserted into an active power outlet. This eliminates the need to always use the POWER button on the remote control or projector cabinet.
5. Using On-Screen Menu

Turning On the Projector By Applying Computer Signal [AUTO POWER ON]
When the projector is in Standby mode, applying a computer or HDMI signal from a computer connected to the COMPUTER IN input, HDMI1/MHL, or HDMI2 input will power on the projector and simultaneously project the image. This functionality eliminates the need to always use the POWER button on the remote control or the projector cabinet to power on the projector.
To use this function, first connect a computer to the projector and the projector to an active AC input.

NOTE:
• Disconnecting a computer signal from the computer will not power off the projector. We recommend using this function in combination of the AUTO POWER OFF function.
• This function will not be available under the following conditions:
  - when a component signal is applied to the COMPUTER IN terminal
  - when a Sync on Green RGB signal or composite sync signal is applied
  - when MHL signal is applied to HDMI1/MHL IN terminal
• To enable the AUTO POWER ON after turning off the projector, wait 5 seconds and input a computer or HDMI signal. If a computer or HDMI signal is still present when the projector is turned off, the AUTO POWER ON will not work and the projector remains in standby mode.

Enabling Power Management [AUTO POWER OFF]
The projector has power management functions. To reduce power consumption, the power management functions (1 and 2) are factory preset as shown below. To control the projector from an external device via a LAN or serial cable connection, use the on-screen menu to change the settings for 1 and 2.

1. STANDBY MODE (Factory preset: NORMAL)
   To control the projector from an external device, select [NETWORK STANDBY] for [STANDBY MODE].

NOTE:
• When [NORMAL] is selected for [STANDBY MODE], the following terminals and functions will not work:
  MONITOR OUT terminal, AUDIO OUT terminal, USB(PC) port, LAN functions, Mail Alert function, DDC/CI (Virtual Remote Tool)

2. AUTO POWER OFF (Factory preset: 1 hour)
   To control the projector from an external device, select [OFF] for [AUTO POWER OFF].

NOTE:
• When [1:00] is selected for [AUTO POWER OFF], you can enable the projector to automatically turn off in 60 minutes if there is no signal received by any input or if no operation is performed.

Selecting Default Source [DEFAULT SOURCE SELECT]
You can set the projector to default to any one of its inputs each time the projector is turned on.

   LAST.................. Sets the projector to default to the previous or last active input each time the projector is turned on.
   AUTO.................. Searches for an active source in order of COMPUTER → HDMI1/MHL → HDMI2 → VIDEO → USB-A → USB-B → COMPUTER and displays the first found source.
   COMPUTER ............ Displays the computer signal from the COMPUTER IN terminal every time the projector is turned on.
   HDMI1/MHL ............ Displays the digital source from the HDMI 1/MHL IN terminal every time the projector is turned on.
   HDMI2 ................. Displays the digital source from the HDMI 2 IN terminal every time the projector is turned on.
   VIDEO ................. Displays the Video source from the VIDEO IN terminal every time the projector is turned on.
   USB-A.................. Displays slides or plays back movie files from the USB memory device every time the projector is turned on.
   LAN.................... Displays a signal from LAN port (RJ-45) or the USB Wireless LAN Unit.
   USB-B.................. Displays the computer signal from the USB (PC) terminal every time the projector is turned on.
### Setting up the Projector for a Wired LAN Connection [WIRED LAN]

<table>
<thead>
<tr>
<th>WIRED LAN</th>
<th>DISABLE</th>
<th>Wired LAN connection will be turned off.</th>
</tr>
</thead>
<tbody>
<tr>
<td>ENABLE</td>
<td></td>
<td>Wired LAN connection will be turned on.</td>
</tr>
</tbody>
</table>

| SETTINGS | DHCP   | ON.......................... IP address, subnet mask, and gateway will be automatically assigned to the projector from your DHCP server. |
|          |        | OFF.......................... Specify IP address, subnet mask, and gateway assigned by your network administrator. |

<table>
<thead>
<tr>
<th>IP ADDRESS</th>
<th>Set your IP address of the network connected to the projector.</th>
</tr>
</thead>
<tbody>
<tr>
<td>SUBNET MASK</td>
<td>Set your subnet mask number of the network connected to the projector.</td>
</tr>
<tr>
<td>GATEWAY</td>
<td>Set the default gateway of the network connected to the projector.</td>
</tr>
</tbody>
</table>

| AUTO DNS | ON.......................... DHCP server will automatically assign IP address of DNS server connected to the projector. |
|          | OFF.......................... Set your IP address of DNS server connected to the projector. |

| RECONNECT | Retry to connect the projector to a network. |

**Important**
- Consult with your network administrator about these settings.
- When using a wired LAN connection, connect a LAN cable (Ethernet cable) to the LAN port (RJ-45) of the projector. (→ page 114)

**Tip:** The network settings you make will not be affected even when [RESET] is done from the menu.
Setting up the Projector for a Wireless LAN Connection (with the optional USB Wireless LAN Unit equipped) [WIRELESS LAN]

**Important**
- Consult with your network administrator about these settings.
- When using a wireless LAN connection, attach the optional USB Wireless LAN to the projector. (→ page 115)

<table>
<thead>
<tr>
<th>[PROFILE]</th>
<th>[DISABLE]</th>
<th>Wireless LAN connection will be turned off</th>
</tr>
</thead>
<tbody>
<tr>
<td>[SIMPLE ACCESS POINT]</td>
<td>Set the projector for simple access point. Selecting [SIMPLE ACCESS POINT] will allow the projector to create an infrastructure network. The IP address of the projector will be set automatically. Select &quot;Obtain an IP Address Automatically&quot; to set the IP address of a connected computer.</td>
<td></td>
</tr>
<tr>
<td>[PROFILE 1]</td>
<td>Up to two settings for the USB wireless LAN unit can be stored in memory of the projector. (→ page 48) To recall the settings from memory, select [PROFILE 1] or [PROFILE 2] from [PROFILE].</td>
<td></td>
</tr>
<tr>
<td>[PROFILE 2]</td>
<td></td>
<td></td>
</tr>
<tr>
<td>[RECONNECT]</td>
<td>Retry to connect the projector to a network. Try this if you have changed [PROFILE].</td>
<td></td>
</tr>
</tbody>
</table>

When you connect with your computer to save your profile and select "Automatically connect when within range" from the Properties tab of Wireless Network in Windows for your selected profile, your wireless LAN will be accessed under the following conditions:
- at the time of turning on the computer or the projector
- when the notebook type is within the range of the projector's wireless LAN can be achieved.

Data transmission between wireless LAN and wired LAN is not possible.

When the [SIMPLE ACCESS POINT] mode is used to send images, it is recommended to connect to only one computer.
### Hints on How to Set Up LAN Connection

**To set up the projector for a LAN connection:**
Access the HTTP server function to display the web browser (→ page 45) and select [NETWORK SETTINGS] → [SETTINGS] → [WIRELESS LAN] → [PROFILE 1] or [PROFILE 2].
Two settings can be set for the USB Wireless LAN Unit.
Next select [SETTINGS] for your selected profile, and set [ENABLE] or [DISABLE] for [DHCP], [IP ADDRESS], [SUBNET MASK], and [GATEWAY]. Last click [SAVE]. To reflect changes, click the [SETTING] tab and then click [APPLY]. (→ page 48)

**To recall LAN settings stored in the profile number:**
Use [PROFILE 1] or [PROFILE 2] set on the HTTP server, from the projector menu, select [SETUP] → [WIRELESS LAN] → [PROFILE] → [PROFILE 1] or [PROFILE 2]. Last select [YES] and press the ENTER button. (→ page 97)

**To connect a DHCP server:**
From the projector menu, select [SETUP] → [WIRED LAN] → [SETTINGS] → [DHCP] → [ON] and press the ENTER button. To specify IP address without using the DHCP server, use the HTTP server function. (→ page 96)

**To set only for wireless LAN (NETWORK TYPE and WEP/WPA):**
Access the HTTP server function to display the web browser (→ page 45) and select [NETWORK SETTINGS] → [SETTINGS] → [WIRELESS LAN] → [PROFILE 1] or [PROFILE 2].
Make necessary settings for [SETTINGS] and click [SAVE].
From the projector menu, select [SETUP] → [WIRELESS LAN] → [PROFILE] → [PROFILE 1] or [PROFILE 2].

**To select an SSID:**
Access the HTTP server function to display the web browser (→ page 45) and select [NETWORK SETTINGS] → [SETTINGS] → [WIRELESS LAN] → [CONNECTION] → [SITE SURVEY] and select the ID.
If you do not use [SITE SURVEY], type the SSID in [CONNECTION]. (→ page 48)

**To receive lamp replacement time or error messages via e-mail:**
Access the HTTP server function to display the web browser (→ page 45) and select [NETWORK SETTINGS] → [ALERT MAIL], and set [SNDER’S ADDRESS], [SMTP SERVER NAME], and [RECIPIENT’S ADDRESS]. Last, click [SAVE]. (→ page 50)
Menu Descriptions & Functions [INFO.]

Displays the status of the current signal and lamp usage. This item has six pages. The information included is as follows:

TIP: Pressing the HELP button on the remote control will show the [INFO.] menu items.

[USAGE TIME]

[LAMP LIFE REMAINING] (%)*
[LAMP HOURS USED] (H)
[FILTER HOURS USED] (H)
[TOTAL CARBON SAVINGS] (kg-CO2)
[TOTAL COST SAVINGS]

* The progress indicator shows the percentage of remaining bulb life.

The value informs you of the amount of lamp usage. When the remaining lamp time reaches 0, the LAMP LIFE REMAINING bar indicator changes from 0% to 100 Hours and starts counting down.

If the remaining lamp time reaches 0 hours, the projector will not turn on.

- The message to the effect that the lamp or the filters should be replaced will be displayed for one minute when the projector is turned on and when the POWER button on the projector or the remote control is pressed.

To dismiss this message, press any button on the projector or the remote control.

<table>
<thead>
<tr>
<th>Lamp life(H)</th>
<th>Replacement lamp</th>
<th>Model</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ECO MODE</td>
<td></td>
<td></td>
</tr>
<tr>
<td>OFF/AUTO ECO</td>
<td>NORMAL</td>
<td>ECO</td>
</tr>
<tr>
<td>3800</td>
<td>5000</td>
<td>6000</td>
</tr>
<tr>
<td>4000</td>
<td>5000</td>
<td>8000</td>
</tr>
<tr>
<td></td>
<td>NP33LP</td>
<td>UM351W/UM361X</td>
</tr>
<tr>
<td></td>
<td>NP32LP</td>
<td>UM301W/UM301X</td>
</tr>
</tbody>
</table>

- [TOTAL CARBON SAVINGS]

This displays the estimated carbon saving information in kg. The carbon footprint factor in the carbon saving calculation is based on the OECD (2008 Edition). (→ page 28)
### 5. Using On-Screen Menu

#### [SOURCE(1)]

<table>
<thead>
<tr>
<th>Source</th>
<th>Adjust</th>
<th>Setup</th>
<th>Info</th>
<th>Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SOURCE NAME</strong></td>
<td>1024x768</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SOURCE INDEX</strong></td>
<td>108</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>HORIZONTAL FREQUENCY</strong></td>
<td>48 [kHz]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>VERTICAL FREQUENCY</strong></td>
<td>60 [Hz]</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SYNC TYPE</strong></td>
<td>SEPARATE SYNC</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SYNC POLARITY</strong></td>
<td>H: (+) V: (-)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SCAN TYPE</strong></td>
<td>NON-INTERLACE</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### [SOURCE(2)]

<table>
<thead>
<tr>
<th>Source</th>
<th>Adjust</th>
<th>Setup</th>
<th>Info</th>
<th>Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SIGNAL TYPE</strong></td>
<td>RGB</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>VIDEO TYPE</strong></td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>BIT DEPTH</strong></td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>VIDEO LEVEL</strong></td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MHL SIGNAL</strong></td>
<td>---</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### [WIRED LAN]

<table>
<thead>
<tr>
<th>Source</th>
<th>Adjust</th>
<th>Setup</th>
<th>Info</th>
<th>Reset</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IP ADDRESS</strong></td>
<td>. .</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>SUBNET MASK</strong></td>
<td>. .</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>GATEWAY</strong></td>
<td>. .</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>MAC ADDRESS</strong></td>
<td>00:00:00:00:00:00</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- [SOURCE NAME]
- [HORIZONTAL FREQUENCY]
- [SYNC TYPE]
- [SCAN TYPE]
- [SOURCE INDEX]
- [VERTICAL FREQUENCY]
- [SYNC POLARITY]
- [SIGNAL TYPE]
- [VIDEO TYPE]
- [VIDEO LEVEL]
5. Using On-Screen Menu

[WIRELESS LAN]

<table>
<thead>
<tr>
<th>SOURCE</th>
<th>ADJUST</th>
<th>SETUP</th>
<th>INFO</th>
<th>RESET</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>WIRED LAN</td>
<td>WIRELESS LAN</td>
</tr>
</tbody>
</table>

- IP ADDRESS
- SUBNET MASK
- GATEWAY
- MAC ADDRESS
- SSID
- NETWORK TYPE
- WEP/WPA
- CHANNEL
- SIGNAL LEVEL

[VERSION]

<table>
<thead>
<tr>
<th>SOURCE</th>
<th>ADJUST</th>
<th>SETUP</th>
<th>INFO</th>
<th>RESET</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>WIRED LAN</td>
<td>WIRELESS LAN</td>
</tr>
</tbody>
</table>

- FIRMWARE 1.00
- DATA 1.00

[OTHERS]

<table>
<thead>
<tr>
<th>SOURCE</th>
<th>ADJUST</th>
<th>SETUP</th>
<th>INFO</th>
<th>RESET</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>WIRED LAN</td>
<td>WIRELESS LAN</td>
</tr>
</tbody>
</table>

- PROJECTOR NAME UM351 Series
- MODEL NO.
- SERIAL NUMBER
- LAN UNIT TYPE

[CONTROL ID] (when [CONTROL ID] is set)
Menu Descriptions & Functions [RESET]

Returning to Factory Default [RESET]
The RESET feature allows you to change adjustments and settings to the factory preset for a (all) source (s) except the following:

[CURRENT SIGNAL]
Resets the adjustments for the current signal to the factory preset levels.
The items that can be reset are: [PRESET], [CONTRAST], [BRIGHTNESS], [COLOR], [HUE], [SHARPNESS], [ASPECT RATIO], [HORIZONTAL], [VERTICAL], [CLOCK], [PHASE], and [OVERSCAN].

[ALL DATA]
Reset all the adjustments and settings for all the signals to the factory preset.
All items can be reset EXCEPT [LANGUAGE], [BACKGROUND], [FILTER MESSAGE], [SECURITY], [COMMUNICATION SPEED], [CONTROL ID], [STANDBY MODE], [FAN MODE], [LAMP LIFE REMAINING], [LAMP HOURS USED], [FILTER HOURS USED], [TOTAL CARBON SAVINGS], [WIRED LAN], and [WIRELESS LAN].
To reset the lamp usage time, see “Clearing Lamp Hour Meter [CLEAR LAMP HOURS]” below.

Clearing Lamp Hour Meter [CLEAR LAMP HOURS]
Resets the lamp clock back to zero. Selecting this option displays submenu for a confirmation. Select [YES] and press the ENTER button.

NOTE: Elapsed time of the lamp use will not be affected even when [RESET] is done from the menu.

NOTE: The projector will turn off and go into standby mode when you continue to use the projector for another 100 hours after the lamp has reached the end of its life. In this condition you cannot clear the lamp hour meter on the menu. If this happens, press the HELP button on the remote control for 10 seconds to reset the lamp clock back to zero. Do this only after replacing the lamp.

Clearing the Filter Usage Hours [CLEAR FILTER HOURS]
Resets the filter usage back to zero. Selecting this option displays submenu for a confirmation. Select [YES] and press the ENTER button.

NOTE: Elapsed time of the filter use will not be affected even when [RESET] is done from the menu.
6. Installation and Connections

1 Setting Up the Screen and the Projector

[UM361X/UM301X]

The further your projector is from the screen or wall, the larger the image. The minimum size the image can be is 61.5” (1562 mm) measured diagonally when the projector is 4 inches (105 mm) between the screen side of the projector and the wall or screen. The largest the image can be is 116.6” (2962 mm) when the projector is 20 inches (510 mm) between the screen side of the projector and the wall or screen.

[UM361X/UM301X]

<table>
<thead>
<tr>
<th>Screen Size</th>
<th>H1</th>
<th>H2</th>
<th>L1</th>
<th>L2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagonal</td>
<td>Width</td>
<td>Height</td>
<td>inch</td>
<td>mm</td>
</tr>
<tr>
<td>61.5</td>
<td>49</td>
<td>1250</td>
<td>37</td>
<td>937</td>
</tr>
<tr>
<td>70</td>
<td>56</td>
<td>1422</td>
<td>42</td>
<td>1067</td>
</tr>
<tr>
<td>80</td>
<td>64</td>
<td>1626</td>
<td>48</td>
<td>1219</td>
</tr>
<tr>
<td>90</td>
<td>72</td>
<td>1829</td>
<td>54</td>
<td>1372</td>
</tr>
<tr>
<td>100</td>
<td>80</td>
<td>2032</td>
<td>60</td>
<td>1524</td>
</tr>
<tr>
<td>110</td>
<td>88</td>
<td>2235</td>
<td>66</td>
<td>1676</td>
</tr>
<tr>
<td>116.6</td>
<td>93</td>
<td>2369</td>
<td>70</td>
<td>1777</td>
</tr>
</tbody>
</table>

NOTE:
- The above figures are design values and may vary.
6. Installation and Connections

The further your projector is from the screen or wall, the larger the image. The minimum size the image can be is 58” (1473 mm) measured diagonally when the projector is 4 inches (105 mm) between the screen side of the projector and the wall or screen. The largest the image can be is 110” (2794 mm) when the projector is 20 inches (510 mm) between the screen side of the projector and the wall or screen.

<table>
<thead>
<tr>
<th>Screen Size</th>
<th>Diagonal Width</th>
<th>Height</th>
<th>H1 width</th>
<th>H2 width</th>
<th>L1 width</th>
<th>L2 width</th>
</tr>
</thead>
<tbody>
<tr>
<td>inch</td>
<td>mm</td>
<td>inch</td>
<td>mm</td>
<td>inch</td>
<td>mm</td>
<td>inch</td>
</tr>
<tr>
<td>58</td>
<td>1473</td>
<td>49</td>
<td>1249</td>
<td>31</td>
<td>781</td>
<td>9</td>
</tr>
<tr>
<td>60</td>
<td>1524</td>
<td>51</td>
<td>1292</td>
<td>32</td>
<td>808</td>
<td>10</td>
</tr>
<tr>
<td>70</td>
<td>1778</td>
<td>59</td>
<td>1508</td>
<td>37</td>
<td>942</td>
<td>11</td>
</tr>
<tr>
<td>80</td>
<td>2032</td>
<td>68</td>
<td>1723</td>
<td>42</td>
<td>1077</td>
<td>11</td>
</tr>
<tr>
<td>90</td>
<td>2286</td>
<td>76</td>
<td>1939</td>
<td>48</td>
<td>1212</td>
<td>12</td>
</tr>
<tr>
<td>100</td>
<td>2540</td>
<td>85</td>
<td>2154</td>
<td>53</td>
<td>1346</td>
<td>13</td>
</tr>
<tr>
<td>110</td>
<td>2794</td>
<td>93</td>
<td>2369</td>
<td>58</td>
<td>1481</td>
<td>14</td>
</tr>
</tbody>
</table>

[UM351W/UM301W]

---

**Screen Size (diagonal)**

**Screen width**

**Center of screen**

**Projector bottom**

**Screen side of projector**

**Center of projection window**

---

**Screen size (inch)**

**Diagonal**

**Height**

**L1/L2 (cm)**

---

104
6. Installation and Connections

WARNING

* Installing your projector on the ceiling must be done by a qualified technician. Contact your NEC dealer for more information.
* Do not attempt to install the projector yourself.
  • Only use your projector on a solid, level surface. If the projector falls to the ground, you can be injured and the projector severely damaged.
  • Do not use the projector where temperatures vary greatly. The projector must be used at temperatures between 41°F (5°C) and 104°F (40°C) (Eco mode selected automatically at 95°F to 104°F/35°C to 40°C).
  • Do not expose the projector to moisture, dust, or smoke. This will harm the screen image.
  • Ensure that you have adequate ventilation around your projector so heat can dissipate. Do not cover the vents on the side or the front of the projector.

Reflecting the Image

Using a mirror to reflect your projector's image enables you to enjoy a much larger image when a smaller space is required. Contact your NEC dealer if you need a mirror system. If you're using a mirror system and your image is inverted, use the MENU and ▲▼◄► buttons on your projector cabinet or your remote control to correct the orientation. (→ page 90)
# Connecting Your Computer

Computer cables, HDMI and USB can be used to connect to a computer. The connection cable is not enclosed with the projector. Please get ready a suitable cable for the connection.

---

**NOTE:** Signals supported by Plug & Play (DDC2)

<table>
<thead>
<tr>
<th>INPUT</th>
<th>COMPUTER IN</th>
<th>HDMI 1/MHL IN</th>
<th>HDMI 2 IN</th>
</tr>
</thead>
<tbody>
<tr>
<td>analog</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>digital</td>
<td>Yes</td>
<td>digital</td>
<td></td>
</tr>
</tbody>
</table>

---

- **HDMI cable (not supplied)**
  - Use High Speed HDMI® Cable.

- **A commercially available USB cable (compatible with USB 2.0 specifications)**
- **Stereo mini-plug audio cable (not supplied)**
- **Computer cable (VGA) (supplied)**
  - To mini D-Sub 15-pin terminal on the projector. It is recommended that you use a commercially available distribution amplifier if connecting a signal cable longer than the cable supplied.

---

* Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPUTER IN</td>
<td>🌐 COMPUTER</td>
<td>(COMPUTER 1)</td>
</tr>
<tr>
<td>HDMI 1/MHL IN</td>
<td>🌐 HDMI 1/MHL</td>
<td>(HDMI 1/MHL*)</td>
</tr>
<tr>
<td>HDMI 2 IN</td>
<td>🌐 HDMI 2</td>
<td>(HDMI 2*)</td>
</tr>
<tr>
<td>USB (PC)</td>
<td>🌐 USB-B</td>
<td>(USB-B)</td>
</tr>
</tbody>
</table>

---

*NOTE:* For Mac, use a commercially available pin adapter (not supplied) to connect to your Mac’s video port.
6. Installation and Connections

NOTE: The projector is not compatible with video decoded outputs of the NEC ISS-6020 switcher.

NOTE: An image may not be displayed correctly when a Video source is played back via a commercially available scan converter. This is because the projector will process a video signal as a computer signal at the default setting. In that case, do the following.

* When an image is displayed with the lower and upper black portion of the screen or a dark image is not displayed correctly:
  - Project an image to fill the screen and then press the AUTO ADJ. button on the remote control or the projector cabinet.

Enabling the computer's external display
Displaying an image on the notebook PC's screen does not necessarily mean it outputs a signal to the projector. When using a PC compatible laptop, a combination of function keys will enable/disable the external display. Usually, the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through external display selections.

Cautions when using a DVI signal

- When the computer has a DVI output connector, use a commercially available converter cable to connect the computer to the projector's HDMI 1/MHL or HDMI 2 input connector (only digital video signals can be input).

NOTE: When Viewing a DVI Digital Signal

- Turn off the power of the computer and projector before connecting.
- When a video deck is connected via a scan converter, etc., the display may not be correct during fast-forwarding and rewinding.
- Use a DVI-to-HDMI cable compliant with DDWG (Digital Display Working Group) DVI (Digital Visual Interface) revision 1.0 standard.
  - The cable should be within 197’/5 m long.
- Turn off the projector and the PC before connecting the DVI-to-HDMI cable.
- To project a DVI digital signal: Connect the cables, turn the projector on, then select the HDMI input. Finally, turn on your PC. Failure to do so may not activate the digital output of the graphics card resulting in no picture being displayed. Should this happen, restart your PC.
- Do not disconnect the DVI-to-HDMI cable while the projector is running. If the signal cable has been disconnected and then reconnected, an image may not be correctly displayed. Should this happen, restart your PC.
- The COMPUTER video input connectors support Windows Plug and Play.
- A Mac signal adapter (commercially available) may be required to connect a Mac computer.
Connecting an External Monitor

You can connect a separate, external monitor to your projector to simultaneously view on a monitor the computer analog image you’re projecting.

NOTE:
- When audio equipment is connected, the projector speaker is disabled.
- The signal output from the MONITOR OUT (COMPUTER) of this projector is for projecting image on exclusive one display.
- When no signal is applied over 3 minutes in the condition of projector standby when NETWORK STANDBY is set in the Standby mode, output from the MONITOR OUT or AUDIO OUT terminal will be stopped. In this case pull out the computer cable and set it back after inputting video signal
- Monitor out and sleep mode:
  - The MONITOR OUT (COMP.) connector will not work when [NORMAL] is selected for [STANDBY MODE]. The MONITOR OUT (COMP.) connector will work only in the sleep mode.
  - Applying a signal from the COMPUTER IN connector will put the projector in the sleep mode, which allows you to use the MONITOR OUT(COMP.) connector and the AUDIO OUT mini jack. Sound from the MIC input jack will be output to the AUDIO OUT mini jack.
  - The sleep mode is one of the standby modes. The sleep mode cannot be selected from the menu.
- In the network standby mode, sound for the last viewed computer or video source will be heard.
  - BNC-to- COMPUTER IN terminal converted signal will not be output in the standby mode and sleep mode.
Connecting Your DVD Player or Other AV Equipment

Connecting Video Input

- Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIDEO IN</td>
<td>➤ VIDEO</td>
<td>(VIDEO)</td>
</tr>
</tbody>
</table>

NOTE: Refer to your VCR owner’s manual for more information about your equipment’s video output requirements.

NOTE: An image may not be displayed correctly when a Video source is played back in fast-forward or fast-rewind via a scan converter.
Connecting Component Input

A component signal will be automatically displayed. If not, from the menu, select [SETUP] → [OPTIONS(1)] → [SIGNAL SELECT] → [COMPUTER], and then place a check mark in the Component radio button.

- Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPUTER IN</td>
<td>COMPUTER</td>
<td>(COMPUTER 1)</td>
</tr>
</tbody>
</table>

NOTE: Refer to your DVD player’s owner’s manual for more information about your DVD player’s video output requirements.
Connecting HDMI Input

You can connect the HDMI output of your DVD player, hard disk player, Blu-ray player, or notebook type PC to the HDMI IN terminal of your projector.

- Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI 1/MHL IN</td>
<td>HDMI1/MHL</td>
<td>(HDMI1/MHL*)</td>
</tr>
<tr>
<td>HDMI 2 IN</td>
<td>HDMI2</td>
<td>(HDMI2*)</td>
</tr>
</tbody>
</table>

- When connecting the HDMI1/MHL IN terminal (or HDMI2 terminal) of the projector to the DVD player, the projector's video level can be made settings in accordance with the DVD player's video level. In the menu select [HDMI SETTINGS] → [VIDEO LEVEL] and make necessary settings.

- If the HDMI input sound cannot be heard, in the menu select [AUDIO SELECT] → [HDMI1/MHL] or [HDMI2]. (→ page 93)
6. Installation and Connections

Connecting a smart phone and a tablet terminal

The below mentioned feature is available when the projector is connected with MHL supported devices such as a smart phone and a tablet terminal by a MHL cable (not supplied)

- Projecting an image and a file on the MHL supported devices.
- Output sound on the MHL supported devices from the build-in speaker.
- Charge the MHL supported devices.
- Operate the MHL supported devices by the remote control for the projector.
- Operate the projector by the MHL supported devices

• Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI 1/MHL IN</td>
<td>[HDMI1/MHL]</td>
<td>(HDMI1/MHL*)</td>
</tr>
</tbody>
</table>

NOTE:

- Please use the MHL cable (not supplied) that meets the standard. If the cable that does not meet the standard is used, it may be cause of fire, injury or damage of property around during charging the MHL supported devices.
- If MHL-HDMI adaptor is used, it may disable to charge/operate the MHL supported devices by the remote control of the projector.
- If image can not be projected correctly, pull out the MHL cable once and put it back again.
- Depending on types and setting of smart phones and tablets, image may not be projected correctly.

Information

- In the below mentioned conditions, the MHL supported devices are not charged
  - When the projector is in STANDBY mode
  - When the MHL supported devices are discharged completely.
  - When supply current is over consumption current.
Connecting your document camera
You can connect your document camera and project printed documents, etc.

Name, position, and direction of terminals are vary depending on camera model. Please check user's manual of your camera for details.

Computer cable (VGA) (supplied)

Video cable (not supplied)

• Select the source name for its appropriate input terminal after turning on the projector.

<table>
<thead>
<tr>
<th>Input terminal</th>
<th>SOURCE button on the projector cabinet</th>
<th>Button on the remote control</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMPUTER IN</td>
<td>🖥 COMPUTER</td>
<td>(COMPUTER 1)</td>
</tr>
<tr>
<td>VIDEO IN</td>
<td>🎥 VIDEO</td>
<td>(VIDEO)</td>
</tr>
</tbody>
</table>

Table projection
Installing the projector in vertical position, it able to project images onto the ceiling, the table and the floor. Make sure to install the projector with the table projection mount (NP01TK sold separately).
Connecting to a Wired LAN

The projector comes standard with a LAN port (RJ-45) which provides a LAN connection using a LAN cable. To use a LAN connection, you are required to set the LAN on the projector menu. Select [SETUP] → [WIRED LAN]. (→ page 96).

Example of LAN connection

Example of wired LAN connection

NOTE: Use a Category 5 or higher LAN cable.
Connecting to a Wireless LAN (Optional: NP05LM series)

The USB Wireless LAN Unit also provides a wireless LAN connection. To use a wireless LAN connection, you are required to assign an IP address to the projector.

Important:
- If you use the projector with the USB Wireless LAN Unit in the area where the use of wireless LAN equipment is prohibited, remove the USB Wireless LAN Unit from the projector.
- Buy the appropriate USB Wireless LAN Unit for your country or area.

NOTE:
- The green LED on the USB Wireless LAN Unit flashes to show that the USB Wireless LAN Unit is working.
- Your computer’s wireless LAN adapter (or unit) must be complied with Wi-Fi (IEEE802.11b/g/n) standard.

Flow of Setting Wireless LAN

Step 1: Attach the USB Wireless LAN Unit to the projector.
Step 2: Connect the computer to the projector via wired LAN. (→ page 114)
  Use the computer’s browser to display the projector’s HTTP server. (→ page 45)
Step 3: Use an HTTP server to set the wireless LAN. (→ page 48)
  Access the HTTP server function to set [NETWORK SETTINGS] → [SETTINGS] → [WIRELESS] → [SIMPLE ACCESS POINT], [PROFILE1] or [PROFILE2].

NOTE:
- To use the HTTP server function, the projector must be connected to a network.
  First use the wired LAN to connect the projector to a network and then use the HTTP server to set the wireless LAN.
- After setting the wireless LAN by using the HTTP server, set [NETWORK SETTINGS] → [SETTINGS] → [WIRED] → [DISABLE]

When switching to set on the projector after connecting to the wireless LAN:
Use the menu to set the wireless LAN connection for the projector.
(→ page 97)
Select [DISABLE], [SIMPLE ACCESS POINT], [PROFILE1] or [PROFILE2] you set from the HTTP server.

Attaching the USB Wireless LAN Unit

NOTE:
- The USB Wireless LAN Unit must be inserted into the USB Wireless LAN Unit port in the correct direction. It cannot be inserted in the reverse direction. If the USB Wireless LAN Unit is inserted in the reverse direction with excessive force applied, the USB port may break.
- Before touching the USB Wireless LAN Unit, touch a metallic object (such as a door knob or aluminum window frame) to discharge the static electricity from your body.
- Always insert or remove the USB Wireless LAN unit when the main power is turned off. Failure to do so may cause projector malfunction or damage to the USB wireless LAN unit. If the projector will not work correctly, turn off the projector, disconnect the power cord, and then connect it again.
- Do not insert other USB devices into the USB Wireless LAN unit port. Do not insert the USB Wireless LAN unit into the USB (PC) port (Type B).
NOTE: When the cable cover is attached, remove it before inserting the USB Wireless LAN Unit.

1. Press the POWER button to turn off the projector and set it into standby condition, and disconnect the power cord.

2. Slowly insert the USB Wireless LAN Unit into the USB (WLAN) port.

   Remove the cap from the USB Wireless LAN Unit, and then insert it with the surface (side of indicator) facing outward. Keep the cap for later use.

   NOTE: Do not force to insert the USB Wireless LAN Unit.

To remove the USB Wireless LAN Unit, disconnect the power cord and use the above procedure.

NOTE:

• The green LED on the USB Wireless LAN Unit flashes to show that Wireless LAN Unit is working. If the USB Wireless LAN Unit is incorrectly attached, the blue LED will not flash.

• Do not press the button on the USB Wireless LAN Unit. The button will not work with this model.
Example of wireless LAN connection
(Network Type → Wireless LAN PROFILE 1 or PROFILE 2)
This section describes the simple maintenance procedures you should follow to clean the filters, the projection window, the cabinet, and to replace the lamp and the filters.

## 1 Cleaning the Filters

The air-filter sponge keeps dust and dirt from getting inside the projector and should be frequently cleaned. If the filter is dirty or clogged, your projector may overheat.

**WARNING**
- Do not use a spray containing flammable gas to get rid of accumulated dust and dirt on the filters. It may cause fire.

**NOTE:** The message for filter cleaning will be displayed for one minute after the projector is turned on or off. When the message is displayed, clean the filters. The time to clean the filters is set to [5000 H] at time of shipment. To cancel the message, press any button on the projector cabinet or the remote control.

The two-layer filter on the projector improves cooling and dust-proof capabilities. The outsides (intake side) of the first and second layer filters remove dust. To clean the filter, detach the filter unit and the filter cover.

**CAUTION**
- Before cleaning the filters, turn off the projector, disconnect the power cord and then allow the cabinet to cool. Failure to do so can result in electric shock or burn injuries.

1. Push the button rightward to release the filter cover and pull it out.

2. Remove the two filter cases.
3. Remove the four filters and use a vacuum cleaner to vacuum all the dust inside and outside.

Get rid of dust in the sponge filter

NOTE:
- Whenever you vacuum the filter, use the soft brush attachment to vacuum. This is to avoid damage to the filter.
- Do not wash the filter with water. Doing so can result in filter clogging.

4. Remove dust from the filter cover and the two filter cases (large and small).

Clean both outside and inside.

5. Attach the four filters to two filter cases (large and small).

- Attach the coarse-texture sponge filter to the outside of filter case. The coarse-texture sponge filter has slits on it. Align these slits with the protrusions of the filter case.
- Attach the fine-texture sponge filter to the inside of the filter case.
6. **Insert the large filter case into the projector cabinet.**
   Make sure that the filter case is inserted in the correct orientation.

7. **Put the small filter case to the projector cabinet.**
   Make sure that the filter case is inserted in the correct orientation.

8. **Put the filter cover back to the projector cabinet.**
   Insert two catches of the tip of the filter cover into the groove of the cabinet, and push the button to close the filter cover.
   - If you find it to hard to close the filter cover, try pushing the hook.

9. **Clear the filter usage hours.**
   Plug the power cord into the wall outlet, and then turn on the projector.
   From the menu, select [RESET] → [CLEAR FILTER HOURS]. (→ page 102)
   The interval time to clean the filters is set to [OFF] at time of shipment. When using the projector as it is, you do not clear the filter usage.
2 Cleaning the Projection Window

- Turn off the projector before cleaning.
- Do not scratch or mar the projection window as it is made of glass.
- Use a blower or lens paper to clean the projection window, and be careful not to scratch or mar the glass surface.

**WARNING**

- Do not use a spray containing flammable gas to get rid of accumulated dust and dirt on the projection window. It may cause of fire.

3 Cleaning the Cabinet

Turn off the projector, and unplug the projector before cleaning.

- Use a dry soft cloth to wipe dust off the cabinet.
  
  If heavily soiled, use a mild detergent.
- Never use strong detergents or solvents such as alcohol or thinner.
- When cleaning the vents or the speaker using a vacuum cleaner, do not force the brush of the vacuum cleaner into the slits of the cabinet.

**NOTE:**

Do not apply volatile agent such as insecticide on the cabinet, the projection window, or the screen. Do not leave a rubber or vinyl product in prolonged contact with it. Otherwise the surface finish will be deteriorated or the coating may be stripped off.
Replacing the Lamp and the Filters

When the lamp reaches the end of its life, the LAMP indicator in the cabinet will blink red and the message “THE LAMP HAS REACHED THE END OF ITS USABLE LIFE. PLEASE REPLACE THE LAMP AND FILTER.” will appear (*). Even though the lamp may still be working, replace the lamp to maintain the optimal projector performance. After replacing the lamp, be sure to clear the lamp hour meter. (→ page 102)

<table>
<thead>
<tr>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>• DO NOT TOUCH THE LAMP immediately after it has been used. It will be extremely hot. Turn the projector off and then disconnect the power cord. Allow at least one hour for the lamp to cool before handling.</td>
</tr>
</tbody>
</table>

- Use the specified lamp for safety and performance.

To order the replacement lamp, specify your lamp type.

Replacement lamp:

- NP33LP: UM351W/UM361X
- NP32LP: UM301W/UM301X

The replacement lamp comes with filters. While the filters attached to the projector at the time of purchase are made of dark sponge material, the filters included with the optional lamp are made of non-woven white material. There is no difference in performance between these two types.

- DO NOT REMOVE ANY SCREWS except one lamp cover screw and two lamp housing screws. You could receive an electric shock.

- Do not break the glass on the lamp housing.

Keep finger prints off the glass surface on the lamp housing. Leaving finger prints on the glass surface might cause an unwanted shadow and poor picture quality.

- The projector will turn off and go into standby mode when you continue to use the projector for another 100 hours after the lamp has reached the end of its life. If this happens, be sure to replace the lamp. If you continue to use the lamp after the lamp reaches the end of its life, the lamp bulb may shatter, and pieces of glass may be scattered in the lamp case. Do not touch them as the pieces of glass may cause injury. If this happens, contact your NEC dealer for lamp replacement.

*NOTE: This message will be displayed under the following conditions:
- for one minute after the projector has been powered on
- when the (POWER) button on the projector cabinet or the STANDBY button on the remote control is pressed

To turn off the message, press any button on the projector cabinet or the remote control.

Optional lamp and tools needed for replacement:

- Phillips screwdriver (plus-head)
- Replacement lamp

Flow of Replacing the Lamp and the Filters

**Step 1.** Replace the lamp

**Step 2.** Replace the filters (→ page 125)

**Step 3.** Clear the lamp usage hours and the filter usage hours (→ page 102)
To replace the lamp:

1. Remove the lamp cover.
   (1) Loosen the lamp cover screw
   • The lamp cover screw is not removable.
   (2) Push and slide the lamp cover off.

2. Remove the lamp housing.
   (1) Loosen the two screws securing the lamp housing until the phillips screwdriver goes into a freewheeling condition.
   • The two screws are not removable.
   • There is an interlock on this case to prevent the risk of electrical shock. Do not attempt to circumvent this interlock.
   (2) Remove the lamp housing by holding it.

CAUTION:
Make sure that the lamp housing is cool enough to before removing it.
3. **Install a new lamp housing.**
   (1) Insert a new lamp housing until the lamp housing is plugged into the socket.
   (2) Push the top center of the lamp housing to secure it.
   (3) Secure it in place with the two screws.
   • Be sure to tighten the screws.

4. **Reattach the lamp cover.**
   (1) Slide the lamp cover back until it snaps into place.
   (2) Tighten the screw to secure the lamp cover.
   • Be sure to tighten the screw.

---

**This completes the lamp replacement.**
**Go on to the filter replacement.**

**NOTE:** When you continue to use the projector for another 100 hours after the lamp has reached the end of its life, the projector cannot turn on and the menu is not displayed.
If this happens, press the HELP button on the remote control for 10 seconds to reset the lamp clock back to zero.
When the lamp time clock is reset to zero, the LAMP indicator goes out.
7. Maintenance

To replace the filters:

**NOTE:**
- Replace all four filters at the same time.
- Before replacing the filters, wipe off dust and dirt from the projector cabinet.
- The projector is precision equipment. Keep out dust and dirt during filter replacement.
- Do not wash the filters with soap and water. Soap and water will damage the filter membrane.
- Put filters into place. Incorrect attachment of a filter may cause dust and dirt to get into the inside of the projector.

Before replacing the filters, replace the lamp. (→ page 122)

1. **Push the button rightward to release the filter cover and pull it out.**

2. **Remove the two filter cases.**

Small filter case     Large filter case
3. Remove the four filters and use a vacuum cleaner to vacuum all the dust inside and outside.

Get rid of dust in the sponge filter

**NOTE:**
- Whenever you vacuum the filter, use the soft brush attachment to vacuum. This is to avoid damage to the filter.
- Do not wash the filter with water. Doing so can result in filter clogging.

4. Remove dust from the filter cover and the two filter cases (large and small).

Clean both outside and inside.

5. Attach the four filters to two filter cases (large and small).

- Attach the coarse-texture sponge filter to the outside of filter case.
  The coarse-texture sponge filter has slits on it. Align these slits with the protrusions of the filter case.
- Attach the fine-texture sponge filter to the inside of the filter case.
6. Insert the large filter case into the projector cabinet.
   Make sure that the filter case is inserted in the correct orientation.

7. Put the small filter case to the projector cabinet.
   Make sure that the filter case is inserted in the correct orientation.

8. Put the filter cover back to the projector cabinet.
   Insert two catches of the tip of the filter cover into the groove of the cabinet, and push the button to close the filter cover.
   • If you find it to hard to close the filter cover, try pushing the hook.

This completes the filter replacement.
Go on to the clearing lamp and filter hour meters.

To clear the lamp usage hours and the filter usage hours:
1. Place the projector where you use it.
2. Plug the power cord into the wall outlet, and then turn on the projector.
3. Clear the lamp usage hours and the filter usage hours.
   1. From the menu, select [RESET] → [CLEAR LAMP HOURS] and reset the lamp usage hours.
   2. Select [CLEAR FILTER HOURS]. and reset the filter usage hours. (→ page 102)
8. Appendix

1 Troubleshooting

This section helps you resolve problems you may encounter while setting up or using the projector.

Indicator Messages

Power Indicator

<table>
<thead>
<tr>
<th>Indicator Condition</th>
<th>Projector Condition</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>The main power is off</td>
<td>–</td>
</tr>
<tr>
<td>Blinking light Blue 0.5 sec On, 0.5 sec Off</td>
<td>The projector is getting ready to turn on.</td>
<td>Wait for a moment.</td>
</tr>
<tr>
<td>2.5 sec On, 0.5 sec Off</td>
<td>Off Timer is enabled.</td>
<td>–</td>
</tr>
<tr>
<td>Orange</td>
<td>Cooling</td>
<td>Wait for a moment</td>
</tr>
</tbody>
</table>

Steady light

<table>
<thead>
<tr>
<th>Indicator Condition</th>
<th>Projector Condition</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue</td>
<td>The projector is turned on.</td>
<td>–</td>
</tr>
<tr>
<td>Orange</td>
<td>In Standby condition [NETWORK STANDBY] is selected for [STANDBY MODE]</td>
<td>–</td>
</tr>
<tr>
<td>Red</td>
<td>In Standby condition [NORMAL] is selected for [STANDBY MODE]</td>
<td>–</td>
</tr>
</tbody>
</table>

Status Indicator

<table>
<thead>
<tr>
<th>Indicator Condition</th>
<th>Projector Condition</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Normal or Standby</td>
<td>–</td>
</tr>
<tr>
<td>Blinking light Red 1 cycle (0.5 sec On, 2.5 sec Off)</td>
<td>Lamp cover error or lamp housing error</td>
<td>Mount the lamp cover or lamp housing correctly.</td>
</tr>
<tr>
<td>2 cycle (0.5 sec On, 0.5 sec Off)</td>
<td>Temperature error</td>
<td>The projector is overheated. Move the projector to a cooler location.</td>
</tr>
<tr>
<td>3 cycle (0.5 sec On, 0.5 sec Off)</td>
<td>Power error</td>
<td>Power unit is not working properly. Contact your dealer.</td>
</tr>
<tr>
<td>4 cycle (0.5 sec On, 0.5 sec Off)</td>
<td>Fan error</td>
<td>Fans will not work correctly.</td>
</tr>
<tr>
<td>6 cycle (0.5 sec On, 0.5 sec Off)</td>
<td>Lamp error</td>
<td>Lamp fails to light. Wait a full minute and then turn on again.</td>
</tr>
<tr>
<td>Orange 1 cycle (0.5 sec On, 2.5 sec Off)</td>
<td>Network conflict</td>
<td>Both the built-in wired LAN and the wireless LAN cannot be connected to the same network at the same time. To use both built-in wired LAN and wireless LAN at the same time, connect them to different networks. <strong>NOTE:</strong> In the Standby condition, the status indicator on the cabinet does not blink in orange even if the network conflicts</td>
</tr>
<tr>
<td>Green</td>
<td>Re-firing the lamp (The projector is cooling down.)</td>
<td>The projector is re-firing. Wait for a moment.</td>
</tr>
</tbody>
</table>

Steady light

<table>
<thead>
<tr>
<th>Indicator Condition</th>
<th>Projector Condition</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Sleep mode</td>
<td>–</td>
</tr>
<tr>
<td>Orange</td>
<td>CONTROL PANEL LOCK is on.</td>
<td>You have pressed cabinet button when Control Panel Lock is on.</td>
</tr>
<tr>
<td>CONTROL ID error</td>
<td>Remote control ID and projector ID are not matched.</td>
<td>–</td>
</tr>
</tbody>
</table>

Lamp Indicator

<table>
<thead>
<tr>
<th>Indicator Condition</th>
<th>Projector Condition</th>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Normal</td>
<td>–</td>
</tr>
<tr>
<td>Blinking light Red</td>
<td>Lamp has reached its end of life. Lamp replace-ment message will be displayed.</td>
<td>Replace the lamp.</td>
</tr>
<tr>
<td>Steady light Red</td>
<td>Lamp has been used beyond its limit. The projector will not turn on until the lamp is replaced.</td>
<td>Replace the lamp.</td>
</tr>
<tr>
<td>Green</td>
<td>[ECO MODE] is set to [NORMAL] or [ECO]</td>
<td>–</td>
</tr>
</tbody>
</table>

Over-Temperature Protection

If the temperature inside the projector rises too high, the over-temperature protector will automatically turn off the lamp with the STATUS indicator blinking (2-cycle On and Off.)

Should this happen, do the following:
- Unplug the power cord after the cooling fans stop.
- Move the projector to a cooler location if the room where you are presenting is particularly too warm.
- Clean the vents if they are clogged with dust.
- Wait about 60 minutes until the inside of the projector becomes cool enough.
<table>
<thead>
<tr>
<th>Problem</th>
<th>Check These Items</th>
</tr>
</thead>
</table>
| Does not turn on or shut down | • Check that the power cord is plugged in and that the power button on the projector cabinet or the remote control is on. (→ pages 13, 14)  
  • Ensure that the lamp cover is installed correctly. (→ page 124)  
  • Check to see if the projector has overheated. If there is insufficient ventilation around the projector or if the room where you are presenting is particularly warm, move the projector to a cooler location.  
  • Check to see if you continue to use the projector for another 100 hours after the lamp has reached the end of its life. If so, replace the lamp. After replacing the lamp, reset the lamp hours used. (→ page 122)  
  • The lamp may fail to light. Wait a full minute and then turn on the power again.  
  • Set [FAN MODE] to [HIGH ALTITUDE] when using the projector at altitudes approximately 5500 feet/1700 meters or higher. Using the projector at altitudes approximately 5500 feet/1700 meters or higher without setting to [HIGH ALTITUDE] can cause the projector to overheat and the projector could shut down. If this happens, wait a couple minutes and turn on the projector. (→ page 92)  
  If you turn on the projector immediately after the lamp is turned off, the fans run without displaying an image for some time and then the projector will display the image. Wait for a moment. |
| Will turn off | • Ensure that the [OFF TIMER] or [AUTO POWER OFF] is off. (→ page 88, 95) |
| No picture | • Use the COMPUTER1, HDMI1/MHL, HDMI2, VIDEO, USB-A, USB-B or LAN button on the remote control to select your source (COMPUTER, HDMI1/MHL, HDMI2, VIDEO, USB-A, LAN or USB-B). (→ page 16) If there is still no picture, press the button again.  
  • Ensure your cables are connected properly.  
  • Use menus to adjust the brightness and contrast. (→ page 80)  
  • Reset the settings or adjustments to factory preset levels using the [RESET] in the Menu. (→ page 102)  
  • Enter your registered keyword if the Security function is enabled. (→ page 33)  
  • Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on the power to the notebook PC.  
  In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered up.  
  * If the screen goes blank while using your remote control, it may be the result of the computer’s screen-saver or power management software.  
  • See also the next page. |
| Picture suddenly becomes dark | • Check if the projector is in the Forced ECO mode because of too high ambient temperature. If this is the case, lower the internal temperature of the projector by selecting [HIGH] for [FAN MODE]. (→ page 92) |
| Color tone or hue is unusual | • Check if an appropriate color is selected in [WALL COLOR]. If so, select an appropriate option. (→ page 87)  
  • Adjust [HUE] in [PICTURE]. (→ page 80) |
| Image isn’t square to the screen | • Reposition the projector to improve its angle to the screen. (→ page 17, 18)  
  • Use the Keystone correction function to correct the trapezoid distortion. (→ page 21) |
| Picture is blurred | • Adjust the focus. (→ page 18)  
  • Reposition the projector to improve its angle to the screen. (→ page 17, 18)  
  • Ensure that the distance between the projector and screen is within the adjustment range of the projection window. (→ page 103, 104)  
  • Condensation may form on the lens if the projector is cold, brought into a warm place and is then turned on. Should this happen, let the projector stand until there is no condensation on the lens. |
| Flicker appears on screen | • Set [FAN MODE] to other than [HIGH ALTITUDE] mode when using the projector at altitudes approximately 5500 feet/1700 meters or lower. Using the projector at altitudes less than approximately 5500 feet/1700 meters and setting to [HIGH ALTITUDE] can cause the lamp to overcool, causing the image to flicker. Switch [FAN MODE] to [AUTO]. (→ page 92) |
| Image is scrolling vertically, horizontally or both | • Check the computer’s resolution and frequency. Make sure that the resolution you are trying to display is supported by the projector. (→ page 139)  
  • Adjust the computer image manually with the Horizontal/Vertical in the [IMAGE OPTIONS]. (→ page 82) |
| Remote control does not work | • Install new batteries. (→ page 10)  
  • Make sure there are no obstacles between you and the projector.  
  • Stand within 22 feet (7 m) of the projector. (→ page 10) |
| Indicator is lit or blinking | • See the POWER/STATUS/LAMP Indicator. (→ page 128) |
| Cross color in RGB mode | • Press the AUTO ADJ. button on the projector cabinet or the remote control. (→ page 23)  
  • Adjust the computer image manually with [CLOCK]/[PHASE] in [IMAGE OPTIONS] in the menu. (→ page 81) |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Check These Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mic sound is not heard</td>
<td>• Check if your microphone cable is connected to the MIC input jack correctly.</td>
</tr>
<tr>
<td></td>
<td>• Check if selection of microphone type in the installation menu is correct.</td>
</tr>
<tr>
<td>Mic sound is too loud or quiet</td>
<td>• Adjust [MIC GAIN] from the menu. (→ page 92)</td>
</tr>
</tbody>
</table>

For more information contact your dealer.

**If there is no picture, or the picture is not displayed correctly.**

- **Power on process for the projector and the PC.**
  
  Be sure to connect the projector and notebook PC while the projector is in standby mode and before turning on the power to the notebook PC.
  
  In most cases the output signal from the notebook PC is not turned on unless connected to the projector before being powered up.
  
  *NOTE: You can check the horizontal frequency of the current signal in the projector’s menu under Information. If it reads “0kHz”, this means there is no signal being output from the computer. (→ page 100 or go to next step)*

- **Enabling the computer’s external display.**
  
  Displaying an image on the notebook PC’s screen does not necessarily mean it outputs a signal to the projector. When using a PC compatible laptop, a combination of function keys will enable/disable the external display. Usually, the combination of the “Fn” key along with one of the 12 function keys gets the external display to come on or off. For example, NEC laptops use Fn + F3, while Dell laptops use Fn + F8 key combinations to toggle through external display selections.

- **Non-standard signal output from the computer**
  
  If the output signal from a notebook PC is not an industry standard, the projected image may not be displayed correctly. Should this happen, deactivate the notebook PC’s LCD screen when the projector display is in use. Each notebook PC has a different way of deactivate/reactivate the local LCD screens as described in the previous step. Refer to your computer’s documentation for detailed information.

- **Image displayed is incorrect when using a Mac**
  
  When using a Mac with the projector, set the DIP switch of the Mac adapter (not supplied with the projector) according to your resolution. After setting, restart your Mac for the changes to take affect.
  
  For setting display modes other than those supported by your Mac and the projector, changing the DIP switch on a Mac adapter may bounce an image slightly or may display nothing. Should this happen, set the DIP switch to the 13” fixed mode and then restart your Mac. After that, restore the DIP switches to a displayable mode and then restart the Mac again.
  
  *NOTE: A Video Adapter cable manufactured by Apple Inc. is needed for a MacBook which does not have a mini D-Sub 15-pin terminal.*

- **Mirroring on a MacBook**
  
  * When using the projector with a MacBook, output may not be set to 1024 × 768 unless “mirroring” is off on your MacBook. Refer to owner’s manual supplied with your Mac computer for mirroring.

- **Folders or icons are hidden on the Mac screen**
  
  Folders or icons may not be seen on the screen. Should this happen, select [View] → [Arrange] from the Apple menu and arrange icons.
# Specifications

This section provides technical information about projector's performance.

## Optical

<table>
<thead>
<tr>
<th>Model Number</th>
<th>NP-UM361X</th>
<th>NP-UM301X</th>
<th>NP-UM351W</th>
<th>NP-UM301W</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LCD Panel</strong></td>
<td>0.63 inch LCD with Micro Lens Array (Aspect Ratio 4:3)</td>
<td>0.59 inch LCD with Micro Lens Array (Aspect Ratio 16:10)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Resolution</strong></td>
<td>1024 × 768 pixels (XGA)</td>
<td>1280 × 800 pixels (WXGA)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Lens</strong></td>
<td>Digital zoom and manual focus</td>
<td>Digital Zoom Ratio = 1.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>F = 1.8 f = 4.78 mm</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Lamp</strong></td>
<td>255 W AC (200 W in NORMAL) (160 W in ECO)</td>
<td>235 W AC (170 W in NORMAL) (140 W in ECO)</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>255 W AC (200 W in NORMAL) (160 W in ECO)</td>
<td>235 W AC (170 W in NORMAL) (140 W in ECO)</td>
<td></td>
</tr>
<tr>
<td><strong>Light Output</strong></td>
<td>3600 lumens</td>
<td>3000 lumens</td>
<td>3500 lumens</td>
<td>3000 lumens</td>
</tr>
<tr>
<td></td>
<td>NORMAL: 80%</td>
<td>NORMAL: 75%</td>
<td>NORMAL: 80%</td>
<td>NORMAL: 75%</td>
</tr>
<tr>
<td></td>
<td>ECO: 60%*</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Contrast Ratio</strong></td>
<td>6000:1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Image Size (Diagonal)</strong></td>
<td>61.5 - 116.6 inches/1562 - 2962 mm</td>
<td></td>
<td>58 - 110 inches/1473 - 2794 mm</td>
<td></td>
</tr>
<tr>
<td><strong>Projection Distance</strong> (Min.-Max.)</td>
<td>18 - 34 inches/448 - 854 mm</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Projection Angle</strong></td>
<td>53°</td>
<td></td>
<td>49°</td>
<td></td>
</tr>
</tbody>
</table>

*1 Effective pixels are more than 99.99%.
*2 This is the light output value (lumens) when the [PRESET] mode is set to [HIGH-BRIGHT]. If any other mode is selected as the [PRESET] mode, the light output value may drop slightly.
*3 Compliance with ISO21118-2005
*4 The maximum power becomes equivalent to power in NORMAL (ECO MODE).

## Electrical

<table>
<thead>
<tr>
<th>Model Number</th>
<th>NP-UM361X</th>
<th>NP-UM301X</th>
<th>NP-UM351W</th>
<th>NP-UM301W</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Inputs</strong></td>
<td>1 x RGB/Component (D-Sub 15 P), 2 x HDMI Type A (19P, HDMI® Terminal) HDCP supported*, Exclusively HDMI1 supports MHL signals, 1 x Video (RCA), 1 x (L/R) RCA Audio, 1 x Stereo Mini Audio</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Outputs</strong></td>
<td>1 x RGB (D-Sub 15P), 1 x Stereo Mini Audio</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>PC Control</strong></td>
<td>1 x PC Control Port (D-Sub 9P)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Wired LAN Port</strong></td>
<td>1 x RJ-45 (10BASE-T/100BASE-TX)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Wireless LAN Port</strong> (Optional)</td>
<td>IEE 802.11 b/g/n (optional USB Wireless LAN Unit required)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>USB Port</strong></td>
<td>1 x Type A, 1 x Type B</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Mic Input</strong></td>
<td>1 x Monaural Mini Audio (Dynamic microphone and Condenser microphone)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Color Reproduction</strong></td>
<td>10-bit signal processing (1.07 billion colors) (HDMI, USB-A, LAN: Colors, 16.7 million colors)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Horizontal Resolution</strong></td>
<td>540 TV lines: NTSC/NTSC4.43/PAL/PAL-M/PAL-N/PAL60</td>
<td>300 TV lines: SECAM</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Scan Rate</strong></td>
<td>Horizontal: 15 kHz to 100 kHz (RGB: 24 kHz or over)</td>
<td>Vertical: 50 Hz to 120 Hz (HDMI: 50 Hz to 85 Hz)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Sync Compatibility</strong></td>
<td>Separate Sync</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*5 HDMI® (Deep Color, Lip Sync) with HDCP
Component: 480i/480p/576i/576p/720p/1080i/1080p

*5 What is HDCP/HDCP technology?
HDCP is an acronym for High-bandwidth Digital Content Protection. High bandwidth Digital Content Protection (HDCP) is a system for preventing illegal copying of video data sent over a High-Definition Multimedia Interface (HDMI).

If you are unable to view material via the HDMI input, this does not necessarily mean the projector is not functioning properly. With the implementation of HDCP, there may be cases in which certain content is protected with HDCP and might not be displayed due to the decision/intention of the HDCP community (Digital Content Protection, LLC).

Video: Deep Color; 8/10/12-bit, LipSync
Audio: LPCM; up to 2 ch, sample rate 32/44.1/48 KHz, sample bit: 16/20/24-bit

*6 An image with higher or lower resolution than the projector’s native resolution (UM361X/UM301X: 1024 × 768 / UM351W/UM301W: 1280 × 800) will be displayed with Advanced AccuBlend. (→ page 135)
# 8. Appendix

<table>
<thead>
<tr>
<th>Model Number</th>
<th>NP-UM361X</th>
<th>NP-UM301X</th>
<th>NP-UM351W</th>
<th>NP-UM301W</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Built-in Speaker</strong></td>
<td>20 W (monaural)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Power Requirement</strong></td>
<td>100–240V AC, 50/60Hz</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Input Current</strong></td>
<td>3.8A/1.6A</td>
<td>3.5A/1.5A</td>
<td>3.8A/1.6A</td>
<td>3.5A/1.5A</td>
</tr>
<tr>
<td><strong>Power Consumption</strong></td>
<td>337 W (100-130 V)</td>
<td>297 W (100-130 V)</td>
<td>337 W (100-130 V)</td>
<td>297 W (100-130 V)</td>
</tr>
<tr>
<td><strong>ECO MODE OFF</strong></td>
<td>324 W (200-240 V)</td>
<td>285 W (200-240 V)</td>
<td>324 W (200-240 V)</td>
<td>285 W (200-240 V)</td>
</tr>
<tr>
<td><strong>NORMAL</strong></td>
<td>265 W (100-130 V)</td>
<td>234 W (100-130 V)</td>
<td>265 W (100-130 V)</td>
<td>234 W (100-130 V)</td>
</tr>
<tr>
<td><strong>ECO</strong></td>
<td>214 W (200-240 V)</td>
<td>190 W (200-240 V)</td>
<td>214 W (200-240 V)</td>
<td>190 W (200-240 V)</td>
</tr>
<tr>
<td><strong>STANDBY (NETWORK) OFF</strong></td>
<td>2.1W (100-130 V)/2.4W (200-240 V)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>STANDBY (NORMAL)</strong></td>
<td>0.22W (100-130 V)/0.39W (200-240 V)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

## Mechanical

<table>
<thead>
<tr>
<th>Model Number</th>
<th>NP-UM361X</th>
<th>NP-UM301X</th>
<th>NP-UM351W</th>
<th>NP-UM301W</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Installation Orientation</strong></td>
<td>Desktop/Front, Desktop/Rear, Ceiling/Front, Ceiling/Rear</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Dimensions</strong></td>
<td>14.9&quot; (W) × 4.4&quot; (H) × 16.9&quot;(D)/378 mm (W) × 112 mm (H) × 428 mm (D) (not including protrusions)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>NP-UM361X, NP-UM351W: 5.6 kg/12.4 lbs</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Environmental Considerations</strong></td>
<td>NP-UM301X, NP-UM301W: 5.5 kg/12.2 lbs</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Operational Temperatures</strong></td>
<td>41° to 104°F (5° to 40°C), (ECO mode selected automatically at 95°F to 104°F/35°C to 40°C)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Storage Temperatures</strong></td>
<td>14° to 122°F (-10° to 50°C), 20% to 80% humidity (non-condensing)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Regulations</strong></td>
<td>UL/C-UL Approved (UL 60950-1, CSA 60950-1)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Meets DOC Canada Class B requirements</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Meets FCC Class B requirements</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Meets AS/NZS CISPR.22 Class B</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Meets EMC Directive (EN55022, EN55024, EN61000-3-2, EN61000-3-3)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Meets Low Voltage Directive (EN60950-1, TÜV GS Approved)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For additional information visit:


Europe: [http://www.nec-display-solutions.com/](http://www.nec-display-solutions.com/)


For information on our optional accessories, visit our website or see our brochure.

The specifications are subject to change without notice.
3 Cabinet Dimensions

Unit: mm (inch)
**Pin Assignments of D-Sub COMPUTER Input Terminal**

**Mini D-Sub 15 Pin Terminal**

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>RGB Signal (Analog)</th>
<th>YCbCr Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Red</td>
<td>Cr</td>
</tr>
<tr>
<td>2</td>
<td>Green or Sync on Green</td>
<td>Y</td>
</tr>
<tr>
<td>3</td>
<td>Blue</td>
<td>Cb</td>
</tr>
<tr>
<td>4</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Red Ground</td>
<td>Cr Ground</td>
</tr>
<tr>
<td>7</td>
<td>Green Ground</td>
<td>Y Ground</td>
</tr>
<tr>
<td>8</td>
<td>Blue Ground</td>
<td>Cb Ground</td>
</tr>
<tr>
<td>9</td>
<td>Hotplug</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Sync Signal Ground</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>No Connection</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Bi-directional DATA (SDA)</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Horizontal Sync or Composite Sync</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Vertical Sync</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Data Clock</td>
<td></td>
</tr>
</tbody>
</table>

**COMPUTER IN**

*NOTE: Pin Nos. 12 and 15 are required for DDC/CI.*
### Compatible Input Signal List

#### Analog RGB

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640x480</td>
<td>4:3</td>
<td>60/72/75/85/75/85</td>
</tr>
<tr>
<td>SVGA</td>
<td>800x600</td>
<td>4:3</td>
<td>56/60/72/75/85/75</td>
</tr>
<tr>
<td>XGA</td>
<td>1024x768</td>
<td>4:3</td>
<td>60/70/75/85/75/85</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280x768</td>
<td>15:9</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1280x800</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1360x768</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1366x768</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>Quad-VGA</td>
<td>1280x960</td>
<td>4:3</td>
<td>60/75</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280x1024</td>
<td>5:4</td>
<td>60/75</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400x1050</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440x900</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>WXGA++</td>
<td>1600x900</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>UXGA</td>
<td>1600x1200</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>WUXGA+</td>
<td>1680x1050</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>HD</td>
<td>1280x720</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>Full HD</td>
<td>1920x1080</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1920x1200</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>MAC 13*</td>
<td>640x480</td>
<td>4:3</td>
<td>67</td>
</tr>
<tr>
<td>MAC 16*</td>
<td>832x624</td>
<td>4:3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 19*</td>
<td>1024x768</td>
<td>4:3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 21*</td>
<td>1152x870</td>
<td>4:3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 23*</td>
<td>1280x1024</td>
<td>5:4</td>
<td>65</td>
</tr>
</tbody>
</table>

#### Component

<table>
<thead>
<tr>
<th>Signal</th>
<th>Format</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDTV (1080p)</td>
<td>1920x1080</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV (1080i)</td>
<td>1920x1080</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV (720p)</td>
<td>1280x720</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>SDTV (480p)</td>
<td>720x480</td>
<td>4:3/16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV (576p)</td>
<td>720x576</td>
<td>4:3/16:9</td>
<td>50</td>
</tr>
<tr>
<td>SDTV (480i)</td>
<td>720x480</td>
<td>4:3/16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV (576i)</td>
<td>720x576</td>
<td>4:3/16:9</td>
<td>50</td>
</tr>
</tbody>
</table>

#### MHL

<table>
<thead>
<tr>
<th>Signal</th>
<th>Format</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640x480</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>HDTV(1080p)</td>
<td>1920x1080</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV(1080i)</td>
<td>1920x1080</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV(720p)</td>
<td>1280x720</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>SDTV480p</td>
<td>720x480</td>
<td>4:3/16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV576p</td>
<td>720x576</td>
<td>4:3/16:9</td>
<td>50</td>
</tr>
<tr>
<td>SDTV480i</td>
<td>720x480</td>
<td>4:3/16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV576i</td>
<td>720x576</td>
<td>4:3/16:9</td>
<td>50</td>
</tr>
</tbody>
</table>

#### Composite Video/S-Video

<table>
<thead>
<tr>
<th>Signal</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>PAL</td>
<td>4:3</td>
<td>50</td>
</tr>
<tr>
<td>PAL60</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>SECAM</td>
<td>4:3</td>
<td>50</td>
</tr>
</tbody>
</table>

#### HDMI

<table>
<thead>
<tr>
<th>Signal</th>
<th>Resolution (dots)</th>
<th>Aspect Ratio</th>
<th>Refresh Rate (Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>VGA</td>
<td>640x480</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>SVGA</td>
<td>800x600</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>XGA</td>
<td>1024x768</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>WXGA</td>
<td>1280x768</td>
<td>15:9</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1280x800</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td></td>
<td>1366x768</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>Quad-VGA</td>
<td>1280x960</td>
<td>4:3</td>
<td>60/75</td>
</tr>
<tr>
<td>SXGA</td>
<td>1280x1024</td>
<td>5:4</td>
<td>60/75</td>
</tr>
<tr>
<td>SXGA+</td>
<td>1400x1050</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>WXGA+</td>
<td>1440x900</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>WXGA++</td>
<td>1600x900</td>
<td>16:9</td>
<td>60</td>
</tr>
<tr>
<td>UXGA</td>
<td>1600x1200</td>
<td>4:3</td>
<td>60</td>
</tr>
<tr>
<td>WUXGA</td>
<td>1680x1050</td>
<td>16:10</td>
<td>60</td>
</tr>
<tr>
<td>MAC 13*</td>
<td>640x480</td>
<td>4:3</td>
<td>67</td>
</tr>
<tr>
<td>MAC 16*</td>
<td>832x624</td>
<td>4:3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 19*</td>
<td>1024x768</td>
<td>4:3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 21*</td>
<td>1152x870</td>
<td>4:3</td>
<td>75</td>
</tr>
<tr>
<td>MAC 23*</td>
<td>1280x1024</td>
<td>5:4</td>
<td>65</td>
</tr>
<tr>
<td>HDTV (1080p)</td>
<td>1920x1080</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV (1080i)</td>
<td>1920x1080</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>HDTV (720p)</td>
<td>1280x720</td>
<td>16:9</td>
<td>50/60</td>
</tr>
<tr>
<td>SDTV (480p)</td>
<td>720x480</td>
<td>4:3/16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV (576p)</td>
<td>720x576</td>
<td>4:3/16:9</td>
<td>50</td>
</tr>
<tr>
<td>SDTV (480i)</td>
<td>720x480</td>
<td>4:3/16:9</td>
<td>60</td>
</tr>
<tr>
<td>SDTV (576i)</td>
<td>720x576</td>
<td>4:3/16:9</td>
<td>50</td>
</tr>
</tbody>
</table>

**Note:**
- An image with higher or lower resolution than the projector’s native resolution (UM361X/UM301X: 1024 x 768 / UM351W/ UM301W: 1280 x 800) will be displayed with Advanced AccuBlend.
- Sync on Green and Composite sync signals are not supported.
- Signals other than those specified in the table above may not be displayed correctly. If this should happen, change the refresh rate or resolution on your PC. Refer to Display Properties help section of your PC for procedures.
### PC Control Codes and Cable Connection

#### PC Control Codes

<table>
<thead>
<tr>
<th>Function</th>
<th>Code Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>POWER ON</td>
<td>02H 00H 00H 00H 00H 02H</td>
</tr>
<tr>
<td>POWER OFF</td>
<td>02H 01H 00H 00H 00H 03H</td>
</tr>
<tr>
<td>INPUT SELECT COMPUTER</td>
<td>02H 03H 00H 00H 02H 01H 01H 09H</td>
</tr>
<tr>
<td>INPUT SELECT HDMI1/MHL</td>
<td>02H 03H 00H 00H 02H 01H 1AH 22H</td>
</tr>
<tr>
<td>INPUT SELECT HDMI2</td>
<td>02H 03H 00H 00H 02H 01H 1BH 23H</td>
</tr>
<tr>
<td>INPUT SELECT VIDEO</td>
<td>02H 03H 00H 00H 02H 01H 06H 0EH</td>
</tr>
<tr>
<td>INPUT SELECT USB-A</td>
<td>02H 03H 00H 00H 02H 01H 1FH 27H</td>
</tr>
<tr>
<td>INPUT SELECT LAN</td>
<td>02H 03H 00H 00H 02H 01H 20H 28H</td>
</tr>
<tr>
<td>INPUT SELECT USB-B</td>
<td>02H 03H 00H 00H 02H 01H 22H 2AH</td>
</tr>
<tr>
<td>PICTURE MUTE ON</td>
<td>02H 10H 00H 00H 00H 12H</td>
</tr>
<tr>
<td>PICTURE MUTE OFF</td>
<td>02H 11H 00H 00H 00H 13H</td>
</tr>
<tr>
<td>SOUND MUTE ON</td>
<td>02H 12H 00H 00H 00H 14H</td>
</tr>
<tr>
<td>SOUND MUTE OFF</td>
<td>02H 13H 00H 00H 00H 15H</td>
</tr>
</tbody>
</table>

**NOTE:** Contact your local dealer for a full list of the PC Control Codes if needed.

#### Cable Connection

**Communication Protocol**
- **Baud rate:** 38400 bps
- **Data length:** 8 bits
- **Parity:** No parity
- **Stop bit:** One bit
- **X on/off:** None
- **Communications procedure:** Full duplex

**NOTE:** Depending on the equipment, a lower baud rate may be recommended for long cable runs.

#### PC Control Terminal (D-SUB 9P)

![Diagram of PC Control Terminal (D-SUB 9P)](image)

**NOTE 1:** Pins 1, 4, 6 and 9 are no used.

**NOTE 2:** Jumper “Request to Send” and “Clear to Send” together on both ends of the cable to simplify cable connection.

**NOTE 3:** For long cable runs it is recommended to set communication speed within projector menus to 9600 bps.
Troubleshooting Check List

Before contacting your dealer or service personnel, check the following list to be sure repairs are needed also by referring to the “Troubleshooting” section in your user’s manual. This checklist below will help us solve your problem more efficiently.

* Print this page and the next page for your check.

Frequency of occurrence □ always □ sometimes (How often?_____________________) □ other (____________________)

Power
□ No power (POWER indicator does not light blue) See also “Status Indicator (STATUS)”.
□ Power cord’s plug is fully inserted into the wall outlet.
□ Main power switch is pressed to the ON position.
□ Lamp cover is installed correctly.
□ Lamp Hours Used (lamp operation hours) was cleared after lamp replacement.
□ No power even though you press and hold the POWER button.
□ Shut down during operation.
□ Power cord’s plug is fully inserted into the wall outlet.
□ Lamp cover is installed correctly.
□ [AUTO POWER OFF] is turned off (only models with the [AUTO POWER OFF] function).
□ [OFF TIMER] is turned off (only models with the [OFF TIMER] function).

Video and Audio
□ No image is displayed from your PC or video equipment to the projector.
□ Still no image even though you connect the projector to the PC first, then start the PC.
□ Enabling your notebook PC’s signal output to the projector.
  • A combination of function keys will enable/disable the external display. Usually, the combination of the “Fn” key along with one of the 12 function keys turns the external display on or off.
□ No image (blue or black background, no display).
□ Still no image even though you press the AUTO ADJUST button.
□ Still no image even though you carry out [RESET] in the projector’s menu.
□ Signal cable’s plug is fully inserted into the input terminal
□ A message appears on the screen. (____________________________________)
□ The source connected to the projector is active and available.
□ Still no image even though you adjust the brightness and/or the contrast.
□ Input source’s resolution and frequency are supported by the projector.
□ Parts of the image are lost.
□ Still unchanged even though you press the AUTO ADJUST button.
□ Still unchanged even though you carry out [RESET] in the projector’s menu.
□ Image is shifted in the vertical or horizontal direction.
□ Horizontal and vertical positions are correctly adjusted on a computer signal.
□ Input source’s resolution and frequency are supported by the projector.
□ Some pixels are lost.
□ Image is flickering.
□ Still unchanged even though you press the AUTO ADJUST button.
□ Still unchanged even though you carry out [RESET] in the projector’s menu.
□ Image shows flickering or color drift on a computer signal.
□ Still unchanged even though you change [FAN MODE] from [HIGH ALTITUDE] to [AUTO].
□ Image appears blurry or out of focus.
□ Still unchanged even though you checked the signal’s resolution on PC and changed it to projector’s native resolution.
□ Still unchanged even though you adjusted the focus.
□ No sound.
□ Audio cable is correctly connected to the audio input of the projector.
□ Still unchanged even though you adjusted the volume level.
□ [CONTROL PANEL LOCK] is not turned on or is disabled in the menu.
□ Still unchanged even though you press and hold the EXIT button for a minimum of 10 seconds.

Other
□ Remote control does not work.
□ No obstacles between the sensor of the projector and the remote control.
□ Projector is placed near a fluorescent light that can disturb the infrared remote controls.
□ Batteries are new and are not reversed in installation.
□ Buttons on the projector cabinet do not work (only models with the [CONTROL PANEL LOCK] function)
□ [CONTROL PANEL LOCK] is not turned on or is disabled in the menu.
□ Still unchanged even though you press and hold the EXIT button for a minimum of 10 seconds.
In the space below please describe your problem in detail.

Information on application and environment where your projector is used

**Projector**
- Model number:
- Serial No.:
- Date of purchase:
- Lamp operating time (hours):
- Eco Mode:  
  - OFF
  - AUTO ECO
  - NORMAL
  - ECO

**Information on input signal:**
- Horizontal synch frequency [ ] kHz
- Vertical synch frequency [ ] Hz
- Synch polarity
  - H (+) (-)
  - V (+) (-)
- Synch type
  - Separate
  - Composite
  - Sync on Green
- STATUS Indicator:
  - Steady light
    - Orange
    - Green
  - Flashing light [ ] cycles
- Remote control model number:

**Installation environment**
- Screen size: [ ] inch
- Screen type:  
  - White matte
  - Beads
  - Polarization
  - Wide angle
  - High contrast
- Throw distance: [ ] feet/inch/m
- Orientation:  
  - Ceiling mount
  - Desktop
- Power outlet connection:
  - Connected directly to wall outlet
  - Connected to power cord extender or other (the number of connected equipment _________)
  - Connected to a power cord reel or other (the number of connected equipment _________)

**Computer**
- Manufacturer:
- Model number:
- Notebook PC [ ] / Desktop [ ]
- Native resolution:
- Refresh rate:
- Video adapter:
- Other:

**Video equipment**
- VCR, DVD player, Video camera, Video game or other
- Manufacturer:
- Model number:

**Signal cable**
- NEC standard or other manufacturer’s cable?
  - Model number: [ ] Length: [ ] inch/m
- Distribution amplifier
  - Model number:
- Switcher
  - Model number:
- Adapter
  - Model number:
TCO Certification

Some models in this product family are TCO certified. All TCO certified models have the TCO mark on the marking plate (on the bottom of the product). To see a list of our TCO certified projectors and their TCO Certification (in English only), visit our website at [http://www.nec-display.com/ap/en_projector/tco/index.html](http://www.nec-display.com/ap/en_projector/tco/index.html)

The TCO certification, designed by TCO Development, is an international environmental and ergonomics standard for IT equipment.

In some cases we may post a list of TCO certified models on our website before the TCO mark is placed on the product. This difference in timing is related to the date certification is received compared with the projectors manufacturing date.
REGISTER YOUR PROJECTOR! (for residents in the United States, Canada, and Mexico)

Please take time to register your new projector. This will activate your limited parts and labor warranty and InstaCare service program. Visit our web site at www.necdisplay.com, click on support center/register product and submit your completed form online. Upon receipt, we will send a confirmation letter with all the details you will need to take advantage of fast, reliable warranty and service programs from the industry leader, NEC Display Solutions of America, Inc.